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Welcome
Welcome to Allplan 2013, the high-performance CAD
program for civil engineers.
In this tutorial workbook you will learn about the most
important functions in Allplan 2013's main modules.
You will find that within a short time, you will be in a
position to use Allplan 2013 effectively in your daily
work.
This chapter covers the following:
 Content of this tutorial
 Documentation for Allplan 2013
 Additional help on Allplan 2013
 Where to turn for training, coaching and project
support

Introduction
The Engineering Tutorial is a continuation of the Basics Tutorial,
which explains the principles of 2D drafting and design. In addition,
the Basics Tutorial shows you how to get started in 3D modeling.
The aim of this Engineering Tutorial is to guide you with easy to
follow steps from floor plan design to key plan generation to fully
automatic creation and management of reinforcement drawings in
3D. It consists of 9 exercises, which are divided into 5 units.
This tutorial will provide you with a sound introduction to Allplan
2013. As it only touches on the possibilities of some of the tools,
please consult – especially later when you work with Allplan 2013 –
the F1 online Help as an important source of information.
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A project including the structures and settings (but not the design!)
used in this tutorial is provided with the Allplan DVD. Unit 1: Basics,
Installing the project (on page 12) shows you how to install this
project.
The data used in this tutorial can be downloaded from the Internet.
Detailed information is provided in the appendix. See the section
entitled Training project on the Internet (see "Training project on
Internet" on page 309).
This tutorial also assumes that you have a working knowledge of
Microsoft® Windows® programs. Basic CAD-knowledge is helpful;
however, this tutorial will provide both the experienced CAD user as
well as newcomers to CAD with a solid foundation in the methods
and approach employed by Allplan 2013.

Sources of information
The Allplan documentation consists of the following:
• The help is the main source of information for learning about and
working with Allplan.
While you work with Allplan, you can get help on the current
Help on the
function by pressing the F1 key, or activate
Default toolbar and click the icon on which you require help.
• The Manual consists of two parts. The first part shows how to
install Allplan. The second part is designed to provide an
overview of basic concepts and terms in Allplan as well as
introduce approaches for entering data in Allplan.
• The Basics Tutorial guides you step by step through the most
important tools for designing and modifying elements in Allplan.
• The Architecture Tutorial guides you step by step through the
process of designing a building. In addition, you learn how to
analyze the building data using reports and to output the results
to a plotter.
• The Engineering Tutorial guides you step by step through the
process of creating key plans, general arrangement drawings and
reinforcement drawings. In addition, you learn how to output the
results to a plotter.

Engineering Tutorial

Welcome

• New Features in Allplan provide information on what's new in
the latest version.
• Each volume in the Step-by-Step series deals with a specific
concept or series of tools/modules in Allplan in detail. The areas
covered include data exchange, system administration, geodesy
modules, presentation modules, 3D modeling etc. As a
Serviceplus member you can download these guides as PDF files
in the Learn - Documents area of Allplan Connect
(http://www.allplan-connect.com).

Additional help
Tips on efficient usage
The ? menu includes Tips for efficient usage. This topic provides
practical tips and tricks showing you how to use Allplan efficiently
and how to carry out operations with ease.

User forum (for Serviceplus customers)
Allplan forum in Allplan Connect: users exchange information,
valuable tips relating to everyday work and advice on specific tasks.
Register now at
www.allplan-connect.com

FAQs on the Internet
You can find up-to-date FAQs on the Internet at the following
address:
www.allplan-connect.com/de/support/loesungen.html

Feedback on the Help
If you have suggestions or questions on the help, or if you come
across an error, send an e-mail to:
Dokumentation@nemetschek.de
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Training, coaching and project support
The type of training you are given is a decisive factor in the amount
of time you actually spend working on your own projects: a
professional introduction to the programs and advanced seminars for
advanced users can save you up to 35% of your editing time!
A tailor-made training strategy is essential. Nemetschek’s authorized
seminar centers offer an extensive range of programs and are happy
to work out a custom solution with you that will address your own
needs and requirements:
• Our sophisticated, comprehensive seminar program is the
quickest way for professional users to learn how to use the new
system.
• Special seminars are designed for users who wish to extend and
optimize their knowledge.
• One-on-one seminars are best when it comes to addressing your
own particular methods of working.
• One-day crash courses, designed for office heads, convey the
essentials in a compact format.
• We are also happy to hold seminars on your premises: These
encompass not only Allplan issues but include analysis and
optimization of processes and project organization.
For more detailed information on the current training program,
please consult our online seminar guide, which can be found on our
homepage (http://www.nemetschek-training.de).
You can also contact us for full details
Phone: 0180 1 750000
Fax:
0180 1 750001
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Feedback on the documentation
We are always trying to improve the overall quality of our program
documentation. Your comments and suggestions are important to us
and we welcome feedback on the manuals and online help.
Please do not hesitate to contact us to express criticism or praise
concerning the documentation. Feel free to contact us as follows:
Documentation
Nemetschek Allplan Systems GmbH
Konrad-Zuse-Platz 1
81829 Munich, Germany
Phone: 0180 1 750000
Fax:
0180 1 750001
Email: Dokumentation@nemetschek.de
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Unit 1: Basics
In this unit, you will install the Engineering Tutorial
project, start Allplan and make a few basic settings.
The Engineering Tutorial project comes with a fileset
structure and assigned drawing files.
The project provides four different plot sets controlling
layer visibility.
This way, you can start designing the building
immediately without having to make time-consuming
preparations first.
If you want to create the project along with the fileset
structure and plot sets yourself, the necessary steps are
described in detail in the appendix (on page 275) to this
tutorial. The appendix also provides further information
on various interesting topics such as "Using layers",
"ProjectPilot", "Palette configuration" and much more.
If you do not want to work through the entire tutorial
step by step, you can download the data of the finished
project from our website. It contains the drawing files at
different levels of completion so that you can get started
wherever you want. For example, you do not need to
generate the shell first. Just open the corresponding
drawing file and start creating reinforcement. You can
find information in the appendix: "Training project on
the Internet (see "Training project on Internet" on page
309)".
At the end of this unit, you will find a short
troubleshooting section which can be helpful to you in
using Allplan.
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Installing the project
After you have installed and correctly configured Allplan 2013, you
can install the Engineering Tutorial project provided with the
Allplan DVD.
Note: You can also download the training project - and any updated
versions - from Allplan Connect (http://www.allplan-connect.com)
on the Internet. You can find the data in the Learn - Documents
area.

To install the project that comes with the program
 Allplan 2013 must be installed, registered and correctly
configured. After having installed Allplan, you need to start it at
least once and check whether it works properly.
1 Close any applications that are running.
2 Insert the Allplan 2013 DVD in the DVD drive of your computer.
The DVD menu starts automatically. If it doesn't, click Start on
the task bar, select Run and enter the drive letter of the DVD
drive followed by the pathname and startmenu. For example,
enter e:\startmenu.
3 In the Documentation - Allplan 2013 - Training project for
Engineering Tutorial area, click Start Installation >>.
4 Click Next> to acknowledge the Welcome screen.

Engineering Tutorial
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5 Read the license agreement carefully and accept it. Click Next >.

6 Enter your name and that of your company.
Click Next > to confirm.
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Installing the project

7 Finally, click Finish.
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Starting Allplan and opening the project
You have installed Allplan 2013 and the training project on your
computer. Now you want to start working on the project.
First start Allplan 2013.

To start Allplan and open the project
1 Open the Windows task bar and click the Allplan 2013 icon.
2 On the Default toolbar, click
Basis.

Open on a Project-Specific

3 In the New Project, Open Project dialog box, select the
Engineering Tutorial project and click OK.
The project opens. This can take some time as Allplan first needs
to update some project settings.

Initial Settings
Start by making the following toolbar settings:

Settings in the Tools palette
For the first exercises, you will use the tools in the Basic: Walls,
Openings, Components module. Select this module in the Tools
palette.

Settings in the Tools palette for the following exercise
1 Select the Tools tab in the palette.
2 Select the

Architecture family on the drop-down menu.

3 On the right-hand side of the palette, select the tab for the
Basic: Walls, Openings, Components module.
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The Create and Change areas present the tools provided by the
Basic: Walls, Openings, Components module.
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4 There are different options for arranging the palettes on screen.
To reposition the palette window, click its top border with the left
mouse button and keep it pressed down:
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5 Drag the window to one of the positions displayed.
An example:

Allplan 2013
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6 Release the left mouse button.
The palette window appears at the selected position.

Note: You can use Hide automatically to show (
) the palettes.
7 Position the palette window as you need.

) and hide (
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Track tracing
Track tracing facilitates the intuitive design process. As you will not
use this option in the following exercises, start by switching off track
tracing (which is on by default).

To switch off track tracing
1 Click

Line (Create menu - Draft module).

2 Click in the workspace with the right mouse button and select
Track tracing options on the shortcut menu.
3 Switch Track tracing off.

Note: You can quickly enable and disable track tracing at any
time while entering points by pressing the F11 key or clicking the
Track line icon in the dialog line.
4 Click OK to confirm the settings and press ESC to quit the tool.

Engineering Tutorial

Unit 1: Basics

21

Layer settings
The layer structure of this project is set to Project. All the settings
you make, therefore, will apply to this tutorial project only.
The office standard is thus unaffected by any changes. You will
probably use the office standard in your daily work. The office
standard's settings are defined by the system administrator and apply
for the entire office.
Allplan 2013 provides a very extensive layer structure designed to
meet a broad range of requirements.
You can also define your own layer categories/hierarchies and
layers. For this guide you will be using the layers in the main
architectural and engineering categories.
You can specify whether the format properties (pen, line, and color)
are based on your custom settings, whether these properties are
proposed by the program and displayed on the Format toolbar (you
can modify them at any time) or whether these attributes are always
taken from the relevant layers (from the line style or the setting
assigned to the layer).
For the exercises in this tutorial, you will configure Allplan to select
the layer automatically with the menu. Furthermore, you will work
independently of the predefined layer format properties and make
these settings while drawing.

To define basic settings for layers
Tip: As Match is enabled on
the Format definition tab
(this is the default setting),
you can select the From
layer, line style check boxes
in the Layers' format
properties area.

1 Click

Select, Set Layers (Format menu).

The Select Layer/visibility tab is open.
2 Check that the Auto-select layer with menu box. is active.
3 If necessary, clear the check boxes in the Layers' format
properties area.
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4 Check that Display elements on frozen layers using a fixed
color is active and select color 25, if necessary.

,
and
buttons at top left to expand
Note: You can use the
and collapse the tree structure of the layers and to find specific
entries.
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How to ...
Sometimes, things will not immediately work out as required. This
list helps you succeed.

What if …
• ... I have selected the wrong tool?
Press ESC and click the correct icon.
• ... I make a mistake as I go along?
Press ESC to quit (several times if necessary).
Click

Undo.

• ... I have inadvertently deleted the wrong elements?
Delete is still active, press the right mouse button twice.
If
Undo.
If no tool is active, click
• ... I have unintentionally opened a dialog box or entered wrong
values?
Click Cancel.

What if..
• ..the workspace is empty but you are sure the drawing file
contains design data?
-

Click

Refresh (in the border of the viewport).

-

Click

Plan.

• ... the result of a design operation is not displayed correctly?
Click

Regen in the border of the viewport.

• ... the workspace is suddenly divided into a series of different
viewports?
1 Viewport.
On the Window menu, click
Tip: Check whether the
relevant layer is set so that it
is visible.

• ...specific kinds of elements such as text or hatching do not
appear in the workspace?
Show/Hide (Standard toolbar) and check that the
Click
elements in question are selected.
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Unit 2: Floor Plan and
General Arrangement
Drawing
In this unit, you will learn how to create general
arrangement drawings quickly and efficiently.
 You will use the tools in the
Basic: Walls,
Openings, Components module to create a 3D
building model of a basement. You will also learn
about viewports.
As an alternative, you will create a floor plan of a
Draft
basement in 2D using the tools in the
module.
 Using the tools in the
3D Modeling module, you
will create a three-dimensional general arrangement
drawing of an elevator shaft.
As an alternative, you will create the same 3D general
arrangement drawing using the tools in the
Basic:
Walls, Openings, Components module.
You should work your way through these exercises step
by step These form the basis for subsequent exercises in
units 3 and 4.
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Overview of exercises
Exercise 1: floor plan of basement and viewports

Basic:
You will draw a basement in 3D using the tools in the
Walls, Openings, Components module and in 2D using the tools in
the

Draft module.

Engineering Tutorial
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Exercise 2: 3D elevator shaft

You will draw an elevator shaft for the basement created in exercise
3D Modeling module. As an alternative,
1 using the tools in the
you will use the tools in the
Components module.

Basic: Walls, Openings,

28
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Exercise 1: floor plan of basement
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette and check whether the
family includes the following module(s):

Architecture

Basic: Walls, Openings, Components
In this exercise you will create a floor plan for a basement.
You will mainly use the tools in the
Basic: Walls, Openings,
Components module. You can access these tools in the Tools palette,
Create and Change areas.
You will also learn about viewports.
Finally, as an alternative, you will create the walls of the basement
in 2D.
Start by selecting fileset 1 with the following drawing files:
Fileset
1

Drawing
Drawing file name
file number
101

3D floor plan

102

2D floor plan

103

2D stair

104

Dimensions and labels

105

Hidden line image

110

Key plan

You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).
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Creating the 3D model using the Basic: Walls, Openings, Components
module
If you have not licensed the
Basic: Walls, Openings,
Components module, create the floor plan in 2D (on page 79),
dimension (see "Dimensions" on page 66) it and create the stair (on
page 70).

Tools
Wall
Join Linear Components
Column
Downstand Beam,
Upstand Beam
Door
Window
Hidden Line Image,
Wireframe
Slab
Recess, Opening in Slab
Viewports:
3 Viewports
Hidden Line
Representation
Save, Load View

Objective:
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Settings
Start by making initial settings.

To select a drawing file and set options
 Open the Tools palette and check that the
Basic: Walls,
Openings, Components module (Architecture family) is active.
Open on a Project-Specific Basis (Standard toolbar),
1 Click
open the drawing file tree for fileset 1 by clicking the plus sign
beside the name of the fileset and double-click drawing file 101.
2 Check the current Scale (1:100) and Length (m) in the status bar.
If necessary, enter these values.
Options (Standard toolbar) and select the Components
3 Click
page on the left.
4 Check that the Fixed pen for surface elements of archit.
elements check box is selected in the architectural settings
across modules and click OK to confirm the dialog box.

5 Select
Show/Hide (Standard toolbar) and disable the Color
stands for pen option.

Engineering Tutorial
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Walls
Note: When you are working with the tools in the architectural
modules, you are effectively working in three-dimensional space. To
define the position of a component (wall, door, window etc.) in
space, you require the height of the component’s top and bottom
levels. Here, you will use absolute values to specify the height.
You will use the following settings for the basement in the building:
The finished floor covering of the floor slab is at a height of -2.70
m. You are working with unfinished dimensions. As a result the
unfinished floor is at -2.79 m and the bottom of the floor slab at 0.31 m.
Note: You define the position of a wall by entering its start and end
points. In addition, you need to specify its offset direction relative to
an imaginary line between the start and end points.
You need to enter a wall thickness, which is important for the wall
to be displayed to scale. A hatching style, fill or style area can be
applied to intersected walls.
You need to enter the height so that Allplan 2013 can generate a
three-dimension model based on the floor plan. You can also specify
additional parameters such as a material and building trade.
This exercise involves creating the walls in the basement. Quantity
takeoff is ignored. It is therefore enough if you just define the
thickness and height of the wall and select a style area.

Start by defining wall parameters.

To set wall parameters
1 Click

Wall (Tools palette, Create area).

2 On the Wall Context toolbar, click
dialog box opens.

Properties. The Wall
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3 Enter the following information:
• In the Setup, number of layers area, enable wall type 1: wall
with a single construction layer.
• In the axis preview, move the component axis to an edge of
the wall.
Note: The position of the component axis controls the wall's
offset direction. The component axis can be on a side of the wall
or anywhere within the wall.
4 Enter the following information for layer number 1 in the
Parameters, attributes tab:
• The Thickness is set to 0.300. Do not change this value.
Tip: When setting the wall’s
Priority rating:
thickness of wall in mm.

in the list box,
• Click the value displayed for Priority, click
enter 300 and click OK to confirm. (This selects '300' and
adds it to the list.)
Note: The priority rating controls the manner in which
components intersect. Components with a lower priority rating
have a 'hole' cut in them where they are intersected by other
components. This ensures that these areas are not counted twice
in subsequent quantity takeoff operations.
• For the calculation mode select: volume.
• Set Interaction to dynamic.
• Enable the Auto-Join check box.
The Wall dialog box should now look like this:

Engineering Tutorial
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5 Set pen 0.50 in the Format Properties tab:

Note: The settings on the Format toolbar have no effect on the
format properties of walls.
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6 Enter the following information in the Surface elements tab:
• Select the Style Area option.
301 Reinforced concrete is selected. If it isn't, click the name
of the style area and select number 301.
The Surface elements tab should now look like this:

Tip: The parameters you set in
this dialog box are valid until
you change them.

7 Now click the Height... button and set the height. Enter the top
and bottom levels of the wall as absolute values. Click the
relevant elevation icon.
•

Top level of wall (= bottom of slab): -0.31.

•

Bottom level of wall (= top of floor slab): -2.79.

8 Click OK to confirm the Height and Wall dialog boxes.
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Entering data in property sheets
Tip: For more information on
the Wall tool, press
F1
This will display the relevant
online Help topic.

To enter a value, click the data entry box. Enter the value at the
keyboard and press ENTER.
To enter and add values in custom list boxes, click

first.

To apply entries, click OK.
To discard entries, click Cancel or press ESC.

Component axis
Components are entered along their component axis. The wall’s
direction of extension depends on the position of the component
axis, the direction in which the wall is entered and the position of
the first construction layer in the wall.
Rotate about axis (Wall Context toolbar) to change the
Click
wall's direction of extension.
You can position the component axis as follows:
• Centered in or on the sides of the entire component (wall as a
whole)
• Centered in or on the sides of the each construction layer
• At a freely definable distance to a component edge (wall edge)
Small boxes in the preview indicate the positions you can select.

A
B
C

Component axis
Possible positions on the sides of/centered in the layer or entire wall
Number of layers
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You can place the component axis in several ways:
• Intuitive
Use the mouse to move the axis: the cursor becomes a double
arrow, and the component axis will snap to the positions marked
by small black boxes. The values displayed on the left of the
preview show the distance to the edges.
• Centered in or on the sides of a construction layer or of the
entire wall/upstand
In the Position column, click the icon of the construction layer or
of the entire wall/upstand in which you want to position the axis
and select a position. The values displayed on the left of the
preview show the distance to the edges.
Left edge of component or layer
Right edge of component or layer
Center of component or layer
Custom (with Total wall only)
• Custom position based on numerical value
Click one of the data entry boxes on the left of the preview area
and enter any value defining the offset of the axis to the wall
edge. The program automatically calculates the value for the
other side and displays the
thickness area.

Custom icon in the Total

Offset direction of components, single-layer walls
Components are entered along the component axis. Depending on
the axis' position within the component, you can use the offset
direction to specify on which side of the component axis (relative to
the direction in which the component is entered) the component is
Reverse offset direction, you have the option to
drawn. With
”tilt" the wall or to reverse the setup of the construction layers.
Tip: Using the offset
direction, you can quickly
toggle between inner and
outer dimensions when
entering walls.

The direction is indicated by an arrow and the position of the first
construction layer. You can activate and deactivate these symbols
Point snap
using the Symbols when entering walls option in the
options, Point snap representation area.
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Depending on the position of the component axis, the following
options are available:
• Single-layer wall, lateral component axis:

1
2
A
B
C

Start point of component
End point of component
Component axis
Offset direction
Direction in which component is entered

After clicking

1
2
A
B
C

Reverse offset direction:

Start point of component
End point of component
Component axis
Offset direction
Direction in which component is entered

• Single-layer wall, centered component axis:
Clicking
difference.

Reverse offset direction does not make any

When all the parameters have been set, you can draw the walls. In
this exercise, the values are outside dimensions. Therefore, the wall’s
offset direction is towards the inside.
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To draw exterior walls
Straight Component.

1 Choose the wall type by clicking

2 Set properties, place start point
Click where you want the wall to start.
The wall is attached to the crosshairs. Check that track tracing is
off. If it isn’t, the start point is marked with a cross. If necessary,
disable track tracing by pressing the F11 key.
3 Check and define the wall’s offset direction:
• In the Wall dialog box, you have defined a lateral wall axis.
The axis of a straight wall is simply the line you enter.
• The values are outside dimensions (see illustration below).
Start by drawing a horizontal wall at bottom left. As the
start point is on the outside, the wall’s offset direction is
upwards (= towards the inside).
• Check the preview displayed with the crosshairs. The small
arrow should point upwards (= towards the inside).
Tip: You can change the
component axis at any time
while entering elements using
in the
shortcut keys or
dialog line.

Reverse offset direction on the
• If this is not so, click
Wall Context toolbar to reverse the wall's offset direction.
4 Enter a value of 3.51 for the

X coordinate in the dialog line.

The other walls will join automatically when you create them in
the same way as polylines by entering dX and dY values in the
dialog line.
5 Enter the following values:
dY :

1.0

dX :

5.19

dY : -1.0

dX :

4.505

dY : 16.45

dX : -3.205

dY :

1.0

dX : -3.275

dY : -1.0

dX : -3.275

dY :

dX : -3.45

1.0

dY : -8.375

dX : -1.2

dY : -3.0

dX :

dY : -6.075

1.2
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Tip: If you can’t see the whole
drawing, click
Zoom All in the lower
border of the viewport.

A

2

A Wall's offset direction
6 The wall polyline closes automatically.
Press ESC to quit the
Wall tool.
Draw the interior walls using different thickness and priority rating
settings than those of the exterior walls. The height of the wall is the
same.

To draw interior walls
 The

Basic: Walls, Openings, Components module is open.

1 Double-click an exterior wall with the right mouse button.
Wall tool and gets the element's properties
This activates the
at the same time. The association with the planes (for the height,
for example) is no longer necessary.
2 Choose the wall type by clicking

Straight Component.
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Properties as shown.

• In the Parameters, attributes tab:
Thickness (m) = 0.24
Priority = 240
• In the Format Properties tab:
Pen thickness (2) = 0.35 mm
Then click OK to confirm.
4 Set properties, place start point
Draw the first horizontal interior wall by placing the start point
on the bottom left wall corner (see illustration below) of the
stairwell area. Check the wall’s offset direction in the preview
and, if necessary, change it by clicking
Reverse offset
direction.
5 Enter a value of 5.815 for the
for the
Y coordinate.

X coordinate. Then enter 2.40

6
dY = 2.40

4

dX = 5.815

6 Close the wall outline by clicking the corner of the exterior wall
at the top.
7 Click the point at top right to set the start point for the elevator
walls (see illustration below).
8 Enter a value of 1.78 for the

X coordinate.
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X coordinate.
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Y coordinate and then -1.00 for the

7

Tip: Instead of pressing ESC,
you can also quit tools by
clicking a toolbar with the
right mouse button.

10 Press ESC to close the wall polyline and to quit the

Wall tool.

You will use the
Join Linear Components tool to design the next
wall. This tool can be used to extend a wall to the point where it
intersects another wall.

To join walls
1 Click the elevator wall to be lengthened with the right mouse
button.
Join Linear Components on the shortcut menu. Check
2 Select
that the joint width is set to 0.00 and change this setting in the
dialog line, if necessary.
3 Click the exterior wall through to which the wall is to extend.

3

4
1

4

4 Using the same approach, lengthen the elevator wall by joining it
with the wall of the stairwell. Then quit the tool.
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You will design more interior walls based on the reference point of
existing walls and using the 'enter at right angles' option, which
creates elements at right angles to existing elements. After you have
drawn the interior wall at top left, which is described in this section,
you should be able to create the other walls yourself using the
information provided below.

To draw more interior walls
1 Click

Wall (Tools palette, Create area).

2 Choose the wall type by clicking

Straight Component.

3 Click the first interior wall corner at top right (see illustration
below) and specify the offset direction towards the right/bottom.
4 Enter the length of the wall as follows:
Y coordinate = -7.78.
5 Click

X coordinate = 0 and

Enter at right angles in the dialog line.

6 If necessary, confirm the value dy = 0 in order to enter a value in
the x direction and define the end point of the wall by clicking
the point where the interior wall you just created and the exterior
wall intersect.
7 To set the start point of the horizontal wall at the top, click the
line to the right of the vertical wall you just created. The
reference point is displayed.
8 If required, move the reference point onto the bottom left corner
and enter the offset between the reference point and the start of
the wall: 1.40.
9

Enter at right angles is still active in the dialog line.
Check that the offset direction is towards the top and click the
wall corner at bottom right.
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10 Now draw the other interior walls yourself.

3

7

9
6

11 The wall polylines close automatically. Press ESC to quit the
Wall tool.
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A Note on Views and Viewports
When working with walls and other components, you can get an
impression of how the building looks in 3D space at the click of a
mouse button. Each viewport has its own set of viewing tools in the
lower viewport border.

In Allplan 2013 you can have a number of different views open
simultaneously and work in any view you choose. You can set a
different view in each viewport. For example, you can display a
section, the entire design or an isometric view.
Changes you make to the design in one viewport are immediately
reflected in all the others. You can define your own viewports or use
one of the five standard views and adjust it for your needs.
You can set views on the Window menu.

There are icons in the lower border of each viewport. You can use
them to navigate freely on screen. These tools are known as
‘transparent’ tools; in other words, you can use them while a another
tool (e.g. Line) is active.
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Tools for controlling on-screen display
In Allplan you can zoom in on any section of the design as exactly
as you need. The tools in the border of the viewport enable you to
navigate freely on screen. These tools are known as ‘transparent’
tools; in other words, you can use them while a another tool (e.g.
Line) is active.
If you are working with multiple viewports, these tools are available
in each viewport.
Icon

Function
Zoom All

Use
Refresh sets the display scale so that all the elements in the visible files
can be seen. But if you have loaded a view using
only this view is displayed.

Save, Load View,

Press ESC to cancel the process.
Tip: You can also double-click the middle mouse button.
Zoom Section

Zoom Section zooms in on a section. To do this, press and hold down
the left mouse button and enclose the elements you want to zoom in a
selection rectangle.
Note: If several viewports are open, the zoomed section is displayed in the
viewport in which you clicked the button. The section itself, however, can
be defined in any of the viewports. Requirements: you have not selected a
perspective view and the same view is displayed in both viewports.
Tip: You can also use the right mouse button to define the section without
activating the

Zoom Section tool.

Pan

Pan Pans the section that is visible in the active viewport by a vector
you specify. To enter a vector, press and hold down the left mouse and
then drag. You can also pan in the active viewport by pressing and holding
down the middle mouse button and then dragging. Alternatively, use the
cursor keys.

Refresh

Regen regenerates the section that is visible on screen. Press ESC to
cancel the process.

Reduce View

Reduce View Reduces the section displayed on screen in incremental
steps. (The display scale doubles.)

Enlarge View

Enlarge View Enlarges the section displayed on screen in incremental
steps. (The display scale halves.)
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Function

Use

Standard Views
flyout

You can choose between plan view and any of the standard views.

3D View

3D View opens the 3D View dialog box, where you can set views.
More information can be found in the online help. See the section entitled
3D view.

Navigation Mode

In a viewport: sets a perspective view. When dragging, the cursor behaves
in the same way as in animation windows (sphere mode, camera mode).
In an animation window: when switched off, you can draw in animation
windows as you would in isometric windows.

Previous View

Previous View displays the previous view.

Next View

Next View displays the next view.

Save, Load View

Save, Load View saves the view currently set or loads a view you have
saved. This way, you can set views that you require time and again.
icon is active (pressed in), clicking
Refresh
Note: As long as the
does not refresh the entire drawing but just the saved view. To deactivate
the icon, click it again.

Display Scale

Sets the display scale. You can select from a list of default values or enter
any value in the data entry box. Then press ENTER to confirm.

Always on Top

Places the viewport so that it is always on top (i.e., in front of) the
other ones. This tool is not available when the viewport is maximized.

Activate Section

Activate Section displays an architectural section that you have
Clipping Path. You can define the section’s clipping path
defined with
by pointing and clicking, or by entering the section identifier.

Copy to Clipboard

Copy to Clipboard copies the current contents of the screen to the
Clipboard. You can then paste the data from the Clipboard into Allplan (as
a bitmap) or into other applications using

Paste or Insert contents.
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In addition, the following tools are provided in the layout editor.
You can use these tools to switch between the design view and a
preview of the layout to be plotted.
Icon

Function

Use

Design View

The
Design view displays the elements of the layout as you have
created them. Any superordinate pen, line or color defined is taken into
Show/Hide tool to
account. You can use the options provided by the
specify the type and scope of the elements displayed. The settings in the
Plot Layouts tool are not taken into account.

Color Plot Preview
or

Grayscale Plot
Preview

The color plot previews display the layout as it is printed by a color plotter
and the grayscale plot preview shows the layout as it is printed when you
use a monochrome plotter. For the display, the elements you have selected
Plot Layouts tool and the
in the Plot elements / settings area in the
parameters on the left side of the Settings tab are taken into account. Only
a few options are available in

Show/Hide.

Note: So that you can work quickly and easily, the preview also displays
elements that are outside the page, the margins of the page and, if
activated, the printable area of the output device although they are not
included in the final printout. The selection color is also used in the
preview, which makes working even easier.

The following exercise will help you understand how the viewports
work.

How to set viewports: detailed view and full view
1 On the Window menu, click
2 Click on
3 Click

3 Viewport.

Plan View in the viewport at top left.
Zoom Section in the border of the viewport on the right.

4 Zoom in on a section in the viewport at top left.
This section is displayed in the viewport where you clicked
Zoom Section (here: in the viewport on the right).
This way, you can work on details and still see your entire design
in plan, perspective and elevation.
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To create a hidden line representation
1 Click

3 Viewports.

Hidden Line Representation in the top left viewport to
2 Click
create an accelerated hidden line representation.
Note: You can define settings for the hidden line representation
in the
Options on the Display page, Display area.
3 To hide the division lines between the exterior and interior walls
Show/Hide (Standard toolbar)
of varying pen thickness, open
and select the Use color 1 for all elements options.
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Saving a view
1 Use
Zoom Section to choose a section where the design is
displayed in plan (viewport on the right).
2 Click

Save, Load View.

3 In the Save, Load View dialog box, click New, enter a name for
the view and click Load.
Tip: You can generate hidden
line representations and save
views in any viewport by
clicking the relevant icon.

The view is now active (the
icon is pressed in); in other words,
when you click
Refresh, it is displayed.
Save, Load View (icon is not pressed in) and then
4 Disable
click
Refresh
Now the whole drawing is displayed again.
1 Viewport. This disables the
5 On the Window menu, click
hidden line representation, too.
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Columns
Now you will place a column in the basement.
Tip: You can also use the
Column tool to make any
column-shaped element - for
example, round and
rectangular columns as well
as flush piers of small size.

To draw a column
 Drawing file 101 is current and plan view is active. Line type 1 is
selected.
1 On the Format toolbar, select pen thickness (3) 0.50 mm and
click
Column (Tools palette, Create area).
Check that the layer AR_COL is selected. If it isn't, activate it on
the Format menu or toolbar.
2 On the Column Context toolbar, click

Properties.
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3 Set the parameters in the Column dialog box as shown above:
Type:
Rectangular column
Width: 0.25 m
Thickness: 0.40 m
Priority: 250
Style area: 301 Reinforced concrete
4 Click the button marked Height... and enter the height of the
column as absolute values:
•

Top level: -0.51.

•

Bottom level: -2.79.

5 Confirm the two dialog boxes.
6 On the Column Context toolbar, set the
preview to bottom right.

Anchor point for

7

7 Move the crosshairs to the interior corner (see above).
This point now serves as the reference point for further entries,
and the data entry boxes in the dialog line are highlighted in
yellow.
8 Enter 0.00 for the
X coordinate and 2.85 for the
Y
coordinate in the dialog line and press ENTER to confirm.
The column is positioned.
9 Press ESC to quit the tool.
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Assigning layers
You assign layers and other format properties (pen, line and color) to
walls and upstands in the

Properties dialog box.

Note: If you set the layers as described in unit 1, the appropriate
layer for the selected tool is activated automatically.
If it isn't or you want to use a different layer, do the following.
Tip: Selecting layers

To select the active layer

Always proceed as follows:

 The
Column tool is active.
The dialog box with the properties is closed.

-

First select a tool..

- Check the layer’s short
name on the Format toolbar.
-

1 Click in the Select, Set Layers list box (Format toolbar).

Switch layer if necessary.

Tip: To see which layers have
already been assigned, click
Select, Set Layers on the
Format menu and select the
List existing layers in open
documents option.

2 If the layer AR_COL is available for selection in the quick access
list, click it.
3 If it isn't, click Set... and activate the layer in the dialog box by
double-clicking it.
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Downstand beam
The next step involves creating a beam over the column.

To draw a beam
1 Click
Downstand Beam, Upstand Beam (Tools palette, Create
area). On the Downstand Beam, Upstand Beam Context toolbar,
click
Properties.

2 Set the parameters for the beam as shown above:
Thickness: 0.25 m
Priority: 250
Pen thickness: (2) 0.35 mm
Style area: 301 Reinforced concrete
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3 Check that the layer AR_BEAM is selected. If it isn't, activate it.
4 Click

to define the absolute height of the beam:

•

Top level: -0.31.

•

Bottom level: -0.51.

5 Confirm the two dialog boxes.
6 Click the start point (see below).
7 Click

Enter at right angles and enter 0 for dX.

8 Check the beam’s offset direction in the preview and, if necessary,
Reverse offset direction.
change it by clicking
9 To define the end point of the beam, click the horizontal wall.
As you have selected 'Enter at right angles', you can also click a
corner of the wall.
The beam is drawn.

10 Press ESC to finish entering the beam.
11 To check its position, select an isometric view on the View menu
or open multiple viewports.
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Openings
Note: The procedure for creating an opening – be it a door, window,
niche or recess – is always the same. The differences lie in the
property settings you can make.
Like in the 'real' world, there is an inherent association between
walls and openings in Allplan. When you move a wall, for example,
its openings will move too.
All the doors in the basement are single doors of a size of
0.885/2.10 m (except for the doors to the stairwell and elevator).
Smart symbols are not used. You will draw the door opening without
a door swing. To display the door lintel, the reveal option will be
used.
The procedure for creating door openings also applies to all other
kinds of openings.

Entering openings
Tip: You can enter names for
combinations of parameters
and save them as favorites.
to match the
You can use
settings from an existing
component.

• Click the first point of the opening.
• Enter properties and set the height.
• Enter the width of the opening.
You only have to make the settings for the opening once if you want
to create a series of identical openings. The properties and the height
information are stored by the system until you redefine them.

To create door openings
 The Basic: Walls, Openings, Components module is still open.
Door (Tools palette, Create area).
1 Click
The door opening is attached to the crosshairs.
The program suggests the layer AR_SMSY for the smart symbol
inserted in the opening. Openings always have the same layer as
the component into which they are inserted, regardless which
layer is currently active.
Here, the layer setting is irrelevant.
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2 On the Door Context toolbar, set the
Anchor point for
preview to bottom right and enter 0.00 for the
Offset to
anchor point in the dialog line. Now you can enter a anchor
point.
3 Click a point on the outside of the stairwell wall roughly where
you want to insert the door (see the following illustration).
The reference point is displayed as an arrow and the offset
between the reference point and the point clicked is displayed in
the dialog line.

4 If the reference point is not displayed on the inside corner at top
left, click on the corner to move it there and enter 3.825 m for
the offset in the dialog line.
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Properties.

rectangle for the type.
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7 Click the door swing icon and click
of a door swing symbol.
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Off to disable the display

8 Click Height… and enter the height of the top and bottom levels
of the door as absolute values. Enter
-2.79 for the top level. The top level is obtained from the door
height to which the thickness of the floor is added (0.09 cm).
Enter -0.69.

9 Click OK to confirm the dialog box.
10 In the Door sill area, select the Both sides option. Select pen 0.35
mm for the sill; leave the line and color settings as they are.
Select the AR_WALL layer.
Disable the Create reveal element option.
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11 Click OK to confirm the dialog box.
12 Enter 1.01 m for the width of the opening in the dialog line. The
door opening is drawn.
Tip: You can set the anchor
point (left, right or centered)
on the Door Context toolbar.
You can also disable the
'Prompt for opening width' to
create several doors of the
same width.

13 Now draw all the other door openings yourself. You only need to
enter the width of the opening in the dialog line (except for the
elevator door which is 2.25 m high). Make sure that the offsets
are correct. Change the height of the elevator door in the dialog
box:
Bottom level = -2.79; top level = -0.54.

Tip: To check how your design
looks in 3D, switch to a
standard isometric view (View
menu) and create an
accelerated hidden line
representation by clicking .

14 Press ESC to quit the tool.
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The next step is to insert window openings in the walls. Some of the
window openings will be wider and higher than others and the
height of the sill in each opening is also different. Here, too, the
windows are displayed with a sill.
You are already familiar with the approach. Set the height, define the
shape of the window and place the opening in plan.

To create window openings
Tip: If necessary, change the
anchor point (Window
Context toolbar) and the
position of the reference
point.

1 Click

Window (Tools palette, Create area).

Anchor point for preview to bottom right on the
2 Set the
Window Context toolbar and check that the dialog line displays
0.00 for the
Offset to anchor point.
3 Click the line representing the exterior of the wall at top left and
enter the offset to the reference point in the dialog line.
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Properties.

5 The dimensions of the window openings are 80 by 60 cm. When
the lintel is 20 cm, the top level of the opening is at
-0.51 and the bottom level at -1.11. Click Height... and enter the
height as absolute values.
6 In the Sill area, select the Both sides option. Do not change the
pen, line and color settings of the sill. Select the AR_WALL layer.
Disable the Create reveal element option.
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7 Click OK to confirm the dialog box.

8 Now draw the windows as shown. Do not forget to change the
settings for the windows in the exterior wall on the left.
You can do this in two ways:
• Enter -1.31 for the height of the sill and 0.80 for the height
of the opening
• or click Height... and set the bottom level to -1.31.
9 Press ESC to quit the tool.
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Defining the Reference Point
To change the position the small arrow representing the nearest
significant reference point, you can
• click a point on the wall or
• click a point beyond the wall. The reference point will move to
the point on the wall that is perpendicular to the point you
clicked.

Design check
You can generate a hidden line image to check your design. This
way, you can see whether the window and door openings are placed
correctly. The hidden line image can be saved to a drawing file.

To copy the 3D view to a different drawing file
1 Click
Front Right, Southeast Isometric View in the border of
the viewport.
2 Click

Hidden Line Image, Wireframe (Default toolbar).
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3 Click Hidden Line Image in the Hidden Line Image, Wireframe
dialog box.

Tip: To save the hidden line
image as an NDW file, click
Save as ... on the File menu.

4 Select the Display hidden edges option and confirm the dialog
box and the following message box by clicking OK.
The hidden line image is displayed in a separate window.
5 Close this window by clicking the X in the top right corner.
Acknowledge the prompt by clicking Yes.

->
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6 Select drawing file 105 in the Select the destination drawing file
dialog box.
Open on a Project-Specific Basis and double-click
7 Click
drawing file 105 to make it current.
As the isometric view is still active, nothing is displayed in the
workspace.
8 In the border of the viewport, click

Plan View.

9 Your workspace should now look like this. You can also output
Print (File menu).
the image to the printer by clicking

Dimensions
Now you will dimension the floor plan using the approach described
in exercise 6 in the Basics Tutorial. Select the
Basic family in the
Dimension Lines module.
Tools palette and open the
• Make drawing file 104 current, open drawing file 101 in edit
mode and close all the other drawing files.
• Check the current Scale in the status bar and set it to 1:100, if
necessary.
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• Place the dimensions for the doors, windows and beam on the
layer DL_GEN and the wall dimensions on the layer DL_100.

Turning layers on and off
You can check that the dimensions are assigned to the correct layers
by setting the layer DL_GEN containing the dimensions of the
openings to visible, frozen.
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To turn layers on and off
1 On the Format menu, click

Select, Set Layers.

2 Select the List existing layers in open documents option, click
button at top
the ARCHITECTURE layer structure and then the
left to open the tree structure.
Tip: If you change the status
of the current layer, the
DEFAULT layer becomes the
current one.

3 Using the right mouse button, click the
DL_GEN Dimension line, general layer and choose Visible,
frozen.

4 Click OK to confirm.
The dimensions on layer DL_GEN are displayed in color 25,
which you selected for frozen layers.
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To set the frozen layer to modifiable again, use the right mouse
button to click a dimension line with color 25, choose Modify Layer
Status on the shortcut menu and click Modifiable.

What to do when elements are no longer visible?
• On the Format menu, click
the layers visible.

Select, Set Layers and make all

• If the elements are still not visible, the selected privilege set may
not have the necessary privileges. In this case, open the Layer
dialog box and select the Select Layer/Visibility tab. Open the
Privilege set list box and select an appropriate privilege set or
ask your system administrator for help.

Which layer is the element on?
• Pointing to an element displays information on this element.
Options on the Selection
According to the settings in the
page, the Element name and Layer are displayed by default.
• You can find out which layers individual elements are on by
Select, Set Layers
turning each individual layer on using the
tool on the Format toolbar.
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• You can find out which layer a single element is on by clicking
the element with the right mouse button and selecting Format
Properties.
All the properties including the layer are displayed and can be
changed directly.
You can also change the layer of the current element. The layers
of linked components (e.g. window openings in walls), however,
do not change. It is usually better to use
Properties.

Modify Format

• You can change the layer assignments of one or several elements
Modify Format Properties (Edit toolbar). This tool
using the
also modifies the layers of linked elements.

Stair outline
You can create stairs in two ways:
• You can model it in 3D using the tools in the
or
• You can draw it in 2D using the tools in the

Stairs module
Draft module.
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As half-space landings and flights of stairs are usually produced as
precast elements, you do not need to design or reinforce them. You
will therefore draw the outline of the stair using the tools in the
Draft The following exercise has a "rough design guideline".
Tools that you have already encountered are no longer explained in
detail.

To draw the stair outline
1 Make drawing file 103 current, open drawing file 101 in edit
mode and close all the other drawing files. Select pen thickness
0.13 mm.
Tip: To select a tool you have
already used beforehand, you
can activate it on the Repeat
menu.
You can choose from the 30
tools you have selected most
recently.

2 Select the

Draft module in the Tools palette.

Line,
Rectangle and
Parallel Lines (Tools palette,
3 Use
Create area) to draw the stringers and the steps.
Check that the layer DE_GEN02 is selected. If it isn't, activate it
on the Format menu or toolbar.
4 Use
Line and
the line of travel.
5 Use

Perpendic. Bisector (Create area) to draw

Line to draw two section lines.

Auto-Delete Segment (Change area) to delete redundant
6 Use
line segments.
7 Click

Modify Format Properties.
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8 The Modify Format Properties dialog box opens. Select the Line
type check box and choose line type 2. Then click OK to confirm.
9 Select the element(s) you want to modify: click the elements to
which you want to apply the new line type. Then press ESC to
quit the tool.
10 Make drawing file 104 current, open drawing files 101 and 103
in edit mode and close all the other drawing files.
11 Dimension the outline of the stair and modify the dimensioning
of the door. Double-click a frozen opening dimension line with
the right mouse button.
This selects the Dimension Line tool and automatically activates
the DL_GEN layer.
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Slab
The basement now needs a slab. You can create slabs using the
Slab tool. As with walls, start by entering the properties and then
draw the outline of the slab.

To set the slab’s properties
Tip: You can also use the
Slab tool to create
floor slabs.
A separate set of tools is
provided for designing
foundations.

1 Make drawing file 101 current and set 103 to edit mode.
Basic: Walls, Openings,
2 In the Tools palette, select the
Components module (Architecture family). Click
Slab (Create
area) and select pen thickness 0.50 mm.
Check that the layer AR_SLAB is selected. If it isn't, activate it on
the Format menu or toolbar.
3 On the Slab Context toolbar, click

Properties.
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4 Click Height... and enter the height of the slab as absolute values.
The unfinished floor of the ground floor = top level of the slab
above the basement = -0.11. As the slab is 20 cm thick, the
bottom level = -0.31.

5 Click OK to confirm the height settings, define the priority rating
and select a style area. Do not close the Slab dialog box.

To avoid entering the same properties again and again, you can set
them as you need and save them as favorite files. You can do this for
any component.

To save component properties as a favorite file
 The
Slab tool is still active and the dialog box is open. If it
isn't, select this tool and click
Properties.
1 In the bottom left corner of the dialog box, click
favorite.

Save as a

2 Select the Favorites - project folder, enter a name and click Save
to confirm.
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3 Click OK to confirm the Slab dialog box.
The next time you need a slab with these settings, click
favorite and select the file:
The values in the dialog box will change automatically.

Load

Now you will define the position of the slab. You will do this using
the polyline entry tools. These allow you to map the outline in a
single step. The only requirement is that you click an element in the
polyline and not a point.
Polyline entry tools
You can use these tools to enter or map any outline. To use the following options, select the
Polygonize elements check box.
Polygonize entire element: the start point also serves to specify the direction. You can specify
the number of segments for circles and curves.
Define area of element to polygonize: generates a polyline based on a portion of an element.
The portion is defined using a ‘from’ and a ‘to’ point.
Enter reference point: identifies a point on the element as the start point for the new element.
This start point is determined by clicking a point on the element and entering an offset value
between it and the nearest significant point (displayed as an arrow).
Find closed polylines: click a point on a polyline and the system will detect the entire
boundary.
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To create the slab using the polyline entry tools
1 Set properties, place polygon point 1, element or offset: click a
line representing the outside of a wall. Make sure that you do not
click the line near a point.
Find closed polylines in the input options.

2 Click

3 Click a point (near to the first point) beyond the floor plan. The
system automatically detects the outline of the entire floor plan.

3
1

4 Press ESC to quit the tool.
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You will now insert an opening in the slab in the area of the stair to
provide access to the ground floor. You can use the
Recess,
Opening in Slab tool to pierce slabs in their entirety. Height settings
are not required - all you need to do is define the shape of the
opening. You can choose between rectangular, circular, polygon and
freeform openings.
You will also insert a slab opening for the elevator shaft using the
Outline Auto-Detect tool. Using this tool, you can detect a closed
polyline simply by clicking within its boundaries.

To create a freeform slab opening
1 Click

Recess, Opening in Slab (Tools palette, Create area).

2 Click the basement slab.
3 On the Recess, Opening in Slab Context toolbar, click
Properties.
Tip: Slab openings are created
in the same way as slab
recesses. The parameters are
also identical. The only
difference is that height
settings are required for
recesses as they do not pierce
the slab in its entirety.
As with door and window
openings, slab openings have
the same layer as the
component into which they
are inserted, regardless which
layer is currently active.
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4 Select the Opening type and the

Freeform outline.

5 Click the corners of the stair outline one after the other.

5

5
5

5

5

5

5

5

6 To close the outline, click the first point again or press ESC after
the last point.
This defines the slab opening for the stair. The next step is to
define the slab opening for the elevator shaft.
7 Switch on
Outline auto-detect in the input options (icon must
be pressed in).
8 Click in the elevator shaft. The system automatically detects the
area.

8

9 Press ESC to quit the tool.
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10 Click
Front Right, Southeast Isometric View in the border of
the viewport.
Hidden Line Representation in the border of the
11 Click
viewport, open
Show/Hide and temporarily select the Use
color 1 for all elements option again.

The design should look like this:

Printing out layouts is covered in unit 9.
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Walls in basement as a 2D design using the Draft module
As an alternative to the
Basic: Walls, Openings, Components
module, you will now create the walls in the basement in 2D
using the tools in the
Draft module. You can access these tools in
the Tools palette, Create and Change areas.
Tools:

Objective:

Offset Polyline
Rectangle
Delete Double Lines
Line
Parallel Lines
Auto-Delete Segment
Move

Start by making initial settings.

To select a drawing file and set options
1 Select the
Basic family in the Tools palette and open the
Draft module.
Open on a Project-Specific Basis (Standard toolbar)
2 Click
and double-click drawing file 102.
3 Check the current scale (1:100) and unit of length (m) in the
status bar.
4 On the Format toolbar, select pen thickness 0.50 mm and line
type 1.
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Now draw the exterior walls.
Approaches
You can enter a floor plan in 2D in various ways:
• Create the walls using the
Line and
Parallel Lines tools.
You should already be familiar with this approach as you used it
to draw the title block in the Basics Tutorial.
• Create the walls using the
Rectangle tool. By snapping to
points and entering offset values, you can take openings into
account. You will draw the interior walls in this way.
• Create the walls using the

Offset Polyline tool.

Instead of using these tools to create a drawing in 2D, you can also
use the
Basic: Walls, Openings, Components module to create
the floor plan without taking the height into account (top level =
bottom level = 0.00). This approach is equivalent to the one
described above.

To draw exterior walls as offset polylines
 The
plan view is active and the
Hidden Line
Representation is off.
If it isn't, click
1 Viewport on the Window menu.
1 Click
Tip: When you enter a
negative offset, the offset
polyline is created on the side
opposite the one you clicked.
The direction in which it is
entered, however, does not
change.

Offset Polyline (Tools palette, Create area).

2 Select the layer DE_GEN02. This way, you can use the 2D floor
plan for the key plan and the slab reinforcement.
3 Number of parallel offset lines:
Enter 2.
4 Enter the offset for the parallel lines in the dialog line:
1st offset = 0
2. Offset: = 0.30
5 Click to place the start point at bottom left.

82

Exercise 1: floor plan of basement

Allplan 2013

6 Click left in the input options to define the offset direction, use
X coordinate and
Y coordinate in the dialog line to enter
the values in the x and y directions as shown below. Then press
ESC to quit the tool.
Use the TAB key to switch between the data entry boxes.

Tip: If you have entered an
incorrect value or made an
error, press ESC and
delete (Edit toolbar) the
error. You can then resume
your work.

Tip: If you want to create a
floor plan with different wall
thickness, you can enter the
offset values each time you
place a point or you can use
Modify Offset tool to
the
correct the offset after you
have entered the floor plan.

dX = 3.51

dY = 1.00

dX = 5.19

dY = -1.00

dX = 4.505

dY = 16.45

dX = -3.205

dY = 1.00

dX = -3.275

dY = -1.00

dX = -3.275

dY = 1.00

dX = -3.45

dY = -8.375

dX = -1.20

dY = -3.00

dX = 1.20

dY = -6.075
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Draw the interior walls using the
Rectangle tool. This way, door
openings can be taken into account. Start with the horizontal walls
near the stairwell.

To draw the interior walls as rectangles
1 Click

Rectangle (Tools palette, Create area).

2 Start point: click the re-entrant corner of the exterior wall on the
left (see below).

2

4

3 Diagonal point: enter 6.055 (= length of wall) for the
X
coordinate and -0.24 (= thickness of wall) for the
Y
coordinate. Then press ENTER to confirm.
4 To create the vertical wall, click the top right corner of the wall
you just created and enter
X coordinate = -0.24 for the
length and
Y coordinate = 2.40 for the width.
Delete Double Lines (Tools palette, Change area) and
5 Click
delete the two superimposed lines in the corner (generated by the
two rectangles).
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6 Click
Rectangle and draw the exterior wall at the top of the
stairwell. The start point is the interior edge of the corner (see
illustration below), length = 3.825, width = 0.24.

6

5

7 The
Rectangle tool is still active. To define the start point of
the next rectangle, use the options to snap to points and to enter
offset values.
8 Move the crosshairs to the bottom right corner of the wall you
have just drawn (see below). The data entry boxes in the dialog
line are highlighted in yellow.
Tip: Bear in mind that you
can select a wide range of
tools simply by clicking the
element in question with the
right mouse button (when no
function is active).

9 Enter a value of 1.01 for the
and press ENTER to confirm.

X coordinate in the dialog line

10 Enter 3.00 for the length and 0.24 for the width.

8

11

Moreover, you can activate
tools you have already used
on the Repeat menu.
11 You can delete the superimposed lines at the point where the
horizontal and vertical walls intersect using the
Delete Double
Lines tool (Tools palette, Change area).
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Draw the other interior walls by snapping to points and entering
Parallel Lines tool.
offset values. Experiment with the
When you have drawn all the walls, delete the redundant lines in the
areas where the walls intersect. You can also delete the lines in the
region where the interior walls and the exterior walls meet as the
same material is used for all walls.

Use the
Line tool to complete the door lintels and the beam near
the column. To do this, select pen thickness 0.25 mm.
Now the window openings in the exterior walls are missing.
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To draw window openings
1 Select pen thickness 0.50 mm and click
Create area).

Line (Tools palette,

2 Move the crosshairs to the top left corner of the exterior wall. The
data entry boxes in the dialog line are highlighted in yellow.
3 Enter a value of 0.55 for the
and press ENTER to confirm.
4 Enter a value of -0.30 for the

X coordinate in the dialog line
Y coordinate.

Parallel Lines (Tools palette, Create area) and draw a
5 Click
line to the right of the existing line. Enter an offset of 0.80.
Auto-Delete Segment (Tools palette, Change area) to
6 Use
delete the lines representing the lintels and complete the lintels
for the windows using a pen thickness of 0.25 mm.

2

6
6

Use the same approach to draw all the other window openings
yourself (see figure).
Experiment with the
toolbar).

Copy and

Copy and Resize tools (Edit
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Outline autoTip: Use
detect when you create the
style area.

Use the
Style Area tool (Tools palette, Create area) to apply
hatching to the walls of the floor plan as described in exercise 6 in
the Basics Tutorial. Set the pen thickness to 0.18 mm, select the style
area 301 Reinforced concrete and check that the layer SU_STYL is
active when you create the style area.
To finish, you will check the layers used, move the 2D floor plan in
such a way that the 2D and 3D floor plans are congruent, add the
opening for the stair and check the entire design using the Key plan
and General arrangement drawing plot sets.
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To check the layer settings
1 On the Format menu, click

Select, Set Layers.

Only the DE_GEN02 and SU_STYL layers should be available.

2 Click the SU_STYL layer with the right mouse button, choose
Visible, frozen and click OK to confirm.
The style area is displayed using color 25, which you selected for
frozen layers.
3 If necessary, correct the layer assignment and set the status of the
SU_STYL layer to Modifiable again.

To move the drawing in the workspace
1 Drawing file 102 is current. In addition, open drawing file 101 in
reference mode.
2 Click

Move (Edit toolbar).

3 Select the entire 2D floor plan and place it in such a way that the
2D and 3D floor plans are congruent.
4 Use the

Line tool to draw the edge of the slab in the stairwell.

To check the design using plot sets
1 Set drawing file 101 to edit mode. In addition, open drawing files
103 and 104 in edit mode.
2 On the Format menu, click

Select, Set Layers.
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3 Click in the layer structure with the right mouse button and, on
the shortcut menu, choose Match visibility from plot set....

Tip: The design exists twice
when the General
arrangement drawing plot
set is active.
If you want to display one
floor plan only, you can
define visibility settings for
layers or open/close the
relevant drawing files.

4 Select the Key plan plot set and click OK twice to confirm.
Now all you can see is the 2D floor plan with the main dimension
lines but without style areas.
5 Repeat steps 2 through 4 for the General arrangement drawing
plot set. Enable the Set all layers visible in the plot set to
modifiable option.
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Exercise 2: elevator shaft
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette to check whether the
includes the following module(s):

Bonus Tools family

3D Modeling:
This exercise involves designing an elevator shaft for the basement
you created in exercise 1.
You will mainly use the tools in the
3D Modeling module. You
can access these tools in the Tools palette, Create and Change areas.
Start by selecting fileset 2 with the following drawing files:
Fileset
2

Drawing
Drawing file name
file number
101

3D floor plan

201

General arrangement – 3D modeling
module

202

Concrete component

203

General arrangement – walls, openings,
components module

204

Associative views

205

Reinforcement drawing with 3D model

You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).
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Creating the 3D model using the 3D Modeling module
If you have not licensed the

3D Modeling module, you can use

the
Basic: Walls, Openings, Components module to design (on
page 103) the elevator shaft.

Tools
Box
Planar Polygonal 3D
Surface
3D Line
Polyline Sweep Solid
Change Archit.
Properties
Move

Objective:
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Start by making initial settings.

To select a drawing file and set options
1 Select the
Bonus Tools family in the Tools palette and open
the
3D Modeling module.
Open on a Project-Specific Basis (Standard toolbar),
2 Click
open the drawing file tree for fileset 2 by clicking the plus sign
beside the name of the fileset and double-click drawing file 201.
3 Check the current scale (1:100) and unit of length (m) in the
status bar.
4 On the Format toolbar, select pen thickness 0.50 mm and line
type 1.
3 Viewports.
5 On the Window menu, click
This way, you can always see the design in plan, perspective and
elevation.

Start by designing the floor slab using the

Box tool.

To draw a cube
1 Click
Note: By default, the layer
AR_GEN is used with the
3D Modeling
tools in the
module. As sections with their
own layers will be created
later using the
Associative Views module,
the layer setting is irrelevant.

Box (Tools palette, Create area).

2 In plan view (viewport on the right), click a point in the
workspace. The start point is to be the bottom left point of the
box.
3 Enter the following values in the dialog line:
X coordinate and 3.00 for
Diagonal point: enter 2.54 for the
the
Y coordinate. Then press ENTER to confirm.
Click point on parallel surface or enter height = 0.30
3 Viewports again to refresh the
4 On the Window menu, click
view in all the three viewports.
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In the next steps, you will create the polyline sweep solid consisting
of vertical walls which are joined with the floor slab in the
basement. This involves three basic steps:
• Create the outline as a planar polygonal surface.
• Create the path using 3D lines.
• Generate the polyline sweep solid.

To create the outline as a planar polygonal surface
1 Click
Planar Polygonal 3D Surface (Tools palette, Create
area). The following dialog box appears:

2 Click Enter new 3D lines and click OK to confirm.
3 In isometric view (viewport at top left), move the crosshairs to the
top front corner of the box. The data entry boxes in the dialog
line are highlighted in yellow.

3
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4 Enter
X coordinate = -0.20 and
Y coordinate = 0.50 and press ENTER to confirm.
The start point is attached to the crosshairs.
5 Enter values in the
shown below.

Z/

X coordinate data entry boxes as

Use the TAB key to switch between the data entry boxes.

dZ = 1.10
dX = 0.70
dZ = 0.30
dX = -1.00
dZ = -1.40
dX = 0.30

The design should now look like this in isometric view:
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The next step involves drawing the path for the polyline sweep solid
as a 3D line.

To draw the path for a polyline sweep solid as a 3D
line
1 Click

3D Line (Tools palette, Create area).

2 In isometric view, click the top left point of the outline (see
below).
Y/
X coordinate data entry boxes in the dialog
3 Use the
line to enter the dimensions of the shaft:
dY = 2.00
dX = -1.54
dY = -2.00
dX = 1.54

2

4 Press ESC twice to quit the tool.
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Now you will create the polyline sweep solid. The 3D line will serve
as the path; in other words, the polygonal surface will be moved
(‘swept’) along this line.

To create a polyline sweep solid
1 Click

Polyline Sweep Solid (Tools palette, Create area).

2 Click path for sweep solid: Click to the left of the 3D line and
enclose it in a selection rectangle without releasing the left
mouse button.
3 Click profile for sweep solid: click the polygonal surface.

2.2

2.1
3

The surface is swept along the profile.
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Your display should now look like this:

To finish, you will assign a surface element to the volume model.
This surface element will be used later when you create associative
sections. After this, you will move the volume model so that it is
congruent with the 3D floor plan created in exercise 1. In addition,
check that the top of the elevator shaft and the bottom of the
basement walls are flush.

To assign a surface element
1 Click
Change Archit. Properties (Architecture family, Basic:
Walls, Openings, Components module, Change menu).
2 In the Surface elements area, select style area 301 Reinforced
concrete.
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3 Select the entire volume model and click Apply in the Change
Archit, Properties dialog box.
4 Press ESC to quit the tool.

To move the volume model
1 Make drawing file 201 current and open drawing file 101 in
reference mode.
2

3 Viewports should still be active. Click
toolbar).

Move (Edit

3 In plan view (viewport on the right), select the entire volume
model.
4 On the Window menu, click
in all viewports.

3 Viewports to refresh the view

5 Position the volume model on the 3D floor plan in such a way
that they are congruent. In addition, the shaft dimensions must
match.
Move tool is still active.
6 The
Select the volume model again by double-clicking the right
mouse button and move it by
dz = -4.49.
This value is based on the absolute height of the basement walls
(= -2.79) and the overall height of the elevator shaft including
the floor slab (= 1.70).
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This elevator shaft and the floor plan of the basement will serve as
the basis for exercise 4 that shows you how to create sections using
the tools in the

Associative Views module and apply

reinforcement using the tools in the

Bar Reinforcement module.

Printing out layouts is covered in unit 9.

A note on concrete components
Using the

Concrete Construction - 3D Object tool in the

3D Modeling module, you can create three-dimensional
engineering components quickly and easily.
This tool, which requires a separate license, contains predefined
components whose dimensions can be customized in componentspecific dialog boxes. All entries you make are immediately
displayed in a preview on screen.
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A number of tools is provided to assist you when placing these
components.
Now you will create the floor slab and the walls of the elevator shaft
using a concrete component.

To create the floor slab and the elevator shaft as
concrete components
1 Click
Open on a Project-Specific Basis (Default toolbar),
close drawing file 201 and open drawing file 202.
Concrete Construction - 3D Object (Tools palette,
2 Click
Create area).

Note: Only the All catalog
comes with the program.
In addition, you can define
your own component-specific
catalogs (consult the online
Help).

3 The Select Component dialog box is displayed. Select Sleeve
foundation type 2.
4 Select the

Place sleeve on foundation axis check box.
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5 In the section view, click the overall height of the foundation,
enter 1.40 and press the TAB key to go to the next data entry
box. Enter the dimensions of the component as shown below.

6 Click OK to confirm the settings.
A preview of the component is attached to the crosshairs. Click
the bottom left corner of the elevator shaft to specify the drop-in
point. The bottom center of the foundation plate serves as the
component’s reference point.
7 Enter half the length of the opening in the dialog line.
•

X coordinate = 0.77

•

Y coordinate = 1.00

8 Point to the bottom left wall corner of the elevator shaft, click in
the workspace with the right mouse button and select
Component dialog on the shortcut menu.
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The component’s dialog box is displayed so that you can modify
the data.
9 Click
Enter elevation points and enter -4.49 for the
reference elevation of the component. Check the height by
moving the crosshairs in the workspace.
Tip: Any changes you make
are displayed directly in the
workspace.

10 Click OK to confirm the dialog box and place the component.
Then press ESC to quit the tool.
11 Select the
Change Archit. Properties tool and assign the style
area 301 Reinforced concrete to the concrete component. Use the
procedure previously described.
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Creating the 3D model using the Basic: Walls, Openings, Components
module
As an alternative to the

3D Modeling module, you can also use

the tools in the
Basic: Walls, Openings, Components module to
create the elevator shaft.
You can access these tools using the Tools palette, Create and
Change areas. As these tools were covered in exercise 1, they are no
longer explained in detail.

Tools:

Objective:

Wall
Slab
Recess, Opening in Slab
Move

Start by making initial settings.

To select a drawing file and set options
1 In the Tools palette, select the
Components module.

Basic: Walls, Openings,

Open on a Project-Specific Basis (Standard toolbar)
2 Click
and double-click drawing file 203.
3 Check the current scale (1:100) and unit of length (m) in the
status bar.
4 On the Format toolbar, select pen thickness 0.50 mm and line
type 1.
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Create the walls of the elevator shaft.

To create walls
1 Click
2 Click

Wall (Repeat menu).
Properties.

3 The Wall dialog box opens. Select wall thickness 0.300, priority
rating 300, pen thickness 0.50 mm and area style 301. Then click
Height....
4 Enter the height as absolute values:
•

Top level of wall: -3.09.

•

Bottom level of wall: -4.19.

5 Click OK to confirm the settings.
6 Click

Rectangular Component.

7 Start point: in plan view (viewport on the right), click a point in
the workspace.
Enter at right angles and check that the wall’s offset
8 Disable
direction is towards the outside! If necessary, change it by
clicking
Reverse offset direction.
X coordinate and 2.00 for
9 Diagonal point: enter 1.54 for the
the
Y coordinate. Press ENTER to confirm.
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Now you will create the slab and the floor slab for the elevator shaft.

To create the slab and the floor slab
1 Click
2 Click

Slab (Repeat menu).
Properties.

3 The Slab dialog box opens. Set the priority rating to 300, select
area style 301 and click Height....
4 Enter the height as absolute values:
•

Top level of slab: -2.79

•

Bottom level of slab: -3.09

5 Click OK twice.
6 Set properties, place polygon point 1, element or offset: enter
0.70 for the offset in the dialog line.
7 In plan view, click the bottom left corner of the wall you have
just created.
8 To point or element / enter offset: in plan view, click the top right
corner of the wall you have just created and press ESC.
Tip: You can also use the
Slab Foundation tool to
create the floor slab.
This tool allows you to define
the top level of the
foundation by matching the
bottom level of an existing
component.

9 Repeat steps 2 through 8 to enter the floor slab. The floor slab
projects from the wall by 0.20 m. Use the following absolute
values to define its height:
•

Top level of slab: -4.19

•

Bottom level of slab: -4.49

10 Press ESC to quit the tool.
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The slab now needs an opening.

To create a slab opening
1 Click
Tip: You can also select the
slab in elevation or isometric
view.

Recess, Opening in Slab (Repeat menu).

2 Click the upper slab.
3 On the Recess, Opening in Slab Context toolbar, click
Properties.
4 Select the Opening type and the
OK to confirm.

Freeform outline. Then click

Outline auto-detect in the input options (icon must
5 Switch on
be pressed in).
6 Change the offset to 0.00 in the dialog line and click within the
walls of the shaft. The system automatically detects the area.
7 Press ESC to quit the tool.
8 On the Window menu, click
in all viewports.

3 Viewports to refresh the view

Hidden Line
9 In isometric view (top left viewport), click
Representation in the border of the viewport.
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To finish, move the elevator shaft underneath the elevator shaft of
the basement you created in exercise 1.

To move the elevator shaft
1 Make drawing file 203 current and open drawing file 101 in
reference mode.
2

3 Viewports should still be active. Click
toolbar).

Move (Edit

3 In plan view (viewport on the right), select the entire elevator
shaft.
4 On the Window menu, click
in all viewports.

3 Viewports to refresh the view

5 Position the elevator shaft on the 3D floor plan in such a way
that they are congruent. In addition, the shaft dimensions must
match.
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Unit 3: Key Plan
In this unit you will learn how to create key plans
quickly and easily.

Exercise 3: key plan for basement
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette and check whether the
family includes the following module(s):

Engineering

Key Plan
In this exercise, you will create a key plan for the basement. This
exercise requires exercise 1.
You will mainly use the tools in the
Key Plan module. You can
access these tools in the Tools palette, Create and Change areas.
Start by selecting fileset 1 with the following drawing files:
Fileset
1

Drawing
Drawing file name
file number
101

3D floor plan

102

2D floor plan

103

2D stair

104

Dimensions and labels

105

Hidden line image

110

Key plan

You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).
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Objective:

Horizontal Mark
Slab Mark
Move
Modify Lines

Start by making initial settings.

To select drawing files and to set options
Tip: Look in the online Help
for basic information
on the Key Plan module:

1 Select the
Engineering family in the Tools palette and open
the
Key Plan module.
Open on a Project-Specific Basis (Default toolbar),
2 Click
open the drawing file tree for fileset 1, select drawing file 110,
open drawing files 102 and 103 in edit mode and close all the
others.
3 On the Window menu, click

1 Viewport.

4 Check the current scale (1:100) and unit of length (m) in the
status bar.
5 On the Format toolbar, select pen thickness 0.25 mm and line
type 1.
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Options (Default toolbar) and select the Key plan page.

7 Make settings as shown above and click OK to confirm.

As the half-space landing and the flights of the stair will be created
as precast elements, you will only draw the boundaries of these
components. Then you will use plot sets to specify which design
entities are visible.

To control the visibility of design entities
1 Click

Line (Repeat menu).

2 Click in the Select, Set Layers list box (Format toolbar) and then
Set....

3 Select the List entire layer hierarchy option and click the
button at top left to close the tree structure.
4 Open the Key plan layers in the Engineering layer structure by
clicking the relevant plus sign and double-click the layer
KP_GEN.
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5 Complete the design by drawing the stairwell and the other
missing stair components. Then press ESC to quit the tool.
6 Click in the Select, Set Layers list box again and select Set....
7 Click in the layer structure with the right mouse button and, on
the shortcut menu, choose Match visibility from plot set....
8 Select the Key plan plot set and click OK twice to confirm.
Now all you can see is the floor plan with the lines you have just
drawn but without style areas.

First, you will apply marks to the exterior walls. Next, a mark will be
assigned to the slab.

To create horizontal marks
1 Click
Horizontal Mark (Tools palette, Create area).
Check that the layer KP_MRK is active. If it isn't, activate it on
the Format menu or toolbar.
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2 On the Horizontal Mark Context toolbar, click
Direction of Load and select
Bubble.
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Without

3 Enable Plus Text, Leader and Number +. This defines how the
mark is displayed.
4 Click

to make settings for the mark text.

5 Set the following parameters:
• Text Height = Text Width: 2.50
• Aspect: 1.00
• Font: Arial
• Font angle in degrees: 90
6 In the dialog line, enter W01 and press ENTER to confirm.
7 Place the mark, which is attached to the crosshairs, outside the
exterior wall on the left (see illustration below).
Tip: You can specify the type
of leader on the Context
toolbar.

8 Reference to point: select the Straight setting and click the
exterior wall. The leader is created. Press ESC to finish.
9 Set a start point, click text or enter additional text: set the text
parameters and click where the additional text is to be displayed.
10 Enter d=30 for the additional text and press ENTER to confirm.

8
7
9
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11 Press ESC. The next mark number is already attached to the
crosshairs. You can modify it in the dialog line.
12 Enter W02 for the exterior wall at the bottom.
13 Use the same approach to assign mark numbers W03 and W04 to
the other exterior walls.
14 Press ESC twice to quit the tool.

Two options are available for displaying slab marks: a mark can be
displayed horizontally or at an angle that reflects the angle of the
slab diagonal. In this exercise, you will create horizontal marks.

To create slab marks
1 Click

Slab Mark (Tools palette, Create area).

2 Click
Direction of Load on All Sides, set the arrow length,
which is relative to the slab size, to 0.10 and disable the Leader
option.
3 Enter 01 in the dialog line and press ENTER to confirm.
4 Start point, match text or enter mark text: click the bottom left
corner of the slab.
5 Diagonal point, match text or enter mark text: click the top right
corner. The mark is displayed.
6 Click where the additional text is to appear.
7 Enter the additional text in the dialog line and press ENTER to
confirm.

Engineering Tutorial

Unit 3: Key Plan

115

8 Press ESC twice to finish.

5

4

Allplan provides several methods for modifying key plans:
You can use this tool to modify marks.
You can use this tool to modify text in marks.
You can use this tool to modify lines and their reference.
You can use this tool to edit additional text.
You can use this tool to change text settings.
You can use this tool to replace text in marks.
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The next step is to move the slab mark.

To modify marks
1 Click

Move (Edit toolbar).

2 Select the element(s) you want to move: click the mark.
The mark including additional text, leaders and slab diagonals is
selected.
3 From point: click the center of the circle.
4 To point: drag the circle on the diagonal upwards to the right.

4
3
2

The slab diagonals have also moved.
5 Click

Modify Lines (Tools palette, Change area).

6 Click line to be modified: click the end of the lower diagonal.
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7 To point or line: click the bottom left corner.

6
7

8 Use the same approach to modify the line at the top.
9 Press ESC to quit the tool.

Mark reports
You can assign detailed, additional text to the marks. In order for the
marks to be displayed more clearly, you can select the Additional
text as construction lines setting in the options. You can then print
Report tool (Tools
the marks and the additional text using the
palette, Create area).
Complete the key plan as shown below. Do not assign marks to the
half-space landing and the flights of the stair as these components
are precast elements.

118

Exercise 3: key plan for basement

Allplan 2013

Then open drawing file 104 in edit mode. As you have selected the
Key plan plot set, only the main dimension lines are displayed.

Printing out layouts is covered in unit 9.
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Unit 4: Reinforcement
Drawing
This unit consists of four exercises, in which you will
learn how to create reinforcement drawings quickly and
efficiently.
 You will use the tools in the
Associative Views and
Bar Reinforcement modules to
reinforce a 3D elevator shaft and create a
reinforcement model in 3D at the same time (method
1). Finally, you will create a reinforcement schedule
and a bending schedule.
Bar Reinforcement
 You will use the tools in the
module to reinforce a basic 2D door lintel, create a
reinforcement model in 3D (method 2) and save the
reinforcement as a symbol.
 You will use the tools in the
Bar Reinforcement
and
Mesh Reinforcement modules to reinforce a
basic 2D slab without creating a 3D model from the
reinforcement (method 3).
 You will use the tools in the
reinforce a section of a slab.

BAMTEC module to

To finish, you will learn how to manage cross-section
catalogs.
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Overview of exercises
Exercise 4: creating a 3D elevator shaft with a 3D model
(method 1)
You will use the tools in the Associative Views and Bar Reinforcement
modules to reinforce the elevator shaft you created in exercise 2.
Based on the reinforcement, a three-dimensional model will be created
automatically.
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Exercise 5: creating a 2D door lintel with a 3D model (method 2)
You will draw a door lintel using the tools in the Draft module and
reinforce it using the tools in the Bar Reinforcement module. Based
on the reinforcement, a three-dimensional model will be created
automatically.

Türsturz

M 1:50

Ansicht

Schnitt

You will save the door lintel as a symbol in a catalog. You will then
retrieve and modify it.

Türsturz
Ansicht

M 1:50
Schnitt
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Exercise 6: creating 2D slab without a 3D model (method 3)
You will use the tools in the Bar Reinforcement and Mesh
Reinforcement modules to reinforce sections of the slab you created
in exercise 1. In this exercise you will not create a 3D reinforcement
model.
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Exercise 7: BAMTEC® reinforcement
You will use the tools in the BAMTEC module to reinforce a section
of the slab without a 3D model.

a
längs

Teppichdatei:
BAM0503.TEC

a
quer

Initial settings
Until now you have been working with the Palette Configuration
and you have activated tools by selecting the relevant family and
module in the Tools palette.
In the following exercises you will access tools in different families
and modules without setting them in the Tools palette first. This
requires the following settings:
• Select the
Views, Details family in the Tools palette and open
Associative Views module.
the
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Tip: The step-by-step
instructions make extensive
reference to flyouts and the
icons they contain. If you
are a novice, we strongly
recommend that you make a
copy of this and stick it on
your screen!
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• Show the Engineering toolbar, which contains the most
important tools in the
Engineering family on flyouts.
Click the status bar with the right mouse button and click
Engineering on the shortcut menu. Double-click the title bar of
the Engineering toolbar to dock it at top left.
Bar Entry and Placement flyout
Area Reinforcement flyout
Mesh Entry and Placement flyout
BAMTEC flyout
Display flyout
Engineering Modify flyout
Lists/Schedules flyout

Exercise 4: creating a 3D elevator shaft with
a 3D model (method 1)
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette and check whether the

Engineering and

Views, Details families include the following modules:
Associative Views

Bar Reinforcement

Check whether the following tools are available on the Engineering
toolbar:
Bar Shape
FF Components

Engineering Tutorial

Tip: Look in the online Help
for basic information
on the reinforcement
methods:
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In this exercise you will reinforce the 3D elevator shaft you created
in exercise 2. First, you will create the shell using associative
sections. Next, you will create the reinforcement with a 3D model
(method 1). This exercise requires exercises 1 and 2.
Start by selecting fileset 2 with the following drawing files:
Fileset
2

Drawing
Drawing file name
file number
101

3D floor plan

201

General arrangement – 3D modeling
module

202

Concrete component

203

General arrangement – walls, openings,
components module

204

Associative views

205

Reinforcement drawing with 3D model

You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).
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Task 1: creating associative sections
In the first part of this exercise, you will use the architectural floor
plan and the 3D elevator shaft to create associative sections, which
will form the basis for placing reinforcement later (see Tip).
Tip: For more information on
Associative Views
the
module, please consult the
online Help:

You will mainly use the tools in the
Associative Views module.
You can access these tools in the Tools palette, Create and Change
areas.

Tools:
Create Section

Objective:
Grundriss Bodenplatte d=30cm

Grundriss Schachtwände d=30cm

Copy
Modify View and
Section Properties
Properties palette

Schnitt A-A

Schnitt B-B

You can use the tools in the
Associative Views module to create
clipping paths and views. These form the basis for the reinforcement
drawing later.
At first glance, associative views and sections would appear to be no
different from 2D data. However, they are derived from a threedimensional model and are therefore inherently linked with this
model.
The component displayed will automatically update to reflect any
modifications you make to the 3D component or in a view or
section. If, for example, you move an opening in the front elevation
or insert it in the floor plan later, the 3D component and all
associative views and sections of your general arrangement drawing
will adapt automatically. You can also make modifications in
isometric views.

Engineering Tutorial

Unit 4: Reinforcement Drawing

127

Placing reinforcement has an immediate and direct effect on the
three-dimensional model and consequently on all the other views
and sections.
To create reinforcement, at least two orthogonal views or sections
are required. You can create any number of additional sections by
deriving them from the three-dimensional model. The reinforcement
is automatically displayed in the appropriate manner and can be
labeled immediately.
Sections are different to views in that they have a spatially delimited
depth. This delimitation is defined using two clipping lines.
Start by making initial settings.

To select drawing files and to set options
 Open the Tools palette and check whether the
Associative
Views module (Views, Details family) is selected.
Open on a Project-Specific Basis (Default toolbar),
1 Click
open the drawing file tree for fileset 2, select drawing file 204,
open drawing files 101 and 201 (or 203) in edit mode and close
all the others.
2 On the Window menu, click
still open.

1 Viewport if three viewports are

3 In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.
4 Click

Options (Default toolbar) and then Associative views.

5 Check whether the Create across drawing files and Transfer 3D
components automatically to sections options are selected. If
they aren't, select them.
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6 On the Format menu, click
Select, Set Layers, select the List
existing layers in open documents option, click the
ARCHITECTURE layer structure and then the
button at top left
to expand the tree structure.
7 Select the layers AR_GEN and AR_WALL, click the selection with
the right mouse button and, on the shortcut menu, choose
Modifiable.
Note: If you are using drawing file 203 instead of drawing file
201, the layer AR_GEN is not available. In this case, set the
AR_SLAB layer to modifiable.

8 Select the List entire layer hierarchy option, expand the
ENGINEERING layer structure and navigate to the Shell layers.
Make SH_GEN current and set SH_SHL to modifiable.
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You will begin by creating a plan view based on the 3D shell
drawing data. The height will not be delimited.

To create a plan view
1 Click
Create Section (Tools palette, Create area).
The layer set on the Format toolbar is used for the label. You
cannot select a different layer. The layer for the section is taken
from the 3D components. You can also specify it in the dialog
boxes for hidden line images and sections.
2 Select 3D elements of which you want to create a section: click to
the left of the elevator shaft's upper floor slab and enclose it in a
selection rectangle without releasing the left mouse button (see
below). This selects the elements fully bounded and intersected by
the selection rectangle (
Select elements based on direction is
enabled in the Filter Assistant).
2.1

2.2

Tip: In Observer mode, the
bottom edge is placed so that
it is always horizontal; in
other words, horizontal edges
are always horizontal,
regardless of the viewing
direction.
When set to Folded, however,
the section created is folded.

Note:
You can also activate
Select elements fully bounded and
intersected by selection rectangle in the Filter Assistant and
define the selection rectangle independently of the direction.
3 On the Create Section Context toolbar, you can switch between
Observer and Folded by clicking the buttons. Select Observer.
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4 Select viewing direction: click in the circle. This has the effect
that the object is viewed from the top when the section is
calculated.
5 From point: click to the left of and below the bottom left corner
of the upper floor slab (see below).
6 To point: click a point above the top right corner of the upper
floor slab (see below). Then press ESC to finish.
6

5

The View and Section Properties Context toolbar is displayed
and the section is attached to the crosshairs.
7 The Status box is set to Hidden. If it isn't, click the box to switch
to the hidden line image.
8 Click the Def... button on the View and Section Properties
Context toolbar to open the Settings for Hidden Line Images
dialog box. Check that the Show visible edges and Display
hidden edges options are selected, specify the following format
properties and click OK to confirm the dialog box.
Visible edges:
Pen 0.35 mm; do not change the line and color; layer SH_SHL
Hidden edges:
Do not change the pen, line and color; layer SH_SHL
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9 On the View and Section Properties Context toolbar, click
Section settings for associative view beside
.
10 In the Representation of clipping path area, select the Place
clipping line option. In the Section display area, select the Apply
thick line around intersected elements option and then Exterior
edges. Finally, select layer SH_SHL for all linear elements and
click OK to confirm the dialog box.
Leave the other settings as they are.
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11 On the View and Section Properties Context toolbar, click
Dimension Line to switch off dimensioning.
Tip: Track tracing helps you
place points in exact
alignment with existing
points. You can press the F11
Track line
key or click the
icon in the dialog line to
quickly switch track tracing
on and off.

12 To point or angle of rotation: place the section so that it is to the
right of and aligned with the architectural floor plan.
13 Press ESC as you do not want to define additional sections.
14 To define the label for the plan view, enter
Floor slab, t = 30cm
in the dialog line and press ENTER to confirm.
15 Set the label’s parameters (text height 5mm, text width 4mm) and
place the label for the view.
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You will now create a longitudinal section and a transverse section
based on the plan view you generated beforehand.

To create sections
 The
now.

Create Section tool is still active. If it isn’t, activate it

1 Select 3D elements of which you want to create a section: select
the entire plan view you created beforehand by enclosing it in a
selection rectangle or by clicking the view border.
2 Select viewing direction: click below the circle. The effect of this
is that the object is viewed from the front when the section is
calculated.
3 Define the clipping area by clicking the bottom left corner and
the top right corner in the area of the door opening (see below).
Then press ESC to finish.

3

3

2

4 On the View and Section Properties Context toolbar, click
Section settings for associative view beside
and make
the following settings in the Section object area of the Section
dialog box:
• Select the Display section object (as construction lines) check
box.
• Clear the Height of section object based on intersected
elements check box and enter
-2.29 for the top level and -4.49 for the bottom level.
• Click OK to confirm the dialog box.
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5 To point or enter a rotation angle: place the section so that it is
below and aligned with the floor plan and press ESC.
6 Enter the label for the section in the dialog line, press ENTER and
place the label.
Create Section tool is still active. Select the plan view
7 The
again and create the longitudinal section (viewed from the right).
8 Place the section to the right of the transverse section.
9 Press ESC to quit the tool.

Note: You can configure the program to automatically dimension
associative views and sections. All you need to do is enable the type
of dimension line you want to use and make appropriate settings on
the View and Section Properties Context toolbar.

Finally, you will copy the plan view and modify the height settings
in order to display the floor slab and shaft walls separately.

To copy the plan view and to adjust the height
1 Click

Copy (Edit toolbar).

2 Select the entire plan view by enclosing it in a selection rectangle
or by clicking the view border and place the copy so that it is to
the right of and aligned with the plan view.
Tip: If no tool is active, you
can also open the
modification tool by doubleclicking the section with the
left mouse button.

Modify View and Section Properties (Tools palette,
3 Click
Change area) and select the entire plan view on the left.
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4 On the View and Section Properties Context toolbar, click
Section settings for associative view and make the
following settings in the Section object area of the Section
dialog box:
• Clear the Height of section object based on intersected
elements check box and enter
-4.00 Leave the bottom level as it is: -4.49.
• Click OK to confirm the dialog box.

5 Click Apply to confirm the View and Section Properties Context
toolbar.
6 Use the same approach to modify the height settings of the plan
view on the right. Enter the following values:
• Top level -2.75.
• Bottom level -3.15.
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7 Press ESC to quit the tool, switch to the
Properties palette, click the label of the plan view on the right
and change it as shown below.
Grundriss Bodenplatte d=30cm

Schnitt A-A

Grundriss Schachtwände d=30cm

Schnitt B-B
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Task 2: edge reinforcement of floor slab
Tip: Refer to the chapter
”Reinforcement methods - 3D
reinforcement model” in the
online Help:

Now you will place bar reinforcement and create a three-dimensional
model as you go along (method 1; see Tip).
You will mainly use the tools in the
Bar Reinforcement module.
You can access these tools using the flyouts on the Engineering
toolbar and the shortcut menu.
First you will create the edge reinforcement of the floor slab. You
will use the

Bar Shape tool, which combines the functions of the

Enter and
FF Bar Reinforcement tools and which will
eventually replace these two tools.
• For the longitudinal direction, you will create the bending shape
as a freeform bar by specifying individual points.
• For the transverse direction, you will use a predefined bending
shape that expands to adapt to the existing outline.

Tools:
Options
Bar Shape:
Freeform
Place Bar Shape:
Along placing line
Mirror and Copy
Label
Dimension Line, Label
Bar Shape:
Open Stirrup
Modify placement
display mode

Objective:
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Start by making initial settings.

To select drawing files and to set options
1 Click
Open on a Project-Specific Basis (Default toolbar) and
double-click drawing file 205.
Thus only drawing file 205 is open. All the other drawing files
are closed.
Open on a Project-Specific Basis again or double-click
2 Click
in the workspace with the left mouse button, open drawing file
204 in
edit mode and click Close to quit the dialog box.
Note: If the Automatically transfer 3D components to sections
option is selected and you are working in a workgroup
environment, you need to open drawing file 204 in
reference
mode to ensure a smooth workflow.
3 Change the scale in the status bar to 1:50 and check that the
current unit of length is set to m.
4 Check whether the Engineering toolbar is displayed at top left. If
it isn't, show it as described in the initial settings (on page 123).
5 Switch to the Tools palette and define the DEFAULT layer as the
current one.
Modify View and Section Properties tool to hide the
6 Use the
section object in each of the two sections.
7 Select Reinforcement drawing for the drawing type in the status
bar.
The hatching in the sections changes to fills.

Tip: You can specify how bar
reinforcement is displayed
Options for the
using the
Bar Reinforcement module.
For more information please
consult the online Help.

Before you start, you need to specify whether Allplan is to create a
3D reinforcement model (see Tip on page 136).
In this exercise, you will work with the reinforcement model (method
1). This means that the reinforcement placed will be managed
internally by the system and displayed in all the views and sections
that are created using the tools in the

Associative Views module.
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For the reinforcement of the floor slab, which is 30 cm thick, you
will create two-way bar reinforcement of Ø12/10 cm in the top layer
and Ø10/10 cm in the bottom layer. The concrete cover is 4 cm.
The layer BR_GEN is proposed for bar reinforcement. You can use
this layer here as it is not necessary to differentiate between the
upper and lower reinforcement layers.
You will place the reinforcement on several layers when you create
the slab reinforcement in exercise 6.
Start by creating the freeform bending shape of the open stirrup in
the longitudinal direction.

To enter the open stirrup as a freeform bending shape
1 Click
Options (Default toolbar), select the Reinforcement page
and check that the Reinforce with 3D model option is active in
the General area.
2 Click
Bar Shape (Bar Entry and Placement flyout).
Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
Tip: Allplan also provides a
predefined bending shape for
creating open stirrups. You
will use it later when you
enter open stirrups in the
transverse direction.

The Bar Shape palette opens and the Freeform bending shape is
active by default. You can use it to create any bending shape. To
use a different bending shape, click the button above the graphics
area and select one of the predefined shapes.
Click
to open a dialog box that displays all the bending
shapes graphically in groups.
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3 In the parameter area of the palette, select diameter 12, enter
0.04 for the concrete cover and clear the Hook at start and Hook
at end check boxes.

4 To enter the open stirrup, click the points in section A-A as
shown below. The next step is to define the segment length.

A 1st point
D

A

C

B

B 2nd point
C 3rd point
D 4th point

5 Press ESC to finish entering the open stirrup.
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6 In the parameter area of the palette, enter 0.80for the length of
the Initial segment and the Final segment.
Note: You can still change almost all the parameters. Any
changes you make are immediately displayed in the preview.

7 Press ESC to finish entering the bending shape. As the Label
option was active in the input options when you created the bar
shape, the
Label tool starts automatically.
To finish entering the bending shape and to label the bar, click in
the workspace with the right mouse button and select the
Label tool on the shortcut menu.
8 Make settings for the mark text in the palette.
Select the Options for text line and click , enter 1.00 for the
aspect and click OK to confirm.
9 Place the mark.

10 This defines the bending shape. If you want, you can continue
and immediately place the open stirrup you just created.
However, you can also press ESC and place the mark later using
the
Place Bar Shape or
Place tool.
In this exercise you will place it now.
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To place the open stirrup in edge-based mode
1 The palette of the
Place Bar Shape tool is open and Linear
placement is active.
If it isn’t, click the open stirrup you want to place with the right
mouse button and, on the shortcut menu, choose
Place Bar
Shape.

2 Click the edges of the outline to define the placing area.
Placing line from point: click the bottom right corner in plan
view.
Placing line to point: click the top right corner (see illustration).

Tip: The entries you make are
immediately displayed in the
preview. This way, you can
check the effects of your
settings at any time.
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Symbols indicate the placing region.
Using the input options, you can define the position of the placed
bar, specify how the placement is to be displayed and select
automatic labeling.
Tip: Refer to the chapter
”Reinforcement methods placing mode: align / move /
rotate” in the online Help:
3 Select the Align option and set the placement display mode to
Show middle bar only.
Align uses the spatial orientation and position of the identified
mark and places the reinforcement in alignment (see Tip).
4 In the parameter area of the Place Bar Shape palette, enter 0.04
for the concrete cover and 0.10 for the spacing. You can leave
the other settings as they are.

5 Click
Dimension Line, Label on the shortcut menu.
Alternatively press ESC twice to quit the tool and to start the
Dimension Line, Label tool.
6 Make settings for the dimension lines in the palette.
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7 Select the Dimension line options line and click . The
Dimension Line dialog box opens. Check that the layer BR_GEN
is selected. Change the aspect to 1.00.

8 Click OK to confirm the Dimension Line dialog box and click a
point through which the dimension line is to pass.
The palette switches to the Text/leader tab, where you can define
the label for the placement.
9 Specify the parameters as shown, select the Options for text line
and click , enter 1.00 for the aspect and click OK to confirm.
Note: Automatic mark number is selected in the input options.
Depending on the drop-in point specified, the program
automatically creates the mark number at the beginning or end of
the label. You can check this by moving the crosshairs over the
workspace.
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10 Place the label and press ESC to quit the tool.
Note: When you click
Zoom All, you can see that Allplan has
created not only the reinforcement in the associative views but also
a reinforcement model of the 3D elevator shaft.
To hide the model data, use
to define a section and click
save this section.
The procedure was described in unit 2 when you created the
architectural floor plan.

to
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Displaying and labeling placements
When placing reinforcement, you can specify the placement display
mode in the input options or in the dialog box:
All the bars are displayed.
Only the bar in the middle is displayed.
You can select the bars to be displayed.
A single bar is displayed as folded. This defines the exact
position of the bar, which is required for placing it on the
building site. Allplan presents the different directions in which
the bar can be folded. Select the direction you want to use.
You can use the
the display later.

Modify Placement Display Mode tool to change

Labels can be placed at any time. The Display flyout provides the
following tools for creating labels at a later stage:
Label
Dimension Line, Label
Reinforcement placed is displayed in all the views and sections.
During creation, however, reinforcement can only be labeled in the
placing view. You need to place labels in all the other views and
sections later.
Instead of placing the bar again on the opposite side, it is easier to
mirror mark 1. You can then label the reinforcement.

To mirror and copy reinforcement placed
Tip: To activate general edit
tools, you can also click in the
workspace with the right
mouse button and select a
tool on the shortcut menu.

1 Click

Mirror and Copy (Edit toolbar).

2 Click the bar in the section.
3 Define the mirror axis:
1st point of mirror axis: using the right mouse button, click a
horizontal line of the floor slab in the transverse section and click
Midpoint on the shortcut menu. Make sure that you do not
click the midpoint of the line or any other existing point.

Engineering Tutorial

Tip: Track tracing helps you
define the 2nd point of the
mirror axis. You can press the
Track
F11 key or click the
line icon in the dialog line to
quickly switch track tracing
on and off.

Unit 4: Reinforcement Drawing

147

2nd point of mirror axis: in the dialog line, enter a value that is
not zero for the
Y coordinate and press ENTER to confirm.
4 Press ESC to quit the tool.
5 Using the right mouse button, click the bar in the section and
Label on the shortcut menu.
select
6 Place the mark where you require and press ESC to quit the tool.

6

5

3

2

7 Due to the three-dimensional association of the sections, the
mirrored placement is also displayed in the floor plan. Click the
bar in the floor plan with the right mouse button and, on the
shortcut menu, click
Dimension Line, Label to label the
placement.
8 Place the dimension line and the label to the left of the floor plan
and press ESC to quit the tool.

7

8
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As an alternative, you will now use a predefined, expanding bending
shape to create the edge reinforcement in the transverse direction.
Finally, you will place the bending shape automatically.

To create an expanding open stirrup and place it
automatically
1 Click

Bar Shape (Bar Entry and Placement flyout) again.

2 Select the Open stirrup bending shape in the list box at the top
of the Bar Shape palette

3 In the parameter area of the palette, select diameter 12 and clear
the Same concrete covers check box as these bars are in the
second layer. Change the values for Concrete cover 1 and 3 to
0.055 each and the value for Concrete cover 2 to 0.04.
4 Enter 0.80 for Segment length 1 and 3 and clear the Hook check
box.
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5 Move the crosshairs in section B-B onto the bottom right edge of
the floor slab until the open stirrup expands correctly, then click
the left mouse button.

5

6 Press ESC and place the label for the bar in the section.
7 Select the

Place automatically option in the input options.

Using automatic depth placement, the bar is immediately placed
in the floor plan of the floor slab.
Note:
Automatic depth placement is only possible when you
create the bending shape in a 3D outline and place it immediately
afterwards.
In this case, you cannot define the the placement display mode:
all the bars are always displayed.
Dimension Line, Label on the Repeat menu, click a bar
8 Select
in the placement you just created and place the dimension line
and the label.
9 To copy these bars to the lower part of the floor plan, click
Mirror and Copy (Edit toolbar) and select the placement as an
entity group in plan.
10 1st point of mirror axis: using the right mouse button, click a
vertical line of the floor slab in plan and select
Midpoint on
the shortcut menu.
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11 2nd point of mirror axis: in the dialog line, enter a value that is
not zero for the
X coordinate and press ENTER to confirm. Press ESC.
12 Using the right mouse button, click one of the placements in
Modify Placement Display Mode on the shortcut
plan, select
menu and activate
Show middle bar only for both
placements.

13 Use the shortcut menu and the
Label and
Dimension Line,
Label tools to create labels for the bottom placement in the
section and plan.
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Task 3: Area Reinforcement of the Floor Slab
The edge reinforcement of the floor slab has been placed. The
following part of the exercise involves creating area reinforcement.

Tools:

Objective:

Enter
Area Reinforcement
Span Reinforcement
New Mark Number
Modify Mark
Modify Placement
Display Mode

You will start by creating two-way bar reinforcement.

To create span reinforcement for the bottom layer
Tip: You can also select the
Create menu and click
Engineering, Bar
Enter
Reinforcement,
Area Reinforcement and
Span
choose
Reinforcement on the
Context toolbar that appears.

1 Click

Span Reinforcement (Area Reinforcement flyout).

2 Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
3 From point or element / enter offset: click the bottom left corner
in the floor plan.
4 To point or element / enter offset: enter -0.04 for the support
depth in the dialog line.
Entering a negative value moves the placing polygon towards the
inside.
5 Click the top right corner of the floor plan.
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5

3

6 Press ESC to finish. This selects the area.

7 Define the layer depth. Click in the box beside

Layer Depth.

8 Layer in reference view: click the bottom left point in section B-B.

8
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The dashed line indicates the current layer depth of the
reinforcement. The concrete cover is taken into account. The
elevation symbol shows the layer depth of the definition point
entered. The direction of the positive bar segments and the
placing direction of the bar are indicated by the arrow.
9 Click Concrete Cover (Bottom) and enter 0.04. In section B-B
you can see how the dashed line moves.
10 Click OK to confirm the entries.

11 Set placing parameters:
Diameter 10,
Spacing 0.10,
Angle 0.00,
Equal offsets to edge
Select PP (= placement in polygon) at bottom right.
As the bars and the edge reinforcement are congruent in the floor
plan, set the placement display mode to
Show selected bars
to ensure that the edge reinforcement is not hidden.
12 Click OK to confirm.
13 Select the bar you want to display: all the bars are displayed in
the selection color in the preview. Click a bar in the upper part
and press ESC.
14 Select the Bar markers option, specify the symbol type and place
the dimension line.
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15 Select the Custom text parameter, type in bottom in the line
provided for defining text and place the label.
16 Next, you will place the transverse reinforcement. You do not
need to enter the general arrangement polygon again. You can
copy the one you used for the longitudinal reinforcement. Click
Match in the input options.

17 Select the polygon you want to match: click the existing polygon.
18 The system will automatically propose 0.050 for the concrete
cover at bottom. Increase this value to 0.055 (this is to take the
bar ribs into account) and click OK to confirm.
19 The system will automatically propose 90 degrees for the placing
angle. Check the settings and click OK to confirm.
20 Select a bar to be displayed and place the dimension line and the
label to which you have added custom text.

The bottom layer should now look like this:
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Now that you have completed the bottom layer, you should be able
to create the bars for the top layer yourself. The following section
should serve as a guideline.

To create span reinforcement for the top layer
1 The
now.

Span Reinforcement tool is still active. If it isn’t, select it

2 Match the existing general arrangement polygon.
Layer depth, click the top left point of the floor
3 To define the
slab in section B-B and enter 0.00 for the
Component
thickness.
4 Click Concrete Cover (Top) and enter 0.04.
5 Confirm the settings and set the placing angle to 0.00 degrees.
6 Change the diameter to 12 in the dialog line and confirm.
7 Select a bar to be displayed and place the dimension line and the
label to which you have added custom text (here: "top").
8 Use the same approach to create the second reinforcement layer
at the top. Bear in mind that you need to associate the layer
depth with the top level and click Concrete Cover (Top) after you
have copied the general arrangement polygon. Here, too, set the
diameter to 12.
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The floor slab should now look like this:

Instead of creating the top layer from scratch, you can mirror and
copy the bottom reinforcement.
As the diameter of the top bars is 12 mm, you need to assign new
mark numbers to the bars of the mirrored reinforcement using the
New Mark Number tool (Engineering Modify flyout).
You can then change the diameter using the
Modify Mark tool
and select the bars to be displayed and place labels using the
Modify Placement Display Mode tool.
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Task 4: starter bars
The reinforcement for the floor slab is complete. Now the wall
reinforcement is missing. This part of the exercise involves placing
the starter bars.
Tools:

Objective:

Bar Shape:
Open Stirrup
Stirrup, closed
Modify Placement
Display Mode
Place Bar Shape:
Along placing line
Dimension Line, Label

To enter and place starter bars
1 Using the right mouse button, double-click the open stirrups of
the floor slab wherever you like.
Bar Shape tool starts and the Open stirrup bending shape
The
is active. The diameter is set to 12.
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2 Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
3 In the parameter area of the palette, select the Same concrete
covers check box, enter 0.04 for the Concrete cover and 1.00 for
the Segment length 1 and 3.

4 Move the crosshairs in section A-A over the left outer edge of the
wall until the open stirrup expands correctly, then click the left
mouse button.

4

5 Press ESC to label the bar.
6 Place the bar label in the section.
Place automatically is still set in the input options. The open
stirrups are placed across the entire shaft wall on the left in the
floor plan.

Engineering Tutorial

Unit 4: Reinforcement Drawing

159

If they aren't, click
New placing line in the parameter area of
the palette and define the placing line accordingly.

7 Select
Dimension Line, Label on the Repeat menu, click a bar
in the placement you just created in plan, deactivate the Bar
markers option and place the dimension line.
8 Deactivate the Custom text option and place the label.
9 Press ESC to quit the tool, click the placement in plan with the
Modify
right mouse button and, on the shortcut menu, choose
Placement Display Mode.
Show selected bars, click the three bars just below the
10 Choose
middle (see following illustration) and press ESC twice.
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The floor slab should now look like this:

Now you will place mark 7 in more walls.
Remember: you inserted a door opening in the wall on the right
when you created the floor plan of the basement. In this region,
mark 7 will not be placed. You will use closed stirrups instead. The
placing region for mark 7 will be defined in the floor plan of the
shaft walls. The placed bars, however, will only be displayed in the
floor plan of the floor slab as the starter bars are not within in the
clipping area of the shaft walls.

To place and rotate starter bars
1 Click
Place Bar Shape (Bar Entry and Placement flyout) and
confirm the value displayed in the dialog line: mark 7.
2 Deactivate the Align option in the input options.
3 Place mark 7 in the lower transverse wall (from left to right). To
define the end points of the placing line, click the points where
the inside edges of the longitudinal walls and the outer edge of
the bottom wall intersect (use
Point of Intersection on the
shortcut menu).
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Tip: The sequence in which
you enter points is irrelevant
with the Align placing mode.
With the Move or Rotate
options, however, the
sequence in which the points
are entered defines the
direction of the placing
region.
Look in the online Help for
information on the different
placing modes:
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3

4 In the parameter area of the palette, set the Angle of rotation to
Perpendicular. The preview of the bending shape changes
accordingly.

5 In the input options, click
Show selected bars, select the bars
you want to display and press ESC.
6 Click in the workspace with the right mouse button and choose
Dimension Line, Label, place the dimension line and the label
in the floor plan and press ESC to quit the tool.
Mirror and Copy tool to copy the reinforcement and
7 Use the
its label to the transverse wall at the top. (Alternative: do not
change the Angle of rotation and continue to place the bars in
the transverse wall at the top.)
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8 Click
Place Bar Shape again and confirm the value displayed
in the dialog line: mark 7.
The Align option is not active, and the angle of rotation is set to
Perpendicular.
9 Placing line from point: click the bottom right outer corner of the
30 cm shaft wall in the floor plan of the shaft walls.
10 Placing line to point: click the point where the lower reveal and
the 30 cm shaft wall intersect.

The placing region is highlighted in the floor plan of the shaft
walls, and the placement is displayed in the floor plan of the
floor slab. As the starter bars for the wall are not within the
clipping area of the shaft walls, all the bars are displayed,
regardless of the selected display mode.
11 Press ESC to finish.
12 Use the same approach to place the starter bars above the door
opening. To define the first point of the placing line, click the
point where the upper reveal and the 30 cm shaft wall intersect.
Click the top right outer corner of the 30 cm shaft wall to define
the second point of the placing line.
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13 Select
Dimension Line, Label on the Repeat menu, click a bar
in the placement you just created in the floor plan of the floor
slab and place the dimension line and the label.
14 Create the dimension line and the label for the second placement
and press ESC to quit the tool.
15 Using the right mouse button, click one of the placements in the
floor plan of the floor slab, click
Modify Placement Display
Mode on the shortcut menu and select
Show middle bar
only.
16 The display of the placement clicked changes. Click the second
placement and press ESC to quit the tool.
You will now create and place a closed stirrup in the wall near the
door opening.

To create and place a closed stirrup in the door area
1 On the Repeat menu, click
Bar Shape.
Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
2 Select the Stirrup, closed bending shape in the list box at the top
of the Bar Shape palette.
3 In the parameter area of the palette, select diameter 12 and enter
0.04 for the concrete cover.
4 Move the crosshairs in section A-A over the left outer edge of the
wall on the right until the open stirrup expands correctly, then
click the left mouse button.
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5 Press ESC and place the label for the bar in the section.
6 Automatic depth placement is not useful as the stirrups are only
Place
placed around the door opening. Deactivate the
automatically option in the input options. The Align option is
active.
7 Define the placing line by clicking a corner of the upper reveal in
the floor plan of the shaft walls and then the corresponding
corner of the lower reveal.
8 Select
Dimension Line, Label on the Repeat menu and create
dimension lines and labels for the placements in the floor plans.
Modify Placement Display Mode,
9 On the Repeat menu, click
select
Show middle bar only and click the placement in the
floor plan of the floor slab.
10 Press ESC to quit the tool.

This completes the starter bars for the walls.

Grundriss Bodenplatte d=30cm
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Task 5: bar reinforcement for the walls
The following part of the exercise involves applying reinforcement to
the walls up to the top level of the floor slab (TL = -2.79). You will
enter the reinforcement in the floor plan of the shaft walls.

Tools:

Objective:

Bar Shape:
Freeform
Straight bar
L-shaped bar

Schnitt A-A

Place Bar Shape:
Along placing line
Modify View and
Section Properties
Define Batch
Place:
Place in Batch
Reinforcement Tools

Tip: To create complex
bending shapes (e.g. bent-up
bars for silos, towers or barrel
roofs), you can use the
Convert, Match Elements
tool to convert a bending
shape you have drawn using
Draft module to a bar.
the
When converting, Allplan
interprets the design entities
as the center line of the bar.
This should be borne in mind
when you create them.

Due to the offset, a cranked bar needs to be created for the exterior
wall reinforcement. You will create this bar manually using the
Freeform bending shape provided by the

Bar Shape tool.

To manually enter and place cranked bars
1 Select the
Bar Shape tool again and select Freeform.
Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
2 Clear the Same concrete covers check box and enter 0.00 for the
Concrete cover at start and Concrete cover at end.
3 Click the "+" symbol beside the Segment parameter and enter
0.04 for the Concrete cover of segment.
4 Click the two outside corners of the top left wall in section B-B.
Start at the top.
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Tip: You can also define the
segment type in the graphics
area.

5 In the parameter area of the palette, set the Segment type to
Crank and click the point where the shaft wall and the upper
floor slab intersect.

6 The segment type automatically switches back to Default. To
define the last point, click the point where the shaft wall and the
lower floor slab intersect.
Make sure that the preview of the segment is within the wall. To
achieve this, you need to approach the point from the outside.
7 Press ESC to finish entering the bending shape. Enter 0.95 for the
length of the Initial segment and 1.10 for the length of the Final
segment.
Note: To check or change the crank, select the Segment
parameter, click
to select the segment 2/3 and then click
beside Crank value.
8 Press ESC and place the label for the bar in the section.
A

B
C

A 1st point
B 2nd point
C 3rd point

D

D 4th point
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9 In this example, automatic depth placement would not be
created at the required position. Therefore, leave the setting of the
Place automatically option in the input options as it is (not
selected!) and define the placing line in the floor plan of the shaft
walls:
• Placing line from point: click the bottom left outside corner of
the 30 cm shaft wall.
• Click the bottom right outside corner of the 30 cm shaft wall
to define the 2nd point of the placing line.
10 Clear the Same concrete covers check box in the parameter area
of the palette. Taking the wall offset of 6 cm into account, enter
0.10 for the Concrete cover at start and Concrete cover at end.
Show all bars in the input options. Open the shortcut
11 Select
menu and select the
Dimension Line, Label tool.
12 Create the dimension line and label for the placement in the floor
plan of the shaft walls. The floor plan should now look like this:

13 Place this mark yourself in the floor plan of the shaft walls (not
in the area near the door!) and label the placements. Note that the
concrete cover of the placement beside the reveal of the door is
0.04 instead of 0.10.
Deactivate the Align option and set the angle of rotation to
Perpendicular.
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14 To ensure that the wall reinforcement, which protrudes above the
clipping area defined, is displayed in its entirety, you will now
modify the upper section border in the two sections. Double-click
the view border of a section with the left mouse button and click
Yes to confirm the message. Double-click the view border of a
section with the left mouse button again to open the
Modify
View and Section Properties tool. Click
Section settings for
associative view, change the Top level to -1.7900, click OK to
confirm the dialog box and click Apply. Use the same approach
to change the top level of the second section.
To complete the vertical wall reinforcement, you will create and
place a straight bar. In addition, an L-shaped bar will be inserted in
the upper floor slab.

To enter a straight bar and an L-shaped bar and to
place them in batch mode
1 Close the drawing files 101 and 201 (or 203), open the Repeat
menu, click
Bar Shape and select the Straight bar bending
shape.
Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
2 Deactivate the Expand to adapt to edges option in the input
options.
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3 Select diameter 12 in the parameter area of the palette, disable
the Same concrete covers option and change the value for
Concrete cover 1 to 0.04 and the values for Concrete cover at
start and Concrete cover at end to 0.00.
4 To define the start point, click the corner of the left inside edge of
the shaft wall (see figure) in section B-B.
5 Enter 0.00 for the
X coordinate in the dialog line and 2.40
for the
Y coordinate. Press ENTER to confirm.
6 This creates the bar with the mark number 10. Press ESC and
place the label for the bar in the section.
7 Press ESC as you do not want to place the bar now.
Bar Shape tool is still active. Select the L-shaped bar
8 The
bending shape.
9 Here, too, click the corner of the left inside edge of the shaft wall
in section B-B to define the start point.
10 To define the other points, click the point where the inside edge
of the shaft wall and the top level of the upper floor slab intersect
and then click the top left end point of the floor slab.
11 Select diameter 12 in the parameter area of the palette, change
the value for Concrete cover to 0.04 and enter 1.00 for segment
lengths 1 and 2.
12 Press ESC, place the label for the bar in the section, and press
ESC twice to stop placing the bar and to quit the tool.

10
10

4,9
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13 Using the right mouse button, click one of the bars you have just
created and select
Define Batch on the shortcut menu.
14 Select bars for the batch: select marks 10 and 11 using the
Brackets (Filter Assistant toolbar).
15 Click mark 10 with the right mouse button and select
on the shortcut menu.
16 Click

Place

Place in Batch and click OK to confirm.

17 Proceed in a clockwise direction and place the mark on the inside
edge of the walls in the floor plan of the shaft walls. Enter 0.00
for Concrete cover at start and Concrete cover at end and enter
0.04 for Concrete cover of placement. Start with the wall at the
bottom. Select the Align setting and enter 0,015 for the spacing
in the dialog box.

For the other placements, click mark 10 in the section, confirm
the placing mode, select the Rotated setting and 270°, 180° and
90° for the placing angle on the left, at the top and on the right,
respectively.
18 Place labels as shown below.
Use the same approach to place the reinforcement in the wall on
the right; however, skip labeling.

Engineering Tutorial

Unit 4: Reinforcement Drawing

171

Tip: When you click Custom
in the input options after you
have defined the first
placement, you can
immediately enter the next
placing region along any
placing line (here: the wall on
the left, for example) and
then create common labels
and dimension lines for these
placements.
Enable the 'number of pieces'
option for the individual
dimension lines.

19 L-shaped bars are required near the door. In this area, you need
to
Delete (Edit toolbar) the straight bars (mark 10) placed on
the inside.
With the
Select elements based on direction setting, you
need to start on the left hand side when you open the selection
rectangle. You can also activate the
Fully bounded selection
option in the Filter Assistant.
20 Using the right mouse button, click an L-shaped bar placed, select
Modify Placement Display Mode on the shortcut menu and
click
Show middle bar only in the input options.
21 Click all the L-shaped bars placed and press ESC.
Dimension Line, Label tool on the shortcut menu to
22 Use the
label marks 10 and 11 in the wall on the right.
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The floor plan of the floor slab also contains marks 9 and 10. You
will now hide the wall reinforcement in this area.

To hide reinforcement placed
1 Click
to show
Tip: Click
hidden reinforcement again.

Reinforcement Tools (Display flyout).

2 Click Hide V (hides selected reinforcement in one view).

3 In the floor plan of the floor slab, click all the bars of the wall
reinforcement you want to hide.
Next, you will create horizontal bars as straight bars. They will be
entered in the floor plan of the shaft walls and placed in the
sections.
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To create and place transverse reinforcement using
horizontal bars
1 Double-click a mark (10, for example) in the floor plan of the
shaft walls with the right mouse button to open the
Bar
Shape tool. Select the Straight bar bending shape.
2 Change the value for Concrete cover 1 to 0.055 as the bar is to
be within the transverse reinforcement.
3 Start at the top and click the inside corners of the shaft wall on
the right in the floor plan of the shaft walls. The bar is displayed
in the preview. Press ESC and place the label for the bar.

3

3

4 The bar created is placed in section A-A.
Place automatically
is not active in the input options. It is the Align option that is
selected.
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5 Click the upper and lower wall corner on the right. In the
parameter area of the palette, enter 0.055 for the Concrete cover
at start and 0.02 for the Concrete cover at end.
6 Press ESC twice to quit the tool and to start the
Line, Label tool.

Dimension

7 Select a different dimension line for the label of mark 12. Select
the Fan dimension line type in the Bar Label palette.
8 Set the parameters so that the number of pieces, diameter and
spacing are displayed and change the setting for the text leader
to Manual.

9 Select the Options for text line and click
aspect and click OK to confirm.

, enter 1.00 for the
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10 Place the label and click all bars to which you want to apply a
leader.
11 Press ESC twice to quit the tool.

5

5

12 Now you can place mark 12 along the other vertical bars or you
can mirror and copy the placement:
Tip: If you consider the
spacing between the mark
border and label to be too
Options,
large, open the
Reinforcement - Labels page
and set the blank after the
mark to "0" (in the preview
for the Bar reinforcement at
the top of the page).

13 Now use the same procedure to create horizontal reinforcement
for the transverse side. To enter the bending shape, select Expand
to adapt to edges in the input options. Define a new placing line
in the area of the shaft wall in section B-B. The start point of this
new placing line is at the top and the end point at the bottom.
Finally, hide the transverse reinforcement in the floor plan of the
floor slab.
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Now, you will complete the labels in the sections and floor plans.
Start with section A-A.

To label reinforcing bar placements later
Tip: If you want to modify an
existing label, click it and
open the Properties palette.
Change the settings in the
parameter area of the palette
and click in the workspace to
finish.

1 Click mark 3 (lower longitudinal reinforcement in the floor slab)
in section A-A with the right mouse button and select
Label
on the shortcut menu.
2 Select the Diameter and Spacing parameters and place the label.
The text leaders are set to Automatic. With the Automatic mark
number being selected in the input options, the program places
the mark number at the beginning or end depending on the
position of the label. If you want, you can deactivate this option.

3 Click mark 5, confirm the settings, place the label and press ESC.
4 Click mark 4 with the right mouse button and select
Dimension Line, Label on the shortcut menu.
The Fan dimension line type is selected from the label of the
horizontal reinforcement. In addition, the text leaders are set to
Manual.
5 Deactivate the Number of pieces parameter and place the label.

6 Click all the bars to which leaders are to be drawn.
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7 Press ESC to finish.
8 Click mark 6, confirm the settings and place the label.
9 Click all the bars to which leaders are to be drawn and press ESC
to finish.
Label on the Repeat menu and label marks 9, 10 and
10 Click
11. Deactivate the Diameter and Spacing parameters. The text
leaders are set to Automatic.

Schnitt A-A

11 Now create the labels for section B-B as shown below:
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Schnitt B-B

12 Complete the labels in the floor plan of the shaft walls as shown
below:

Grundriss Schachtwände d=30cm
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Now you have reinforced the elevator shaft with the exception of the
horizontal corner reinforcement, which will be created using FF
components. Finally, you will define the clipping area of the shaft
walls.

To modify the clipping area
1 Double-click the view border of a section with the left mouse
button and click Yes to confirm the message.
2 Using the right mouse button, click the view border in the floor
plan of the shaft walls and, on the shortcut menu, choose
Modify View and Section Properties.
Section settings for associative view and set the Top
3 Click
level of the section object to
-3.1000 and the Bottom level to -3.4000.
4 Click OK to confirm the dialog box and click Apply.

Task 6: Standard Section
In this exercise, you will learn about the function used to place bars
in views.
Tools:

Objective:

FF Components
Place:
Place In View

Regelschnitt
horizontale Eckbewehrung
4*ausführen

Modify Number Off
Factors

With the option to place reinforcement in views, you can assign
placement quantities to bars without having to place them in a
specific region. The reinforcement is only displayed in one view.
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This placing mode is useful for displaying standard details. If you do
not enter the dimensions in the placement direction, you need to
determine the number of bars manually.
The location of the bars in space is not defined when you place bars
in this mode. The placement only affects the quantities (number off
figures).

To create a standard section using FF components and
place it in view mode
1 Click
Open on a Project-Specific Basis (Default toolbar) and
make drawing file 204 current. Drawing files 101, 201 (or 203)
and 205 are now open in edit mode.
2 Use the tools in the Draft and Text modules (Create menu) to
draw a wall corner to the right of the floor plan of the shaft
walls. Label this standard section and select the style area 301
Reinforced concrete (see following illustration).
Assign the layer BR_GEN to the elements by clicking
Select,
Set Layers on the Format menu and double-clicking the layer
BR_GEN.

Regelschnitt
horizontale Eckbewehrung
4*ausführen

3 Click
FF Components (Bar Entry and Placement flyout).
Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
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4 Select the Wall corners catalog in the Select Component dialog
box and double-click Wall corner.

5 Enter the global values in the first line of the Wall corner dialog
box: 12 for the
Diameter, 0.10 for the
Bar spacing, 0.80
for the
Segment length and 0.055 for the
Concrete cover.
As the corner reinforcement is only used for assembly, set the
diameter to 8 and click OK to confirm.
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6 Move the cursor to the left edge of the wall corner until the
reinforcement expands correctly, then click the left mouse button.
7 Click Cancel as you do not want to enter dimensions in the
placing direction.
Entering dimensions causes the program to determine the number
of the stirrups and the length of the longitudinal bars based on
the component settings specified.
8 Select view Click the floor plan of the shaft walls. This assigns the
standard detail to this view.
9 The system prompts you to specify the position of the label for
the first stirrup. Press ESC.
10 Select

Place In View and click OK to confirm.

11 Enter 14 (= number of horizontal bars) for the number, set the
spacing to 0.10 and click OK to confirm.
12 Enable Number of pieces, Diameter and Spacing and place the
label.
13 The dialog line prompts you to specify the position of the label
for the second stirrup. Press ESC.
14 The procedure is the same as for the first stirrup.
15 Enter 1.35 for the length of the longitudinal bars, do not change
the other settings and click OK to confirm.
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16 As the wall corner exists four times, click
Factors (Modify flyout).

Modify Number Off

17 Select placed reinforcement to modify number off factors: select
the entire reinforcement of the standard section, enter 4 for the
Component factor and click OK to confirm.
Dimension Line, Label and label
18 On the Repeat menu, click
the horizontal bars, mark 15, by enclosing them in a selection
rectangle. Select Number of pieces and Diameter for the label
parameters and set the text leaders to Automatic.

Task 7: bar schema
The following part of the exercise involves creating bar schemas.
You will create full schemas which are drawn to scale and place
them beside the design.

Tools:
Full Schema

Objective:
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The partial and full schema tools provide a way of displaying the
internal number-off and bending shape management in the
reinforcement drawing. You can place a schema bar and label for
every mark in the drawing file. The schema will automatically
update to reflect any changes you make to the placed reinforcement
or bending shapes.
There are two types of schema:
•

Full Schema
Number off information on all the placements of a mark

•

Partial Schema
Number off information on one placement of a mark

The bending shape can be drawn to scale or not and it can be
displayed so that it is aligned with the placement.

To create a full schema
1 Click

Tip: If you have deleted a bar
while working, the bar’s mark
number will remain
‘unassigned’.
Rearrange
You can use
Marks to close this "gap".

Full Schema (Display flyout).

2 Select Meshes or Rebars in the Input options, and in the dialog
line, enter the number of the mark based on which a schema is to
be created or click the mark.

3 Enter the settings as shown above.
4 The schema and its label are attached to the crosshairs.
You can use the
Rotate and
Mirror options to specify how
the bars are positioned. Place the schema to the right of the
sections.
5 You should be able to create the other bar schemas yourself. For
straight bars, you can switch off
leg dimensioning. Set the
text angle so that it matches the position of the bar shape.
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Tip: If you consider the
spacing between the diameter
and length to be too small,
Options,
open the
Reinforcement - Labels page
and insert a blank in front of
the length ("L=" in the
preview for the Bar
reinforcement at the top of
the page).

Task 8: reinforcement schedule and bending schedule
The last part of this exercise involves creating a reinforcement
schedule and a bending schedule.

Tools:
Reinforcement Reports
Reinforcing Bar Legend

Objective:
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Reinforcement schedules are created as you work and are thus
always up-to-date. You can also print them whenever you need.
Start by printing the bar schedule, which Allplan 2013 has created
automatically as you worked.

To create a bar schedule
1 Click

Reinforcement Reports (List/Schedules flyout).

2 The Reports dialog box appears in which you can select
predefined reports.
If necessary, click the Default folder on the left and select the
Reinforcement schedule - bending shapes report.
Tip: Parameters relevant to
marks (like number off value,
steel grade, diameter and
individual length) are saved
for reports.
You can create reports both
in document edit mode and
in layout edit mode.

3 Click All in the Input options.
Tip: Click the dimensioned
bending shapes in the Report
editing mode
Viewer in
to modify them in the
workspace.

The report is displayed in the Report Viewer. Various attributes,
such as the project, are included automatically.
4 Enter Elevator shaft - reinforcement drawing for the Layout
parameter. This attribute is taken automatically from the layout
name in layout edit mode.
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5 Clear the Show steel grade check box as there is only one steel
grade in the layout.

6 Click

Print, select the printer and start printing.

Note: In Allplan 2013 you can place bending schedules in layouts.
To print a bending schedule, you can use the Reinforcement
schedule - bending shapes report provided by the
Reinforcement Reports tool.
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Now you will place the bending schedule in the drawing file.

To place the bending schedule in the drawing file
1 Click

Reinforcing Bar Legend (Reports flyout).

2 Select the legend you want to use.
3 If necessary, select the Associative legend of active document
option and click OK to confirm the Legend selection dialog box.
When this option is selected, the bending schedule updates
automatically when you add or delete marks later.
4 Place the bending schedule in the workspace.
A section of the diagram should now look like this:

5 Define the DEFAULT layer as the current one.
Printing out layouts is covered in unit 9.
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Exercise 5: creating a 2D door lintel with a
3D model (method 2)
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette and check whether the

Engineering and

Views, Details families include the following modules:
Associative Views

Bar Reinforcement

Check whether the following tools are available on the Engineering
toolbar:
Bar Shape
In exercise 4, you reinforced a 3D general arrangement drawing and
created a 3D model (method 1, see Tip).
Tip: Refer to the chapter
”Reinforcement methods - 3D
reinforcement model” in the
online Help:

In the following exercise, you will create a precast element of a
reinforced door lintel as a symbol. You will apply reinforcement to a
2D general arrangement drawing and create a 3D model (method 2,
see Tip).
Start by selecting fileset 3 with the following drawing files:
Fileset
3

Drawing
Drawing file name
file number
301

General arrangement in 2D

302

Reinforcement drawing with 3D model

303

Modified door lintel

You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).

190

Exercise 5: creating a 2D door lintel with a 3D model (method 2)

Allplan 2013

Task 1: designing a reinforced door lintel
First, you will use the tools in the
Draft module to create an
elevation and section view as the general arrangement drawing for a
precast door lintel.
After this, you will apply reinforcement. You will mainly use the
Bar Reinforcement module. You can access these
tools in the
tools using the flyouts on the Engineering toolbar and the shortcut
menu.
Finally, you will save the precast door lintel as a symbol in a
catalog.

Tools:

Objective:

Options
Bar Shape:
Stirrup, closed
Straight bar

Türsturz
Ansicht

M 1:50
Schnitt

Place Bar Shape:
Along placing line
Along placing segment
Single placement
Dimension Line, Label
Write to Library

First, draw the outline.

To draw the outline in 2D
1 Click
Open on a Project-Specific Basis (Default toolbar),
open the drawing file tree for fileset 3 and double-click drawing
file 301.
2 In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.
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3 Use the tools in the Draft module to create the design as shown
below. Select pen thickness 0.35 mm for the elevation and 0.50
mm for the section. Use the
Rectangle and
Line tools
(Create menu - Draft module).
Assign the layer DE_GEN02 to the elements by clicking in the
Select, Set Layers list box (Format toolbar) and selecting the
layer DE_GEN02.

Türsturz
Ansicht

M 1:50
Schnitt

You do not need to draw the coordinate system and the 3D view
(shown as dashed lines), which serve as an aid to orientation.
4 Double-click in the workspace with the middle mouse button to
refresh the view.

Tip: Refer to the chapter
”Reinforcement methods orientation in space” in the
online Help:

Now you will create and place the stirrup reinforcement for the
beam. The setting you make defines the spatial orientation for the
entire reinforcement (see Tip).
The layer BR_GEN is proposed for bar reinforcement. You can use
this layer here as it is not necessary to differentiate between the
upper and lower reinforcement layers.

To manually create and place stirrup reinforcement
1 Make drawing file 302 current and set drawing file 301 to edit
mode.
Options (Default toolbar), select the Reinforcement page
2 Click
and check that the Reinforce with 3D model option is active in
the General area.
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3 Click
Bar Shape (Bar Entry and Placement flyout).
Check that the layer BR_GEN is selected. If it isn't, activate it on
the Format menu or toolbar.
4 Select the Stirrup, closed bending shape in the list box at the top
of the Bar Shape palette.

5 In the parameter area of the palette, select diameter 8 and enter
0.03 for the concrete cover.
You can leave the other settings as they are.
6 The Expand to adapt to edges and Label options are active in the
input options. Move the crosshairs in the section to the
component line on the left within the outline until the bending
shape expands, then click in the workspace.
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7 Click Yes at the following prompt asking whether you want to
work with associative views
Tip: As you are creating a 3D
reinforcement cage, you need
to provide the system with a
spatial reference. In the case
of 3D outlines, the spatial
orientation is automatically
defined by the view.

8 Select a projection for 3D position: the stirrup is located in the YZ plane and is to be placed in the X direction. Click X and click
OK to confirm.
this setting defines the spatial orientation for the entire
reinforcement.
9 Press ESC to start the
Label tool and place the bar label in the
section. Set the parameters so that only the mark number is
displayed.

The

Place Bar Shape tool opens automatically.
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10 Placing line from point: click the bottom left end point of the
beam.
11 Placing line to point: click the bottom right end point of the
beam.
12 Select viewing direction: click to the right of the bending shape.
The placed area is selected (marked) and you can see already
whether the bar is located in the correct position.

Tip: You can change the
placement display mode
immediately using the input
options or later using
Modify Placement Display
Mode.

13 In the parameter area of the Place Bar Shape palette, select the
Same concrete covers option and enter 0.03 for the Concrete
cover. If necessary, set the angle of rotation to 0 and the spacing
to 0.10. You can leave the other settings as they are.
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14 Press ESC twice to quit the tool and to start the
Line, Label tool.

Dimension

Note: If you have not worked through exercise 4, you need to set
the aspect to 1.00 by selecting the Dimension line options line
and clicking .
15 Set the type to Dimension line and place the dimension line and
label below the beam. Set the label parameters so that the number
of pieces, diameter and spacing are displayed.

Türsturz
Ansicht

16 Press ESC to quit the tool.

M 1:50
Schnitt
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Next, you will create and place the longitudinal reinforcement of the
beam based on the stirrup reinforcement you just entered.

To create and place the bottom longitudinal
reinforcement
1 Click

Bar Shape (Bar Entry and Placement flyout) again.

2 Select the Straight bar bending shape in the list box at the top of
the Bar Shape palette.
3 Select diameter 14 in the parameter area of the palette, disable
the Same concrete covers option, if necessary, and change the
value for Concrete cover 1 to 0.04 and the values for Concrete
cover at start and Concrete cover at end to 0.03.
4 Deactivate the Expand to adapt to edges option in the input
options and click the two bottom corners of the beam in
elevation view. This creates the bar.
If you want, you can still change all the parameters except for
the (bending shape).
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5 Press ESC, set the label parameters as shown below and place the
label.

The

Place Bar Shape tool opens automatically.

Segment in the input options and click the bottom
6 Click
stirrup leg in the section (see following illustration).

7 In the parameter area of the Place Bar Shape palette, enter 4 for
the Number, click in the workspace with the right mouse button
and select
Dimension Line, Label on the shortcut menu.
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8 Select the Fan dimension line type and set the parameters so that
only the number of pieces and the diameter are included.

With the Automatic mark number being selected in the input
options, the program creates the mark number at the beginning
or end of the label depending on the drop-in point specified.
9 Place the label below the bars. The system automatically draws
leaders to all the bars.
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The next step is to enter the top longitudinal reinforcement. You will
learn about an approach that is particularly useful for reinforcing
components in section or plan without creating an additional view.

To create the top longitudinal reinforcement in the
section and to place it freely in the view
1 The
Bar Shape tool is still active. If it isn’t, select it on the
Repeat menu.
The bending shape is set to Straight bar.
Straight bar as point in the input options and select
2 Select
diameter 12 in the parameter area of the palette.

3 Click

Measure Length (Default toolbar).

4 Click the top left and right end points of the beam.
in the Measured values dialog box and then click L =
5 Click
1.99000 m.
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6 Select the value for the Bar length in the parameter area of the
palette, click this box with the right mouse button and, on the
shortcut menu, choose Paste.

7 The value 1.99000 is entered. Taking the concrete cover of 3.0
cm at the start and end into account, change this value to 1.93.
Place bar in fillet is active in the input options. Do not
change this setting.
8 The cut bar is attached to the crosshairs. Move the crosshairs to
the top left rounded corner of the stirrup and click the left mouse
button.
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9 Click in the workspace with the right mouse button and select
Place Bar Shape on the shortcut menu.
10 Select Single placement in the list box at the top in the Place Bar
Shape palette.
11 Select view: Click the beam displayed in elevation.
Anchor point to top right in the input options and
12 Set the
enter 0.03 for the
Offset in X direction and 0.04 for the
Offset in Y direction.

13 Click the top right corner of the beam displayed in elevation.
14 Press ESC as you do not want to create an additional placement.
15 Press ESC again to skip labeling.

Türsturz

M 1:50

Ansicht

Schnitt
11

13

8
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16 Click
Mirror and Copy and mirror the top longitudinal bar in
the section.
17 Press ESC to quit the tool.

Now you can create the missing labels. The top longitudinal bars are
two separate placements. To create a common label, you need to
select both placements.

To label the top bars later
1 Click

Dimension Line, Label (Display flyout).

2 Using the left mouse button, enclose the two bars at the top in
the section in a selection rectangle (from left to right).
Select elements based on direction is active in the Filter
Assistant.
3 Confirm the dimension line type and place the mark above the
bars. You can enter a direction angle for the label in the dialog
line. The system automatically draws leaders to all the bars.
4 Using the same approach, create a label for top longitudinal bars
in the view and place it above the bars.
5 Press ESC to quit the tool.
The drawing should now look like this:

Türsturz
Ansicht

M 1:50
Schnitt
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Now that you have completed the reinforcement of the door lintel,
you will save it as a symbol. You will then retrieve and modify it.
Symbols and their use is covered in the Basics Tutorial.

To create and save a symbol
1 Click

Write to Library (Standard toolbar).

2 All users should be able to access this reinforcement symbol.
Click Office in the Path area and Symbol catalog in the Library
area.
3 Click OK to confirm.
The dialog box disappears. Now you are back in the workspace.
In this example, only associative views without the reinforcement
model are available. As you want to copy the 3D model without
the views, you must not select the view borders. Otherwise, the
views are also copied.
Brackets, enclose the entire reinforcement symbol in
4 Open the
a selection rectangle and click the view borders of the two views.
With the exception of the view borders, all the elements are
displayed in the selection color. Close the
Brackets.
Tip: You can also change the
position of a symbol’s base
point when you retrieve it.

5 Click the bottom left corner of the beam in elevation view to
define the symbol’s base point. This is the point at which the
element is attached to the crosshairs when you retrieve it later.
6 Click Dumb symbol without Snoop functionality in the dialog
box and click OK to confirm.
7 Click the next available subfolder and enter a name: Standard
details.
8 In the Name area, choose an unassigned number and enter a
name for the symbol: Door lintel.
9 Press ESC to quit symbol entry.
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Task 2: modifying the reinforced door lintel
Now you will retrieve the door lintel and modify it.

Tools:

Objective:

Get from Library

Türsturz

M 1:50

Ansicht

Stretch Entities

Schnitt

New Mark Number
Properties palette
Rearrange Marks
Properties palette
This task also requires fileset 3:
Fileset
3

Drawing
Drawing file name
file number
301

General arrangement in 2D

302

Reinforcement drawing with 3D model

303

Modified door lintel

You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).

First, you will retrieve the symbol and place it in a separate drawing
file.

To retrieve a symbol
1 Click
Open on a Project-Specific Basis (Standard toolbar)
and double-click drawing file 303.
2 In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.
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Get from Library (Standard toolbar).

4 Click Office in the Path area and Symbol catalog in the Library
area. Then click OK to confirm.
The Get Symbol dialog box appears.
5 Select Standard details and click Door lintel.
6 Disable the Auto-adjust to reference scale option and click OK
to confirm.
Now you are back in the workspace. The symbol is attached to
the crosshairs at its base point.
7 Click in the workspace to place the symbol and press ESC to quit
symbol entry.
8 Double-click in the workspace with the middle mouse button to
refresh the view.

Next, you will modify the clear dimensions of the door opening and
the width of the door lintel. In addition, you will modify the spacing
between the stirrups in the middle and the diameter of the bottom
longitudinal reinforcement.
As you saved the door lintel with the 2D general arrangement
drawing when you defined the symbol, you do not need to create it
again. If you only save the reinforcement itself as a symbol, you can
also place it in a new general arrangement drawing.

To modify the door lintel's dimensions
1 Click

Stretch Entities (Edit toolbar).

2 Using the left mouse button, enclose the stirrup leg on the right
and the top and bottom corner bars in a selection rectangle in the
right-hand part of the section (see below).
3 Enter dX = 0.06, dY = 0.00 and dZ = 0.00 to change the width
to 30 cm. The outline and reinforcement adapt automatically.
4 Use the same approach to modify the support area on the left in
the elevation (dX = -1.00, dY = 0.00 and dZ = 0.00).
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The door lintel should now look like this:

Türsturz
Ansicht

M 1:50
Schnitt

2

4

4

2

Next, you will alter the spacing in the middle of the beam. First, you
will assign a new mark number. Then you will modify the spacing
and rearrange the marks so that the stirrup reinforcement is
combined to a single mark again. Finally, you will change the
diameter of the bottom longitudinal reinforcement.

To modify reinforcement
1 Click

New Mark Number (Engineering Modify flyout).

2 What is to become a new mark? Click to the left of the 14 stirrups
in the middle of the beam and enclose them in a selection
rectangle without releasing the left mouse button (
Select
elements based on direction is active in the Filter Assistant).
3 The system proposes a new mark number (based on the last mark
number assigned plus one). Accept it and press ESC.
4 Click a stirrup in the middle, select the Properties palette and
select Place Bar Shape (1) in the list box at the top.
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5 In the parameter area of the palette, change the Offset to 0.20
and click in the workspace to finish.

Türsturz
Ansicht

2
4
2

M 1:50
Schnitt
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6 Click a bar with the right mouse button and select
Rearrange
Marks on the shortcut menu in order to combine the two marks
to a single mark.

7 Make settings as shown above and click OK to confirm.
8 Delete the label for the stirrups in the elevation, click
Dimension Line, Label and use the brackets to select all the
stirrups in the elevation.
9 Set the type to Dimension line, select the Dimension line text
option, select No. of pieces + spacing for the text and place the
dimension line.
10 For the label, switch off spacing, place the label and press ESC to
quit the tool.
11 Click a bar in the bottom longitudinal reinforcement and select
Bar mark (1) in the list box at the top in the Properties palette.
12 In the parameter area of the palette, change the Diameter to 16
and click in the workspace to finish.

13 Switch to the Tools palette.
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Your drawing should now look like this:

Türsturz
Ansicht

Tip: The essentials are
described in the online Help
that comes with Allplan.
Refer to the chapter about
Associative Views
the
module and the chapter
”Reinforcement methods - 3D
reinforcement model”.

M 1:50
Schnitt

Finally, you can create a bar schema. The approach is the same as
with the elevator shaft in exercise 4. Consequently, it is not
described any further here.
As you created the reinforcement with a 3D model, you can delete
the elevation or section at any time and create them again using the
Associative Views module. As opposed to the
tools in the
elevator shaft, only the three-dimensional reinforcement cage is
displayed (see Tip).
If you want to reinforce a component in the floor plan only, you can
create a new plan view provided the original view or the section still
exists.

Printing out layouts is covered in unit 9.
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Exercise 6: creating 2D slab without a 3D
model (method 3)
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette and check whether the
family includes the following module(s):
Mesh Reinforcement

Tip: Refer to the chapter
”Reinforcement methods - 3D
reinforcement model” in the
online Help:

Engineering

Bar Reinforcement

This exercise involves reinforcing a floor slab based on the 2D floor
plan of the basement created in exercise 1. In this exercise you will
not create a 3D model (method 3, see Tip). This exercise requires
exercise 1.
Start by selecting fileset 4 with the following drawing files:
Fileset
4

Drawing
Drawing file name
file number
102

2D floor plan

401

Reinforcement, bottom layer - without
3D model

402

Reinforcement, top layer - without 3D
model

You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).

Instead of drawing file 102, you can also open drawing file 101 of
exercise 1 in edit mode. In this case, set the status of the existing
layers to Modifiable and hide the style areas so that you can see
Show/Hide (Default toolbar) and
better what you are doing: click
deactivate the style area.
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Task 1: mesh reinforcement, bottom layer
In this part of the exercise, you will create the mesh reinforcement
for the bottom layer.
You will mainly use the tools in the
Mesh Reinforcement
module. You can access these tools using the flyouts on the
Engineering toolbar.
Tools:

Objective:

Options
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Start by making initial settings.

To select drawing files and to set options
Tip: You can specify how
mesh reinforcement is
displayed using the
Options tool.
For more information please
consult the online Help.

1 Check whether the Engineering toolbar is displayed at top left. If
it isn't, show it as described in the initial settings (on page 123).
2 Click
Open on a Project-Specific Basis (Standard toolbar),
open the drawing file tree for fileset 4, make drawing file 401
current and open drawing file 102 in edit mode.
3 In the status bar, click the current Scale and select 1:50. Check
the current unit of length and set it to m, if necessary.
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Now you will start by placing meshes in the span at bottom left in
the floor plan.

To place by span in a rectangular area
1 Click
Options (Standard toolbar), select the Reinforcement
page, clear the Reinforce with 3D model check box in the
General area and click OK to confirm.
2 Click
Span Reinforcement (Mesh Entry and Placement
flyout).
The system proposes the layer MR_GEN.
3 Click in the Select, Set Layers list box (Format toolbar) and then
Set....
4 Select the List layers assigned to currently selected menu option
and double-click the layer MR_M_B.
5 From point or element / enter offset: enter 0.15 for the support
depth in the dialog line.
6 Define the placing polygon by clicking the bottom left inside
corner of the wall and then the top right wall corner. Press ESC
to finish.

6

6
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7 The support depth needs to be changed on the right and at the
top. Click
Support depth in the dialog box.
8 Click side of polygon: click the right side of the polygon and
enter 0.12.
Tip: When Transverse
Overlap is enabled, only
entire meshes are placed. The
value proposed by the system
is displayed in the data entry
box and cannot be changed.

9 Repeat these steps with the top side of the polygon and click OK
to confirm the settings.

Mesh Type and select Q257A. This sets the values
10 Click
for the
Longitudinal Overlap and
Transverse Overlap to
0.34.
Define the other settings as shown above.
Tip: Allplan 2013
automatically calculates the
overlap depending on the
type of reinforcing steel mesh
you select. The placement
algorithms are designed with
economic considerations in
mind. However, you can
change this at any time by
specifying the lap joint
yourself. The lap joint can be
labeled if required (see
Options - Reinforcement Labels page).

11 Click OK to confirm the entries.
The placement should now look like this:
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12 Press ESC to quit the tool.
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The next step is to apply reinforcement to the adjacent span on the
right. You will mark out the span using a freeform outline.

To place by span in a polygonal area
1 Click
Span Reinforcement (Mesh Entry and Placement
flyout).
2 Enter 0.12 for the support depth in the dialog line.
Tip: The general arrangement
polygon of the area
reinforcement placed is
displayed in construction line
format. Clicking this polygon
selects the entire placement.

3 Working counter-clockwise, click the inside corners of the span
and press ESC to finish.
4 The support depth for the exterior wall is 0.15. Click
Support
Depth in the dialog box, click the exterior wall, enter 0.15 and
click OK to confirm.
5 Select mesh type Q513A and set the placing angle to 0.00
degrees.
6 Confirm.
The reinforcing steel mesh placement is drawn and labeled.
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7 Press ESC to quit the tool.
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Now you should be able to place the reinforcing steel meshes
yourself (support depth for interior walls is 0.12 and for exterior
walls 0.15):
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Finally, you can place various labels.
 If you inadvertently deleted labels, you can use
Label to label
meshes with the mark number and/or mesh type at a later stage.
In addition, you can label the mesh dimensions of individual
meshes. In general, dimensions of the same mark number only
have to be labeled once.
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 You can use
Dimension Overlap to manually dimension
splices in the longitudinal and transverse directions. When labels
are created automatically, all splices are also dimensioned.

Task 2: recess
Now you will apply reinforcement to the slab opening created for the
elevator shaft.
You will mainly use the tools in the
Bar Reinforcement module.
You can access these tools using the flyouts on the Engineering
toolbar.
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Start by placing open stirrups around the elevator shaft.

To place edge reinforcement
1 Click
Edge Reinforcement (Area Reinforcement flyout).
The system proposes the BR_GEN layer.
2 Click in the Select, Set Layers list box (Format toolbar) and then
Set....
3 Select the List layers assigned to currently selected menu option
and use the shortcut menu to make layer BR_B_B current.
4 Select the List existing layers in open documents option and set
the layer MR_M_B to Hidden, frozen so that you can see better.
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5 Enter the 1st edge point or click a line: click the bottom inside
corner of the shaft wall on the right.
6 2nd point: click the top inside corner.
7 To specify the direction point, click the slab to the right of the
shaft wall.
Support Depth in the dialog box, click a side of the
8 Click
polygon and enter the offset. Enter -0.03 for the side towards the
recess and 0.00 for all the other sides.
9 Enter 0.70 for the Edge Reinforcement Length and click OK to
confirm.

10 Set the
Diameter to 8 and the
Shape.
Tip: You can use the
Shape for each side of
polygon parameter to define
the bending shape at the
edges of the general
arrangement polygon,
regardless of the general
bending shape selected for
the reinforcing bars. This
allows you to define hooks at
the supports and create
straight lap joints at the same
time, for example.

Spacing to 0.15 and click

11 In the Bending Shape Defaults dialog box, select the bending
shapes for the start and end of the bar as shown above.
12 Enter values as shown for the a (0.14) and b (0.70) parameters of
the bending shape at the start of the bar and click OK to confirm.
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13 Set the display mode to
Show selected bars, switch the start
point so that the placement starts on the left and click OK to
confirm.
14 Select the bars to be displayed and place the dimension line and
the label.
• If necessary, set the type to Dimension line, select layer
BR_B_B for the dimension line and set the aspect to 1.00 by
selecting the Dimension line options line and clicking .
• Clear the Dimension line text check box for the dimension
line. For the label, select Number of pieces, Diameter and
Spacing and select the automatic text leaders.
15 The next edge point for the next placement is now attached to
the crosshairs. Click the corner at top left, set the parameters and
complete the edge reinforcement as shown in the following
illustration.
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Now you need to create the longitudinal reinforcement.

To place additional reinforcing bars as area
reinforcement
1 Click
Additional Reinforcement (Area Reinforcement flyout).
Check that the layer BR_B_B is selected. If it isn't, activate it on
the Format menu or toolbar.
2 Click From-to in the input options.
3 Enter start point: click the top inside corner of the shaft wall on
the right.
4 Enter end point: click the bottom inside corner.
5 Make the following settings:

Diameter 12
Offset to edge 0.04
Spacing 0.07
Bar length 4.00
Straight Bar
Number of bars 3
Placement display mode

Show All Bars.

6 Click OK to confirm.
7 Place the dimension line and the label. Set the text parameters so
that only the Number of pieces value and the Diameter are
displayed.
8 Now place the additional reinforcement above the three other
shaft walls yourself.
The bar length for the reinforcement at the top and bottom is 4.0
m and 5.0 m for the reinforcement on the left.
9 Press ESC to quit the tool.
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10 Although the same bar shape has been placed along each edge,
the individual placements have been assigned consecutive marks.
Click
Rearrange Marks (Engineering Modify flyout) and
confirm the settings.
11 Finally, click in the Select, Set Layers list box and select Set....
12 Click in the layer structure with the right mouse button and, on
the shortcut menu, choose Match visibility from plot set....
13 Select the Reinforcement, bottom layer plot set, enable the Set
all layers visible in the plot set to modifiable option and click
OK twice.
Now all you can see is the entire reinforcement (bottom layer)
and the floor plan without style areas.
14 Move the labels of the bar and mesh reinforcement so that they
do not collide.

The drawing should now look like this:
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Task 3: support reinforcement / spacers
Now you will create support reinforcement. Finally, you will enter
spacers.
You will mainly use the tools in the
Mesh Reinforcement
module. You can access these tools using the flyouts on the
Engineering toolbar.

Tools:

Objective:

Support Reinforcement
Place Individually
Modify Format
Properties

5A
R3 3
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R3

A
35
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35

Start by making initial settings.

To select drawing files and to set options
1 Click
Open on a Project-Specific Basis (Standard toolbar)
and make drawing file 402 current. Drawing files 102 and 401
are open in edit mode.
2 Check the current reference scale (1:50) and unit of length (m) in
the status bar.
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Now you will create support reinforcement.

To place support reinforcement
1 Click
Support Reinforcement (Mesh Entry and Placement
flyout).
Select, Set Layers on the Format menu, match the
2 Click
visibility of the layers from the Reinforcement, top layer plot set
to hide the reinforcement at the bottom, select the List layers
assigned to currently selected menu option and double-click the
layer MR_M_T.

3 1st support point, direction or angle: enter 90.0.
4 Click the diagonally opposite points in the wall.

5 Click

Support Reinforcement Length and set it to 1.50.

6 Click
Support Depth and make the following settings: 0.15
for the exterior wall and 0.12 for the interior wall.

4

4
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7 The area delimited by a dashed line represents the placing
geometry.
8 Click OK to confirm the dialog box.
9 Set the Mesh Type to R335A and click OK to confirm.
The reinforcing steel mesh placement is drawn.
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10 Press ESC to quit the tool.

Edge reinforcement
The edge reinforcement tool in the mesh reinforcement module is
equivalent to the tool with the same name in the bar reinforcement
module. The procedure was described with the edge reinforcement
around the slab recess. The procedure for selecting the mesh type
and setting the parameters is the same as for the tools you have
already used in the
Mesh Reinforcement module. Consequently,
this tool is not described any further here.
A special placing mode – surplus mesh placement – can be used for
edge reinforcement. To do this, create a reinforcing steel mesh
cutting diagram in a separate window. Then you can click a left-over
mesh and place it in its entirety or just parts of it (see further down).
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Spacer
Basically, spacers are only important when it comes to ordering steel
and they should therefore be included in reinforcement schedules.
The steel quantities need to be calculated based on the drawing file
with the meshes.
There are two ways to display spacers:
• You can define the placing region for the spacers using the
Span Reinforcement tool. Areas without reinforcement at the
top can be entered as recesses. Then select spacer for the Mesh
Type.
When you create the placement as construction lines, it is
displayed on screen but not printed. Advantage: the required
number is determined automatically. Disadvantage: the cutting
diagram and the reinforcing steel mesh schedule include cut
spacers. This does not reflect standard on-site and bending shop
practice (only entire spacers are ordered and supplied).
Place Individually tool and
• You can define a spacer using the
calculate the required number manually. This is a relatively fast
approach and fully appropriate for display purposes.

Finally, you will enter spacers using the place individually tool.

To enter spacers
1 Click
Place Individually (Mesh Entry and Placement flyout).
Check that the layer MR_M_T is selected. If it isn't, activate it on
the Format menu or toolbar.

2 Click
Mesh Type and select spacer BK16. Enter the
required number (e.g. 120). For the number of meshes, enter 2
and set the layer factor to 60. Set the placing angle to 0.00
degrees.

Engineering Tutorial
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3 Set placing parameters or specify position: click anywhere in
your drawing and press ESC to quit the tool.
Modify Format Properties (Edit toolbar), select the
4 Click
Convert 2D entities to construction lines option, click OK to
confirm and select the meshes you just created (assuming that
you want to exclude the spacers from subsequent printouts).
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Task 4: cutting diagram / excess mesh
To finish, you will create a cutting diagram for the bottom mesh
reinforcement layer and place excess mesh.
You can access the tools via the flyouts on the Engineering toolbar.

Tools:

Objective:

Mesh Reports
Place Individually

Start by creating the cutting diagram for the bottom reinforcement
layer.
Note: To create a cutting diagram, a drawing file with reinforcing
steel meshes must be current. If the reinforcing steel meshes to be
included in the cutting diagram are located in different drawing files,
open the other drawing files in edit mode. Meshes on visible but
frozen layers are not included in the cutting diagram.
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To place a cutting diagram in a drawing file
1 Make drawing file 401 current. Drawing files 102 and 402 are
open in edit mode.
2 On the Format toolbar, select pen thickness 0.25 mm and line
type 1.
Select, Set Layers on the Format menu and set layer
3 Click
MR_M_B to Modifiable and layer MR_M_T to Visible, frozen.

Tip: To place the mesh
cutting diagram in the
drawing file, you can also use
the Mesh cutting diagram
Mesh
provided by the
Legend tool. However, this
diagram cannot be sent to
the printer.

4 Click

Mesh Reports (Reports flyout).

5 In the Reports dialog box, click the Default folder on the left,
select the Mesh cutting diagram report and click All in the input
options to include all marks.
The report is displayed in the Report Viewer.
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Export and select Allplan.

The current drawing file is displayed and the report is attached to
the crosshairs.
7 Place the report in the drawing file.
This saves the mesh cutting diagram in the drawing file and
prints it along with the drawing file with reinforcing steel meshes
placed in the layout.

Engineering Tutorial

Unit 4: Reinforcement Drawing

229

After you have created a cutting diagram in which the entire meshes
are filtered out, you can see which excess pieces are left. You can
click and then place these.

To place excess mesh
1 Click

Place Individually (Mesh Entry and Placement flyout).

2 Select a layer. Make sure that you do not mix the bottom and top
reinforcement layers.
Excess Mesh Placement on the Place Individually
3 Click
Context toolbar.
In addition to the current viewport, the Excess Mesh Placement
window appears, which shows all the meshes with pieces of
excess mesh as a cutting diagram.
4 In the cutting diagram, click the piece of excess reinforcing steel
mesh that you want to place.
The Excess Mesh Placement window is closed again.
5 Place the piece of excess mesh. You can retain the dimensions of
the reinforcing steel mesh copied automatically or change them.
6 To place more pieces of excess mesh, click
Placement again.

Printing out layouts is covered in unit 9.

Excess Mesh
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Exercise 7: BAMTEC® reinforcement
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette and check whether the
family includes the following module(s):

Engineering

BAMTEC

Tip: Refer to the chapter
”Reinforcement methods - 3D
reinforcement model” in the
online Help:

In this exercise you will manually create BAMTEC carpet
reinforcement based on FEA calculation results (i.e. the FEA results
are not used automatically). You will not work with the 3D model
(method 3, see Tip) as you will only create a floor plan without
sections.
You will mainly use the tools in the
BAMTEC module. You can
access these tools using the flyouts on the Engineering toolbar.
Start by selecting fileset 5 with the following drawing files:
Fileset
5

Drawing
Drawing file name
file number
501

Structure

502

Carpet outline

503
504
You can find the fileset in the 'Engineering Tutorial' project (see
”Appendix: creating the training project”).
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Tools:
Tip: Look in the online Help
for basic information on the
BAMTEC module:
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Objective:

Carpet Outline
Separate into Files
Carpet Mounting Strips
Basic Carpet
Reinforcement
Additional Carpet
Reinforcement

Teppichdatei:
BAM0503.TEC

BAMTEC File
Get from Library
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a
g
s
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The following exercise is based on the slab outline shown below. The
process of creating this slab outline is described in detail in the
”Finite Elements” manual. The FEA results used here are also taken
from this manual.
In this exercise, you will reinforce the area with hatching (see
below). If you have installed the training project provided with the
Allplan DVD or downloaded it from the Internet, you will find the
slab outline in drawing file 501. All you need to do is make the
existing layers visible. Otherwise, create it yourself.

To copy or draw the slab outline
1 If you have already carried out FEA calculations for this example,
copy the floor plan (consisting of grid, walls and recesses) to
drawing file 501.
Place the grid, walls, beams, columns and recesses on different
layers.
2 If these drawing files are not available to you, you can create the
slab outline yourself using the
Basic: Walls, Openings,
Components or
Draft module. Use the dimensions given.
Place the grid, walls, beams, columns and recesses on different
layers - just use the layers proposed by the system.
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Start by making initial settings.

To select drawing files and to set options
Tip: You can specify how
BAMTEC reinforcement is
displayed using the
Options tool.
For more information please
consult the online Help.

1 Check whether the Engineering toolbar is displayed at top left. If
it isn't, show it as described in the initial settings (on page 123).
Open on a Project-Specific Basis (Standard toolbar),
2 Click
make drawing file 502 current and open drawing file 501 in edit
mode.
3 Check the current scale (1:100) and unit of length (m) in the
status bar.
4 On the Format toolbar, select pen thickness 0.25 mm and line
type 1.
Options and check that the Reinforce with 3D
5 Open the
model option is not active.

The first step involves defining the carpet outline, i.e. the size of the
carpets, the unroll direction, the label and the position of the carpets
in the slab.
Note: Certain technical criteria pertaining to the application
guidelines for the BAMTEC reinforcement technology have to be
observed (see Tip on page 229)!

To define the carpet outline
1 Click
Carpet Outline (BAMTEC flyout).
The system proposes the layer BA_B.
2 Click in the Select, Set Layers list box (Format toolbar) and then
Set....
3 Select the List layers assigned to currently selected menu option
and double-click the layer BA_B_B_1.
4 From point or element or enter offset: enter 0.00 for the support
depth in the dialog line. Press ENTER to confirm.
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5 To create the first carpet, use the inside wall corner in the B/1
axis for the start point.
X coordinate in the dialog line and 6 Enter 14.10 for the
14.25 for the
Y coordinate. Press ENTER to confirm.
7 Press ESC to close the polyline and click OK to confirm.

8 On the Carpet Outline Context toolbar, enter an angle of 180°.
This defines the position of the first bar and thus the unroll
direction.
9 Enter 0.10 m for the offset between the first bar and the edge.
10 Define the carpet label as shown. "B 1.1“ stands for: bottom
layer, carpet 1, 1st carpet.

11 Click OK to confirm the values.
The carpet outline is created with the unroll direction, first bar
and label.
12 Now you can enter the next carpet. Repeat steps 4 through 11
and create the other carpets. Name them B1.2, B1.3, B1.4., B1.5
and B1.6. Please note the following:
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Enter the outlines of the carpets B1.2 and B1.3 for the longitudinal
direction yourself. Please note the following:
• In the D and F axes, the carpets are joined without overlap.
• When you define the carpet outline for carpet B1.3, do not
include the rectangular area at bottom left between grid point
G/1 and the top right corner of the recess as this would cause the
program to generate illegal reinforcing bars. The offset around
the recess needs to be set to 0.05 m.

• The values on the Context toolbar above are valid for the carpets
B1.4, B1.5 and B1.6. The angle for the unroll direction (90°
instead of 180 degrees) and the offset to the first bar (0.05 m
instead of 0.10 m) are different. Use the layer BA_B_B_2.
• The carpets B1.4 and B1.5 are 12.00 m long in the transverse
direction. With an overlap length of 0.50 m, the length of carpet
B1.6 is 12.70 m. Carpet B1.6 has a recess in the bottom left area
(similar to carpet B1.3).
• To define the lap joint, specify the start point by moving the
crosshairs to the bottom left corner of the carpet previously
Y coordinate data
created. Then enter a value of 0.50 in the
entry box, which is highlighted in yellow. In this case, the offset
values are 0.00.
Alternatively, you can enter an offset of -0.50 for the top side of
the outline of carpets B1.5 and B1.6.
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Compare what you have drawn with the finished carpet placing
drawing below.
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Before you can create the reinforcement for the carpets, you need to
distribute the individual carpets in the placing drawing onto
different drawing files. You will use carpet B1.1 as an example.
Tip: You can also separate all
the carpets in one go by
selecting the following
option:
Copy ALL carpet outline
polygons to different
drawing files

To distribute carpets onto different drawing files
1 Click

Separate into Files (BAMTEC flyout).

2 Select the Copy ONE carpet outline polygon to a different
drawing file option in the File Settings and Reinforcement
Mode dialog box.
3 Check the box in the File Splitting area and click OK to confirm.
4 Click the first bar of carpet B1.1.
5 Specify the first drawing file - 503 - in the Select destination
drawing file dialog box.
The program automatically creates drawing files 503 (data for
.)
assembly drawing) and 504 (layout). (See for yourself: click

Tip: As opposed to manual
reinforcement, the
Reinforce tool is used to
reinforce carpets
automatically.
This tool is designed with
economic considerations in
mind, allowing you to create
a structurally adequate
reinforcement system in a
fully automatic manner.

Using carpet B1.1 as an example, you will now learn about the
functions used for reinforcing carpets manually. You will use the
following tools:
Carpet Mounting Strips
Basic Carpet Reinforcement
Additional Carpet
Reinforcement
Note: For production reasons, the following values defining the
spacing between mounting strips must be adhered to:
the first mounting strip begins after 52.5 cm. After this, the
mounting strips are spaced at 1.55 m intervals.
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To place mounting strips
1 Click
Open on a Project-Specific Basis (Default toolbar) and
double-click drawing file 503.
Carpet Mounting Strips (BAMTEC flyout).
2 Click
Carpet mounting strips are always created on layer BA_B_MST,
regardless of the selected layer.
3 As you separated the carpet polygon beforehand, a general
arrangement polygon already exists. Click Match in the input
options.
4 Select the polygon you want to match: click the polygon and click
OK to confirm.
5 Make the following settings on the Carpet Mounting Strips
Context toolbar:
Spacing 1.55
Angle 90° (entering an angle of 90° places the start point at
bottom right. Production also starts
at this point.)
Offset to starting edge 0.515,
Line type for bar display 4

6 Click OK to confirm the entries.
7 The mounting strips are displayed in the selection color. The
dimension line is attached to the crosshairs. You do not need to
dimension the mounting strips manually as they will be arranged
automatically by the production machine. Skip labeling by
pressing ESC.
8 Press ESC to quit the

Carpet Mounting Strips tool.
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The basic carpet reinforcement has a diameter of 12 mm and is
spaced at 20 cm intervals. It has the mark number 3. See the
illustration of the reinforced carpet at the beginning of this exercise
(objective).

To define basic carpet reinforcement
1 Click

Basic Carpet Reinforcement (BAMTEC flyout).

2 Select carpet to which you want to apply basic reinforcement:
click the carpet polygon.
3 Enter the following parameters on the Basic Carpet
Reinforcement Context toolbar:
Diameter 12
Spacing 0.20
Offset to starting edge 0.100
Line type for bar display 1

4 Click OK to confirm the entries.
5 The basic reinforcement is displayed in the selection color. The
palette for the dimension line appears.
• If necessary, set the type to Dimension line, select layer
BA_B_B_1 for the dimension line and set the aspect to 1.00
by selecting the Dimension line options line and clicking .
• Select the Bar markers option and place the dimension line in
the workspace.
6 Switch to the Text/leader tab, set the label parameters so that the
Number of pieces, Diameter and Spacing are included, select the
automatic text leaders and place the label in the workspace.
7 Press ESC to quit the

Basic Carpet Reinforcement tool.
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You will place five different types of additional reinforcement in
carpet B1.1. Marks 4, 5, 6, 7, and 8 are used for the additional
reinforcement. See the illustration of the reinforced carpet at the
beginning of this exercise (objective).

To place additional carpet reinforcement
Tip: The entries you make are
immediately displayed in the
preview. This way, you can
check the effects of your
settings at any time.

1 Click
Additional Carpet Reinforcement (BAMTEC flyout) and
select layer BA_B_B_1.
2 Set the following parameters on the Additional Carpet
Reinforcement Context toolbar:
Diameter 8
Anchor point (start point of placement): top left
dx offset = 0.35
dy offset = 4.002
Placing length 5.25
Spacing 0.20
Angle = 180°
Number of pieces: 10

3 Place the additional reinforcement at the top left corner of the
carpet polygon.
4 The additional reinforcement is displayed in the selection color.
Place the dimension line and the label using the settings
proposed by the system.

You will now create more additional reinforcement. Repeat steps 2 to
4 and use the settings given in the following section.

To create more additional reinforcement
1 The

Additional Carpet Reinforcement tool is still active.
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2 Make the following settings on the Context toolbar:
Diameter 8
Anchor point (start point of placement): top left
dx offset = 0.15
dy offset = 6.002
Placing length 6.45
Spacing 0.20
Number of pieces: 10

3 Place the additional reinforcement at the top left corner of the
carpet polygon.
4 Place the dimension line and the label.
5 The

Additional Carpet Reinforcement tool is still active.

6 Make the following settings on the Context toolbar:
Diameter 8
Anchor point (start point of placement): top left
dx offset = 0.055
dy offset = 8.002
Placing length 5.65
Spacing 0.20
Number of pieces: 24

7 Place the additional reinforcement, the dimension line and the
label.
8 The

Additional Carpet Reinforcement tool is still active.
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9 Make the following settings on the Context toolbar:
Diameter 8
Anchor point (start point of placement): top left
dx offset = 0.055
dy offset = 12.802
Placing length 6.25
Spacing 0.20
Number of pieces: 8

10 Place the additional reinforcement, the dimension line and the
label.
11 The

Additional Carpet Reinforcement tool is still active.

12 Make the following settings on the Context toolbar: Do not forget
to change the anchor point:
Diameter 8
Anchor point (start point of placement): top right,
dx offset = 0.25
dy offset = 13.202
Placing length 5.35
Spacing 0.20
Number of pieces: 6

13 Place the additional reinforcement at the top right corner of the
carpet polygon.
14 Place the dimension line and the label.
15 Press ESC to quit the Additional Carpet Reinforcement tool.
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You can use the Reinforcement Reports and Reinforcing Bar
Legend tools to generate various reinforcement schedules.
Now you will create a BAMTEC file for carpet B1.1.

To create a BAMTEC file
1 Click

BAMTEC File (Lists/Schedules flyout).

2 Select placements from which you want to derive the BAMTEC
Brackets (Filter Assistant toolbar) or the left
file: use the
mouse button to select all the placements.
Tip: If drawing file 504 is
open in edit mode, you can
use the definition point you
specified when the carpets
were separated.

3 Set the definition point: specify the carpet's local reference point.
The system proposes two points. Click the point at bottom right.
The point clicked is marked by a symbol.
4 Place the name of the carpet file where you require.

As opposed to automatic reinforcement, you need to create the
symbols required for carpet production. To finish, you will create
these symbols using the symbols provided.

To place symbols
1 Click

Get from Library (Standard toolbar).

2 Click Symbol catalog in the Library area and BAMTEC Layout
Symbols in the Path area and click OK to confirm.
3 In the Get Symbol dialog box, select the BAMTEC Symbols file
and click ROLL-UP 1:50 (number 7). Click OK to confirm the
dialog box.
4 Place the symbol with the text to the right of the carpet.
Delete (Edit toolbar) and delete all the redundant
5 Click
elements.
6

Move (Edit flyout) the text into the correct position.
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Reinforce carpet B1.4 yourself. The approach is the same as with
carpet B1.1. The start point of carpet B1.4 is the bottom left corner of
the carpet polygon. The additional reinforcement is spaced at the
following intervals (reference point at top or bottom right):
Additional reinforcement 1 (mark 3): dX = 4.151, dY = 1.00,
= 5.85

L

Additional reinforcement 2 (mark 4): dX = 7.151, dY = 0.20,
= 6.50

L

Additional reinforcement 3 (mark 5): dX = 11.551, dY = 0.00,
4.45

L=

Additional reinforcement 4 (mark 6): dX = 4.151, dY = 0.00,
= 2.85

L

Additional reinforcement 5 (mark 7): dX = 5.151, dY = 0.00,
= 4.85

L
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Carpet B1.4 should look like this after the rearrangement:

Teppichdatei:

a
quer

BAM05 06.TEC

a
längs

Printing out layouts is covered in unit 9.

Cross-section catalogs
This chapter shows two examples of cross-sections catalogs. You will
learn how to modify mesh cross-section catalogs and add a new
custom mesh.
Note: Using the self-explanatory forms of the cross-section catalogs,
you can define new catalogs (e.g., custom mesh) or change existing
ones. Cross-section catalogs can be viewed on screen and listed in
reports. You can create reports for individual cross-section catalogs
straight from the overview of all cross-section catalogs.
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These reports can be customized, printed, placed in the current
document or saved as a file in Excel, Word or PDF format. Numerical
input for custom meshes is supported, as is output of a mesh with a
single bar representation.
Now you will change the length of a standard stock mesh from 6.00
m to 12.00 m.

To modify a mesh cross-section catalog
1 On the Tools menu, click Defaults and then Cross-Section
Catalogs. The following dialog box appears:
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2 Click Stock meshes (A) BSt 500 M(A) and then Edit. A full
overview of the mesh cross-section catalog is displayed:
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3 Click a mesh and then Edit.
The following dialog box appears:

4 Enter 12.00 m for the length of the mesh.
5 The weight of the mesh is automatically calculated based on the
modified length. This way, you can modify and save settings
without any problems.
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Next, you will enter a new custom mesh.

To enter a new custom mesh
1 The Stock meshes (A) BSt 500 M(A) dialog box is still active
from the last task. Click Cancel. The overview of the CrossSection Catalogs is displayed again.
2 In the Cross-Section Catalogs dialog box, click New. The
following dialog box appears:
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3 Click Mesh X-Section Catalog.
Another dialog box appears:

4 Click in the Label data entry box and enter Custom Meshes.
5 Click in the Steel grade data entry box and enter 500 M.
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6 Click New.
A dialog box shows which meshes can be defined and how:

Stock meshes without a single bar representation;
only the length, width and overlap are variable.
Stock meshes with a single bar representation;
the parameters are entered in a dialog box.
Stock meshes that can be defined in the
workspace.

Custom meshes without edge bars; can be
defined in a dialog box.
Custom meshes with edge bars; can be defined in
a dialog box.
Custom meshes that can be defined in the
workspace.

Custom meshes with any bar combination;
special functions are provided for defining these
meshes in the workspace.
Spacers that can be defined without single bars;
spacers are entered in the same way as stock
meshes without a bar representation.
Spacers with a single bar representation; can be
defined in the workspace.
7 Click Custom mesh, without edge bars.
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8 A dialog box opens. Enter a name for the new mesh: Custom
Mesh 1.

9 Now you can set the parameters as you need. Start by entering
values for the length, width and the spacing between the bars.
The overlap values depend on these parameters.
10 Save the settings and finish.
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Unit 5: Layout Output
This unit, which consists of two exercises, shows you
how to assemble and print layouts.
 You will use the tools in the
Smart Symbols
module to create a title block as a label style.
 In addition, you will print a layout containing the
elevator shaft you reinforced in exercise 4 (unit 4)
using the tools in the
Plot Layout module.

Requirements for plotting
Before you print or plot, the output device needs to be configured
correctly. If you are working on a network, you can use any device
connected to a remote machine (assuming it is configured correctly).
To do this, connect the output device and install it in the Windows
Print Manager. On a network, install the device on the computer to
which it is connected and then share it.
For more detailed information, please consult your printer’s or
plotter’s user guide or the documentation of the operating system.

Making a quick printout
The Basics Tutorial explains how to print the contents of the display
on a printer or plotter. Below is a short description of this approach.

To print the screen contents
1 Select the drawing files and layers you want to include in the
printout.
2 Click

Print Preview (Default toolbar).
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3 Click
Print Preview Settings, select the Representation tab
and select the Thick line check box. This not only makes the
different line weights visible on screen but also ensures that they
are also printed as such.
In addition, you can use the Print construction lines option to
specify whether construction lines are to be included in printouts.
Specify the other options to suit your own preferences.
4 If necessary, set the scale in the print preview.
5 Click

Set Up Printer and select a printer.

6 Click

Quick Print.

7 Press ESC to close the print preview.
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Exercise 8: custom title block
Requirements:
Allplan 2013 Engineering comes in different module packages.
Open the Tools palette to check whether the
includes the following module(s):

Bonus Tools family

Smart Symbols
Allplan 2013 provides a wide range of "intelligent" title blocks based
on label styles. Label styles contain design entities, text and
attributes.
The advantage of a title block with attributes is that the text will
update whenever the layout is opened.
You can create your own label styles or modify existing title blocks
Smart Symbols module. Attributes can
using the tools in the
only be used when you assigned them during project creation or
later.
This exercise requires an empty drawing file.
Tools:
Get from Library
Label Style

To assign attributes
1 On the Default toolbar, click

New Project, Open Project.

2 Select the Engineering Tutorial project, open the shortcut menu
and click Properties…
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3 In the Project Settings dialog box, click Assign attributes....

4 In the Project Attributes dialog box, click
values and open the Architect group.

Hide unassigned

5 In the Attribute value column of the Architect row, click in the
box and type in the following:
Sam Sample
6 Use the same approach to enter the Sample Street, Anytown
value for the Architect address attribute.
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7 Specify the attributes for the Client, Construction project,
Building information and Structural analysis groups as shown
in the illustration. After this, click
Hide unassigned values to
see all the attributes you have defined.

8 Click OK to confirm the Project Attributes, Project Settings and
New Project, Open Project dialog boxes.
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Tip: The training project,
which can be downloaded,
includes the title block as a
drawing file and as a symbol
(see "Appendix: training
project on Internet”).
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The attributes you just assigned will now be used in the label style
for the title block.
You do not need to draw the title block from scratch. You can use
the one that you defined and saved in the Basics Tutorial.

To create the title block as a label style
 The title block named Original you created in the Basics Tutorial
is available.
 Open an empty drawing file and close all the others.
Bonus Tools family in the Tools palette and open
 Select the
the
Smart Symbols module.
 Set the scale to 1:1.

Tip: To position the label
styles quickly and accurately
at a later date, you can place
Point Symbols as
Construction Lines to mark
the beginning of the original
text to be deleted
(Create menu, Draft module).

1 Click

Get from Library (Default toolbar).

2 Select the Text library and the Office path (or Project if you are
using the training project).
3 Select Title block and then Original.
4 Place the title block and press ESC to quit symbol retrieval mode.
5 Delete the text that is to be replaced by attributes (project-specific
information).

6 Click

Label Style (Tools palette, Create area).
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7 On the context toolbar, click Attribute.

8 Select the Project category, choose the Construction project
name attribute and click OK to confirm.

9 Set the text parameters as shown below and change the format:
A30.
This defines the attribute as a text item with 30 characters
maximum.

10 Switch off Adjust height/width to scale and place the attribute
so that it is left-aligned in the box for the construction project
details.
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11 Repeat steps 7 through 9 and place the following attributes.
Set the text height and width for the Client address, Architect
address and Structural engineer address attributes to 4.000 mm.
Use a value of 5.000 mm for all other text items.
Category

Attribute

Format

Text height

Project

Construction project name

A30

5.000 mm

Location/plot

A30

5.000 mm

Client

A22

5.000 mm

Client address

A30

4.000 mm

Architect

A22

5.000 mm

Architect address

A30

4.000 mm

Structural analysis

A22

5.000 mm

Structural engineer, address

A30

4.000 mm

Layout name

A40

5.000 mm

Layout

Tip: When placing text, you
can align it using track lines
or you can do this later using
Align Text tool
the
(Modify menu, Text module).
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12 Click DefFol (Define Foil) on the Context toolbar.
13 Using the left mouse button, enclose the entire title block in a
selection rectangle.
14 Click the point at bottom right. This will serve as the reference
point.
Note: Title blocks must be saved in subfolders 7 and 8 as these
Label tool in the
Plot
subfolders are associated with the
Layout module.
15 Click subfolder number 8 and enter Title blocks.

16 Click line 1 and enter Reinforcement drawing.
17 Click OK to confirm the Save Data dialog box.
18 Press ESC to quit the tool.
The title block is now saved as a label style.

Note: You can also find the
modules:

Label Style tool in the following

Object Manager,
Rooms, Surfaces, Stories,
Landscaping,
Urban Planning
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Exercise 9: plot layout
Printing out finished layouts is a critical step. In Allplan 2013 a
layout is the element that you bring to paper.
As opposed to design using a conventional drafting board, the scope
of the layout does not have to be defined in advance.
Generally, you leave the layout (which involves arranging and
laying out drawing files and/or filesets) until you’re finished with the
design. This is also the stage where you define the paper size, scale,
border, angle, etc..
Each project can contain up to 9,999 layouts.

Tools:
Set Up Page
Layout Border
Layout Element
Label
Update Layout
Plot Layouts
Layout Window

Task 1: assembling layouts
Now you will set up a layout with the general arrangement and
reinforcement of the elevator shaft. This involves two steps:
• Defining the paper size and layout border.
• Selecting the elements of which the layout is to consist (i.e. the
filesets, drawing files and the title block).
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To define a layout
1 Select the
Layout Editor (Standard toolbar).
The icon remains active until you quit the layout editor and
switch back to document edit mode.
The first time you click this button, the dialog box for selecting
layouts opens automatically. Otherwise, click
Open on a
Project-Specific Basis and select a layout.
2 Select layout 1, press the F2 key and enter Elevator shaft reinforcement drawing for the name.
Close the dialog box.
Tip: The name you enter here
will appear as the Plan name
attribute in the title block!

3 Click

Set Up Page (Tools palette, Create area).

4 In the Page area, set the Format to DIN A2 and select Landscape.
In the Margins area, select the without margin (roll, PDF)
option.
Using the setting you make for the margins, Allplan always
places the page so that its bottom left corner coincides with the
bottom left corner of the printable area of the printer you have
specified in the
Plot Layouts tool. This way, you can make
sure that all elements are plotted as far as the margins of the
page.

264

Exercise 9: plot layout

5 Click
Tip: Custom size lets you
define your own borders.
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Layout Border (Tools palette, Create area).

6 Select DIN A2.
7 Specify the Anchor point and select Filing margin (DIN 824 A)
for the border type.

8 Click OK to confirm.
9 Place the border in the bottom left corner of the page.
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Layout elements are mainly drawing files that you place in the
layout. Drawing files can be positioned individually or as a fileset.
You can specify which layers are to be included in the printout by
selecting a plot set.

To select layout elements
1 Click

Layout Element (Tools palette, Create area).

2 On the Layout Element Context toolbar, click
Fileset and
select fileset 2, Elevator shaft.
The same drawing files as in document edit mode are selected:
drawing files 202 and 203 are off.
3 It is enough if you place the associative views and the
reinforcement model in the layout. Select drawing files 204 and
205 and click OK to confirm the dialog box.
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4 Click the Layer/plot set box. You can use layers to define
visibility settings for the layout elements:
• The Plot set, current setting of the selected plot set option
only displays elements on layers of the plot set currently
selected.
• When set to Current, always use current layer setting, the
visibility settings you defined using
Select, Set Layers on
the Format menu apply.
• When set to Fixed, save layer setting in layout element, you
can define the visibility setting for each layer individually.

5 Select the Reinforcement drawing drawing type and place the
selected drawing file in the layout.
Now the next drawing file is automatically attached to the
crosshairs.
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6 Press ESC to finish selecting layout elements.
7 Click
Tip: To change the annotation
for the layout, switch to the
Text module and use the
standard text editing tools.

Label (Tools palette, Create area).

8 Click the layout border.
9 Click in the Label style box.

10 In the Office folder, select the label style called Reinforcement
drawing and click OK to confirm.
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11 Place the title block in the bottom right corner.
Instead of attributes, the values assigned are now displayed.

Allplan saves the finished layouts. You can print them immediately
or later. When documents have been changed, you need to update
the layout using

Update Layout (Tools palette, Change area).
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Task 2: layout output
The finished layout can now be printed. Before you follow the steps
in the exercise below, check that the plotter has been correctly
installed and configured.

To plot layouts
1 Click
Tip: You can make specific
settings for printing in the
Settings tab. For more
information, activate the
online Help system - all you
need to do is press F1.

Plot Layouts (Tools palette, Create area).

2 Select the output device (printer / plotter) and its paper size (ISO
B2, for example) on the Output tab. The size of the printable area
(printable area minus device margins) must be larger than the
size of the page. This ensures that the complete layout is printed.
. If you have
Here, you can also set up the page by clicking
configured output channels in the Services application, you can
select them using the Allplan vector drivers option. In this case,
define the size of the page using the Paper format selection list.
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3 Depending on the selected output device, you can use Allplan
raster drivers. These printer drivers are especially suitable for
printing large-format layouts. Raster drivers speed up the
printing process, improve the quality of printouts and are very
reliable.
If you want to use raster drivers, activate the Use Allplan raster
driver for output option and open the list box below to select a
raster driver that can be used in conjunction with the selected
printer.
Note: To define the properties of the Allplan raster driver, click
the Properties button to the right of the selected printer/plotter.
Note: The first time you select an output device that can be used
in conjunction with Allplan raster drivers, the following prompt
will appear:

If you want to use Allplan raster drivers, click Yes. The Use
Allplan raster driver for output option is active.
4 Select layout 1 on the Selection tab.
You can exclude specific elements (style areas, for example) from
the plot operation in the Plot elements / options area.
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5 Click Plot to start the plot operation.
To save the settings and print the layout later, click Close.

Task 3: layout windows
You can use layout windows to position just portions of drawings in
your layout. This is useful if you want to display just specific areas
or elements that are far from each other in the fileset. In the
following exercise you will create layout windows and display
sections of individual drawing files.
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To create layout windows
1 Open an empty layout using
Open on a Project-Specific
Basis and specify the format, orientation and margins of the page
using
Set Up Page.
2 Click

Layout Window (Tools palette, Create area).

You will create the window so that you can immediately select
the drawing file you want to display.
3 Click .. place drawing files as layout elements.

4 Select
drawing file 102 and place it in the layout. The
drawing type is set to Reinforcement drawing.
drawing file 401 and click within the boundary of the
5 Select
drawing file already placed.
6 Press ESC as you do not want to select more drawing files for this
layout window.
Tip: Using the polyline entry
tools, you can also define
freeform layout windows or
create layout windows
composed of several
individual polygons.

7 Define the size of the layout window by entering two diagonally
opposite points (bottom left and top right points) with the left
mouse button (see below). Then press ESC twice.
Outline auto-detect is not selected in the
Note: Check that
input options. Otherwise, the border or boundary of the layout
element placed defines the size of the layout window.
8 Repeat steps 2 through 7 to create a layout window for drawing
file 204 or 303.
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9 Click
Modify Layout Window (Tools palette, Change area)
and select Enter new polygon for layout window to change the
size of the window.

10 To change the arrangement of the layout windows, you can use
Move (Edit toolbar).
The result might look like this:
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Appendix
If you want to create the project yourself, the following
sections provide explanations and step-by-step
instructions on the following topics:
 Project organization - managing data using
ProjectPilot
 Using layers
 Creating a project
 Creating filesets
 Defining plot sets
The appendix also contains information on palette
configuration and general explanations on drawing files.
Note: If you wish to skip the general sections, continue
as described in Creating the training project (on page
290).
Note: You can also download the project from the
Internet. See the section entitled Training project on the
Internet (see "Training project on Internet" on page
309).
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Project organization
Project structure, i.e. the way in which you organize your data, is an
essential part of any building design project. An efficient and logical
structure will allow you to locate the data you need without having
to perform tedious searches.
It is worth spending time carefully planning a project’s structure
before even drawing the first line. Consider the time and effort spent
doing this as a good investment - after all, in the long term, it will
save you time and money.
Allplan’s flexible approach allows users to create their own officespecific structures which, in turn, can be altered to suit the needs of
special projects.

Managing Data with ProjectPilot
What is ProjectPilot?
You use ProjectPilot to create and structure projects in a simple and
clear manner.
ProjectPilot is a powerful data management tool developed specially
for the data structure of Allplan. ProjectPilot provides tools for
copying, moving, renaming and deleting data (e.g., projects, drawing
files, symbols, etc.).
If you are already familiar with Windows Explorer, then you’ll find
that working with ProjectPilot is just as easy. Most steps can be
accomplished via the shortcut menu and you can move or copy files
by dragging and dropping them.
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User interface

Left window (A)
Projects and folders are displayed in a tree structure in the area on
the left. Click the plus sign (+) to display the levels in a folder. Click
on the name of a folder to display its contents in the right pane.
You can display the contents of the folder and open it at the same
time by double-clicking.

Right window (B)
The folders and documents contained in the selected node (on the
left) are displayed in the area on the right. You can sort the
displayed documents by clicking on the title of a column. Clicking in
the background with the right mouse button lets you display the
documents as a list or as icons.
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Preview (C)
A preview of the currently selected document (drawing file, layout) is
displayed in the preview area. To move the preview, click it with the
middle mouse button and drag. To zoom in on an area in the
preview, open a selection rectangle using the left mouse button.
Double-clicking with the middle mouse button restores the preview
to its original size. Alternatively, press the * key on the number pad.
To display in an isometric view: use the number keys on the number
pad. Check that the Num Lock key is active as you do so.

Common approaches in ProjectPilot
If you are already familiar with Windows Explorer, you will quickly
find your way around the ProjectPilot. Most steps can be
accomplished via the shortcut menu or by dragging and dropping.

Sorting the displayed documents
You can sort the displayed documents by clicking on the title of a
column. The first time you click the column title, the documents are
sorted in ascending order. Clicking the same column title again sorts
the documents in descending order. An arrow is displayed to indicate
which column is being sorted and whether sorting is in ascending or
descending order.

Sorted in ascending order (arrow points
upwards) and according to drawing name

Sorted in descending order (arrow points
downwards) and according to drawing name
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Copying and moving with drag and drop
Instead of using the shortcut menu, you can also drag & drop
selected documents in order to move or copy them. Select the
documents, click within the selection with the left mouse button,
keep the mouse button pressed down and then drag. You can tell
whether this is possible by the shape of the cursor when the mouse
pointer is positioned over the destination area.
Cursor

Meaning
The document will be copied to the folder that is below the
mouse pointer.
The document will be moved to the folder that is below
the mouse pointer.
Note: To move documents, hold down the SHIFT key while
dragging the documents.
A shortcut to the document will be created in the folder
below the mouse pointer (e.g., when assigning drawing
files to a fileset).
The document cannot be placed here.

Working with the shortcut menu
Almost all tools available in ProjectPilot can be accessed via the
shortcut menu. Depending on which element you click, a shortcut
menu appropriate to the element opens.

Shortcut menu of a project

Shortcut menu of the fileset folder
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Using the preview
A preview of the selected document is displayed in the preview area.
In this view, you can zoom, pan and select isometric views. Click
Preview on the View menu to specify whether and where the
preview is placed.
• To disable the preview: point to Preview on the View menu and
click None.
• To zoom: use the left mouse button to open a selection rectangle
around the area you want to view in detail. The cursor changes to
crosshairs.
• To pan in the preview: move the view with the middle mouse
button. The cursor changes to a hand. Alternatively, use the
cursor keys.
• To restore the full view of the image in the preview: doubleclick in the preview are with the middle mouse button, or press
the * key on the number pad.
• To display in an isometric view: use the number keys on the
number pad. Check that the Num Lock key and the preview are
active as you do so.
Note: The preview is only available with certain documents (drawing
files, layouts).
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Understanding drawing files
In Allplan, the actual design and data creation process happens in
drawing files. These are the equivalent of the transparencies used in
conventional building design. Drawing files can be used to give
projects a structure. In IT terms, a drawing file is a conventional file
stored on your hard disk. You can display and edit up to 80 drawing
files at once - in other words, you can have several files open
simultaneously. A project can contain up to 9999 drawing files.
When working without layers, the individual building elements (such
as walls, stairs, labeling, etc.) are drawn on different drawing files
and superimposed like transparencies.

In order to edit the drawing files, they have to be activated (opened).
You can do this using the Open on a project-specific basis: drawing
files from fileset/building structure dialog box.
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Drawing file status
With the drawing file status, you define the drawing file on which
you draw and which drawing files are visible and/or can be
modified.
Tip: You can also use the
shortcut menu to change the
drawing file status. Click an
element in the workspace
with the right mouse button
Change
and select
drawing file status on the
shortcut menu.

The following illustration shows the different drawing file statuses.
An explanation is provided in the table below.

Number

Drawing file status

Remark

1

Active

The active drawing file is the one on which you draw. There must
always be one active drawing file.

2

Open in edit mode

Elements in drawing files open in edit mode are visible and can
be modified. Up to 80 drawing files can be open simultaneously
(regardless of whether they are current, in edit and/or reference
mode).

3

Open in reference mode

Elements in drawing files open in reference mode are visible, but
cannot be modified. You can configure the program to use the
same color for all elements in reference drawing files. To do this,
Options, click Desktop environment and open the
select the
Display page. Empty drawing files cannot be opened in reference
mode.

4

Inactive

Elements on inactive drawing files are not visible.

5

Empty

Empty drawing files have no data type icon.

6

Assigned temporarily

The drawing file is assigned temporarily to the fileset; this
assignment is removed when you switch to a different fileset.
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Information on the active drawing file
To get information on the active document, click in the workspace
with the right mouse button and on the shortcut menu, choose
Properties. An information box with all the important information
about the file opens.

Information

Meaning

Memory allocation

This shows how much of the memory reserved for a
file has already been allocated (as a percentage).
Background information: a certain amount of
memory is reserved for files.

Document

The number of the current file is displayed here. The
number is also displayed in the title bar of the
Allplan application window.

Document type

The file type is displayed here. This corresponds to
the data type icon that is displayed in the status bar.

Max. size

The maximum amount of memory available for the
file is displayed in Kbytes.

Min./Max. values

The minimum and maximum coordinates in the file
are displayed here.
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Using layers
Understanding layers
Layers provide an additional means of structuring design entities
within drawing files. You can display exactly the information you
need just by switching the relevant layers on and off. This way, you
can see better what you are doing and proceed quickly.
You can use layers to define the format properties of elements.
Layers are important organizational elements. Their importance
increases the more people are involved in a project and the more a
CAD system is used for the specialist design processes. Layers do not
replace drawing files. Rather, they complement them.

Defining the current layer
When created, each element is given the current layer. The layer
which is used as the current layer is governed by the following
settings:
• When you activate a tool (e.g. line) for the first time, a specific
layer is automatically selected as the current layer (if the Autoselect layer with menu option is active in the Layer dialog box).
The layer in question depends on which tool you activate. If the
Auto-select layer with menu option is not enabled, the program
automatically uses the layer you selected last.
Select, Set Layers or the Format toolbar to
• You can use
define a different layer as the current one. This layer will then
automatically be used as the current layer the next time you
activate the tool.
• When you save components as styles or favorite files, the layer
currently set is also saved. When you retrieve these components
later, the layer saved is automatically set as the current layer.
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• Normally, openings like recesses in walls and slabs or window
and door openings get the same layer as the element into which
Options they are inserted. Click the Special button in the
Components - Miscellaneous area to specify whether these
openings can be assigned separate, independent layers.
• As walls can consist of multiple construction layers and each
layer can have different format properties, you can define the
layer for each of the construction layers in a wall or upstand
directly in the Properties dialog box (you usually make these
settings on the Format toolbar).

Setting the format properties of layers
Every layer has pen, line and color properties. In the Layer dialog
box, you can specify that an element is to automatically assume the
properties of the layer on which it is drawn.
The format properties of a layer can also be defined as a line style
and saved under a name of your choice. Elements can then assume
the format properties of this layer.

When defining line styles, you can specify how they change with
the scale or drawing type. You can define different line styles for
various scale ranges and/or drawing types so that the display of
elements varies depending on the reference scale / drawing type set.
Line styles enable users to work on a scale-independent basis.
Drawing types define how elements are displayed on screen and in
the printout. The display of the elements varies depending on the
selected drawing type. Requirements: the format properties are taken
from the layer (in a fixed manner) and the use of line styles is
enabled.
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Layer access rights
There are different layer access rights. Visibility of layers (i. e.
whether a layer is visible or hidden) is controlled by a different
permission than the option that specifies whether a layer can be
edited or not (i.e. it is frozen). You can save permissions that control
visibility in plot sets; editing rights can be saved in privilege sets.
The status of a layer is represented by icons in the Layer dialog box,
Select Layer/Visibility tab:
Icon

Access right

Explanation

Current

The layer on which you draw.

Modifiable

Elements in this layer are visible and can
be modified.

Visible, frozen

Elements in this layer are visible but
cannot be modified.

Hidden, frozen

Elements in this layer are not visible and
cannot be modified.

You can tell which rights the current privilege set has by the color of
the icon’s lower part: yellow = edit right, gray = viewing right only > cannot be set to modifiable.
The color of the icon's upper part shows the current visibility status.
You can restrict access to layers in the Select Layer/Visibility tab.
For example, you can change the status of layers from Modifiable to
Visible, frozen.
Layer access rights also depend on the privilege set to which a user
belongs. Thus, you cannot assign a higher status to layers (for
example, set hidden layers to modifiable) when you belong to a
privilege set that is not granted full access rights to the relevant
layers.
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Setting layer visibility in drawing files
You can set layers so that they are visible or invisible and thus
show/hide the corresponding elements.
This way, you can quickly hide the elements you don't need during
the current design phase, selectively modify elements in the
displayed layers, check your plan and see whether all the elements
are assigned to the desired layer. For example, you might choose to
hide the slab layer and then view the spatial arrangement of the
building as a hidden line image in perspective view.

Note: Click an element with the right mouse button and, on the
shortcut menu, select Modify Layer Status and then Isolate layer set all other layers to hidden to hide all the layers with the
exception of the layer on which the element clicked is located.
If you find that you often require the same combination of visible
and hidden layers (for dimensioning or labeling at certain scales, for
example), then it is best to define what is known as a plot set. You
can also use plot sets when assembling your layout later on so that
only the visible layers print.
Note: You can configure the program to display all the elements on
frozen layers using a single color by activating the check box in the
Display area of the Layer dialog box.
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Managing layers and layer structures
The management of layers and layer structures is generally the
responsibility of the system administrator. This person defines which
layers are used, sets up the privilege sets and grants access rights.
The designers (architects, engineers, etc.) are assigned to the privilege
sets and thus automatically have the relevant permissions.
When you create a project, you can decide whether you want to use
the layer structure of the office standard or a project-specific layer
structure.
You can name and save layer structures and retrieve these structures
later. If you have assigned line styles to layers, they are saved
together with the layer structure (with the same file name plus the
extension .sty). When importing a layer structure you saved, you
can decide whether to import the associated line style file, too.

Advantages of data organization using layers
With large projects in particular, organizing data using layers has
significant advantages:
• Associative elements - such as wall dimensions or sill elevation
labels - reside in the same drawing file and yet can still be hidden
from view.
• In order for the interaction between elements to function cleanly,
the components in question have to reside in the same drawing
file. This is also the case for certain analysis and evaluation
operations. With layers, you can meet these requirements easily.
• Easier to assemble layouts thanks to plot sets. Plot sets are userdefined compilations of layers. These can also be used when
editing and assembling layouts. When assembling a layout, you
can choose to display only the elements in a specific plot set switching between 1:50 and 1:100 is thus no problem.
• Exporting drawing files to DXF/DWG layers is easier as you can
assign each layer in a drawing file to a different DXF/DWG layer.
When importing DXF/DWG files, the DXF/DWG layer structure
can be automatically integrated in the layer hierarchy.
• The layer of an element can often be modified more quickly than
the element's assignment to a drawing file.
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• You can quickly create layers that are not included in your layer
structure and then use these layers in all the drawing files of a
project.
• As a project can contain more layers (approximately 65,000) than
drawing files (9,999), layers allow you to distinguish more
precisely between the individual design entities.
• You can make up to 65,000 layers visible and modifiable at once
(while you can only display and edit up to 80 drawing files at the
same time).
• Layers can be shown and hidden very quickly (using plot sets or
favorites).
• You can change the format properties of a layer later. All the
elements of this layer that were drawn using the From layer, line
style setting will adapt automatically. This way, you do not need
to modify them separately.
• You can copy format properties including layers by doubleclicking with the right mouse button. This method also works
Copy Format (How) to
with wizards. Similarly, you can use
quickly copy the format properties of an element and apply them
to other elements.

Relationship between layers and drawing files
The use of layers doesn't mean that drawing files don't play a role
when it comes to organizing your data. With large project in
particular, a combination of both is essential. With the same
structural depth, the number of drawing files required is far less
when working with layers.
The number of drawing files you need not only depends on the size
of the project, but also on your hardware. Modern, fast computers
with a lot of memory can handle a lot more data per drawing file
without this leading to a noticeable downturn in performance.
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The interplay between layers and drawing files depends on the
following factors:
• The size of the project and the number of designers involved at
any one time.
If several designers are working on one floor, create one drawing
file per area of responsibility (e.g., East Wing, Central Unit, West
Wing, for example.)
• Simultaneous involvement of specialist designers on the project.
Separate drawing files should always be used for the specialist
designs in order to facilitate concurrent activity.

Using privilege sets
Access to layers can be controlled by means of privilege sets.
Privilege sets are generally assigned when there are several people
working on the same project: when working with Workgroup
Manager, you can assign individual users to one or more privilege
sets. As a result, these users can only see and/or edit the layers that
are associated with the relevant privilege set.
Privilege sets not only control who accesses which layers. By
defining privilege sets with a selection of layers that are to be
available while drawing, the entire design process can be facilitated.
When you install the program, the privilege set ALLPLAN is created
automatically. This privilege set has read and write access for all
layers.

Using plot sets
A plot set is a set of layers that you can select when compiling and
arranging layouts. You can also use plot sets to control which layers
are visible/hidden. Only the elements in the selected plot set are
displayed in the layout.
For example, you can select a plot set for working drawings so that
only the data that is relevant to a working drawing appears in the
final printout.
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Creating the training project
Start by creating a project.

To create the project
1 On the File menu, click

ProjectPilot - Admin....

ProjectPilot opens.
2 In ProjectPilot, click New Project… on the File menu.

3 Enter Engineering Tutorial for the name of the project, activate
the Same folder name as project name option and click Next>.
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4 Set the Layer structures, line styles, drawing types setting to
Project and click Next to confirm.
5 Click Finish to confirm the last dialog box.
6 Close ProjectPilot by clicking Exit on the File menu.
You are back in Allplan in the Engineering Tutorial project.
Note: You can also create new projects using the
Open Project tool (File menu).

New Project,

Path settings
This defines which pen, line, hatching settings, fonts and material
catalogs are used. In practice, the office standard is generally used.
Office: Choose this option if you want different projects within the
same office to use the same settings (for hatching, line types etc.). If
you are working in a network, the office standard is the same on all
computers and can only be changed by users with special privileges.
Project: Choose this option if you want the settings, for instance for
patterns and/or hatching styles, to apply to this project only (in
which case they will probably be different to those used as the office
standard).
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Setting the scale and unit of length
Define scale and length settings for the project.
Start by setting the reference scale to 1:100.

To set the reference scale
1 On the View menu, click

Tip: Alternatively, you can set
the scale in the status bar:
click to the right of scale and
select 1:100.

Reference Scale.

2 Click 100.00 in the Scale dialog box.
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Set the unit you want to use to enter values. The values are to be
interpreted in meters.

To set units
1 Click
Options (Standard toolbar) and select Desktop
environment in the dialog box.
2 Set the Unit of length to m.

Tip: Alternatively, set the unit
of measurement in the status
bar: click to the right of
Length and select m.

3 Click OK to confirm the settings.
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Drawing file structure
Allplan provides two options for structuring drawing files in a
project:
• the

fileset structure and

• the

building structure.

You can define these two structures, which you can use in parallel
manner, in the Open on a project-specific basis: drawing files from
fileset/building structure dialog box.
The building structure is particularly useful for applying a logical
structure to a building. In architecture, the advantage of working
with the building structure is that views, sections and building lists
can be generated quickly and easily.
An important difference between the building structure and the
fileset structure is that each drawing file can only be assigned once
in the building structure. However, when it comes to designing
reinforcement, drawing files are multiply used for different
reinforcement drawings. Therefore, we recommend that you work
with filesets.
In this mode, all you need to do is select the relevant fileset and all
associated drawing files are available immediately. To do this in the
building structure, select the relevant drawing files assigned to the
individual structural levels and use the shortcut menu of the project
to save the different status settings as a favorite, which you can
retrieve later.
When working with the building structure, you cannot place
detailing windows in filesets or assemble layouts using filesets.
As the focus of the exercises in this tutorial is to teach you how to
create reinforcement, you will use the fileset structure.
Please refer to the Architecture Tutorial for information on creating a
building structure, which you can also use here. Look in Allplan's
online Help for detailed information on the building structure.

Creating filesets
For the exercises in this tutorial, you will create your own project
structure. In a real project, it is advisable to use stories and plot sets
to structure projects. For more information see Tips on project
organization (on page 299).
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Create fileset
Tip: To display a section of
the drawing at a larger scale,
open a detailing window in a
drawing file or fileset.

1 Click
The

Open on a Project-Specific Basis.
Fileset structure tab is displayed.

2 Close the drawing file tree for fileset 0 by clicking the arrow to
the left of the fileset called <No fileset> in the Open on a
project-specific basis: drawing files from fileset/building
structure dialog box
or
click
Collapse all entries at top left.
Create Fileset, enter the fileset name Basement and
3 Click
click OK to confirm.

4 Create the filesets Elevator shaft, Standard door lintel, Slab
reinforcement and BAMTEC in the same way.
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Tip: You select the drawing
files as in Windows® Explorer:

5 Click drawing file 101, press and hold down the SHIFT key and
click drawing file 110.

Press the CTRL key to select a
series of
non-adjacent
drawing files
(e.g., 10, 16
and 28).
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This selects drawing files 101 to 110.

Press the SHIFT
key to select a
range of adjacent
drawing files
(e.g. 10 – 20).Or
open a selection
rectangle around
selected drawing
files with the
mouse.

6 Click within the selection, keep the mouse button pressed down
and drag the drawing files to the fileset Basement. Then release
the mouse button again.
The drawing file tree for the fileset opens. The drawing files are
thus assigned to the fileset.
If you have selected a drawing file too many, you can drag it out
of the list in the same way.
Note: Instead of using drag-and-drop operations, you can also
select the fileset and the drawing files and then click Assign to
current fileset on the shortcut menu.
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Notes:
Use the floor plans of the
basement you created in
exercise 1 for filesets 2 and 4.
You do not need to copy the
basement or create it again.
Just assign drawing files 101
and 102 to filesets 2 and 4,
respectively.
Assign the empty drawing
files 503 and 504 to fileset 5.
You will place the separated
carpet outline in these
drawing files later.
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7 Assign drawing files to the other filesets as shown below.
Drawing
1

2

3

4

5

Drawing
Drawing file name
file number
101

3D floor plan

102

2D floor plan

103

2D stair

104

Dimensions and labels

105

Hidden line image

110

Key plan

101

3D floor plan

201

General arrangement - 3D modeling
module

202

Concrete component

203

General arrangement - walls, openings,
components module

204

Associative views

205

Reinforcement drawing with 3D model

301

General arrangement in 2D

302

Reinforcement drawing with 3D model

303

Modified door lintel

102

2D floor plan

401

Reinforcement, bottom layer - without
3D model

402

Reinforcement, top layer - without 3D
model

501

Structure

502

Carpet outline

503
504

8 Name the drawing files as shown.
Labeling drawing files is covered in the Basics Tutorial.
9 Select a drawing file and click Close.
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Tips on project organization
Allplan is a very flexible system that allows you to develop your
own custom solutions for projects and entire offices. The structure
presented here for large-scale projects is intended only as a guide.
You can use the entire structure or just parts of it.
You will probably find this structure useful when you start. As you
progress, you will be in a better position to judge what needs
changing/adding to suit your own needs and requirements. We
would like to emphasize once again that a carefully thought out
project structure will save time for everybody in the long run. The
system has the following structure:
• General project-related information is stored on drawing files 199. This is universally required data (plan layout, axis system
etc.).
• Floor design starts at drawing file 100, starting with the
excavation. Create the design for the key plan in drawing files
300 and higher.
• Use the drawing files starting at number 1000 for general
arrangement drawings and the associated sections. The first digit
indicates the number of the story. The last two digits provide
information on the contents. The sequence in which the drawing
files are named should be identical on each floor.
• Use drawing files 2000 and higher for reinforcement drawings.
Drawing files 2000-2009 can be used for editing and modifying
components. Create precast elements and special components in
the subsequent drawing files.
This example largely reflects the Allplan’s Engineering project
organization, which you can select in the last dialog box when
creating a new project.

Defining plot sets
A plot set is a saved combination of visible and hidden layers.
Both when setting up your layouts and when turning layers on and
off, activating a plot set is a rapid way of showing/hiding only those
layers that are required for a specific layer set. First create and name
the plot sets. Then assign layers to these plot sets.
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To define plot sets
1 Click

Select, Set Layers (Format menu).

2 Select the Plot set tab and click Define, modify plot set.

3 In the Plot set Manager dialog box, click New plot set....
4 Enter Key plan for the name of the first plot set and click OK to
confirm.
You do not need to define a group.

5 If you are working with Workgroup Manager, assign the user
local to the plot set.
6 Repeat steps 3 to 4 (5) and create more plot sets:
-

General arrangement drawing

-

Reinforcement, bottom layer

-

Reinforcement, top layer

7 Click OK to confirm.
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Now you need to define which layers are to be visible and which
hidden in each plot set.

To define visible and hidden layers for plot sets
 The Layer dialog box is still open. The first plot set - Key plan is displayed.
1 Click

at top left to collapse the tree structure.

2 As only a few layers are to be visible, start by setting all layers to
Hidden. Select all layer structures, click the selection with the
right mouse button and, on the shortcut menu, choose Hidden.
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3 Expand the Draft, Dimension line and Key plan areas by clicking
the plus sign. Press the CTRL key and select the layers which are
to be visible in the Key plan plot set (see table).
4 Click the selection with the right mouse button and click Visible
on the shortcut menu.
Make sure that you select individual layers (and not layer
structures or even the entire layer hierarchy!).

5 Click Apply to save the current setting.
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6 Select the next plot set in the Plot set in list box area and define
which layers are to be visible and which hidden in this plot set
(see table).

Tip: For other plot sets, you
can then transfer the setting
of an already defined plot set
and then adapt it as
appropriate.

7
Category

Layer

Short
name

Key
plan

General
Reinforcemen Reinforceme
arrangeme t
nt
nt
at bottom
at top
drawing

Draft

General 01

DE_GEN01

General 02

DE_GEN02

Surface
elements

Style area

SU_STYL



Text

General text

TX_GEN
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Category

Layer

Short
name

Dimension line

Dimension line,
general

DL_GEN

Dimension line
1:100

DL_100

Wall

AR_WALL



Column

AR_COL



Slab

AR_SLAB



Architecture

Key
plan

Allplan 2013

General
Reinforcemen Reinforceme
arrangeme t
nt
nt
at bottom
at top
drawing



Downstand beam AR_BEAM
Views and
sections

Bar
Reinforcement

Mesh
Reinforcement

Key plan





Shell, general

SH_GEN





Views and
sections

SH_SHELL





Bar
reinforcement at
bottom

BR_B_B



Bar
reinforcement at
top

BR_B_T

Mesh
reinforcement at
bottom

MR_M_B

Mesh
reinforcement at
top

MR_M_T

Key plan,
general

KP_GEN



Key plan

KP_MARK









8 When you have assigned layers to all plot sets, click Apply and
then OK.
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Palette configuration
The Palette Configuration is set by default when you install for the
first time.
This configuration displays the Tools, Properties and Wizards and
Connect palettes on the left and the Filter Assistant and Edit toolbar
on the right.
If the Palette Configuration is not set, select it as follows:

To set the palette configuration
• On the View menu, point to Default Configurations and click
Palette Configuration.

You can use the first three palettes to access the families, the
modules and their tools, the properties of design entities and the
wizards. Using the Connect palette, you can access content provided
by Allplan Connect straight from Allplan. You can enter the user
name and password directly in the palette (the entries are lost as
soon as you close Allplan) or on the Palettes tab of the Customize...
tool on the Tools menu (the entries are saved and thus retained).
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Note:
You can customize the arrangement of the palettes for your needs by
selecting the Customize... tool on the Tools menu and opening the
Palettes tab. As an alternative, open the shortcut menu of a palette
and select Customize....
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When the Tools tab is open at the top, the following options are available:
Drop-down menu at the top

Tabs on the right

Available tools

Select a family:

Select a module:

Select a tool in the Create and
Change areas:
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When the Properties tab is open at the top, the following options are available:
Drop-down menu at the top

Tools at the top and bottom

Element properties

Select active elements

Zoom in on selected
objects:
Filter Step by Step

Modify properties (also possible
for some reinforcement
elements)

Match parameters
Load favorite:
Save as a favorite:
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When the Wizards tab is open at the top, the following options are available:
Drop-down menu at the top

Tabs on the right

Available tools

Select a wizard group

Select a wizard

Select a tool

Training project on Internet
If you do not want to work through the entire tutorial step by step,
you can download the training project from our website. It contains
all the drawing files at different levels of completion so that you can
get started wherever you want. For example, you do not need to
generate the general arrangement drawing first. Just open the
corresponding drawing file and start creating reinforcement.
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Downloading the training project
You can download the training data for this tutorial from Allplan
Connect, the international service portal for all Allplan users.
Go to
www.allplan-connect.com
• Use your customer number and email address to register.
Registration is free and not subject to any conditions.
The whole process only takes a few minutes.
• In Allplan Connect, you can find the training data for this
tutorial in the Learn - Documents area.
You can find two versions of the project:
Allplan 2013: Project data for the Engineering Tutorial
(without the model). This project includes the fileset structure
and the assigned drawing files with names so that you can
immediately start working.
Allplan 2013: Project data for the Engineering Tutorial
(including the model). This project contains all the drawing files
at different levels of completion so that you can get started
wherever you want. For example, you do not need to generate
the general arrangement drawing first. Just open the
corresponding drawing file and start creating reinforcement.
• In addition to the training data, you can find the latest version of
this document as a PDF file (Allplan 2013 Tutorial:
Engineering).
• Save the zipped training data in any folder on your computer.
• Extract all the data into any folder, C:\Training data for Allplan
Engineering Tutorial, for example.
Note: Serviceplus customers have access to a number of advanced
step-by-step guides in Allplan Connect's Learn area. It usually takes
one to two working days until you can access this restricted area and
download these documents. Please note that this service is available
to Serviceplus customers only.
For general information on Serviceplus, go to
http://www.nemetschek.de/serviceplus
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Index

Index
A
access rights 286
additional carpet reinforcement
240
additional reinforcement (bar
reinforcement) 219
align
bar reinforcement placed 142
associative section without
height being delimited 129
associative views 126
attributes
assign attribute values 255
for projects 255
Attributes
match attributes 21

B
BAMTEC 230
basic carpet reinforcement
239
carpet outline 233
enter mounting strips 237
place additional reinforcement
240
placing symbols 243
separate into files 237
bar reinforcement 137
bar shape entry 191, 196, 199
open stirrup 148, 157
stirrup 163
basic carpet reinforcement 239
bending schedule 187
box 92

C
carpet mounting strips 237
checklist 23
column 51
common approaches in
ProjectPilot 278

component axis 35
component parameters
column 51
downstand beam, upstand
beam 54
opening 56
save as favorites 74
slab 73
wall 31
copy
reinforcing bars placed 146
create BAMTEC file 243
cross-section catalogs 245
cutting diagram 226

D
define reference point, overview
64
door 56
downstand beam 54
drawing file
general 281
status 282
drawing file status 282
drawing file structure 295

E
edge reinforcement
meshes 223
reinforcing bars 216
engineering toolbar 123
Extension
single-tier 36

F
favorites
save 74
fileset
create, new 295
folded 129
full schema 184
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Index

H
height
absolute heights 31
enter parameters 31
help 6
hidden edges 49
hidden line image 49, 64
hidden reinforcement 172

K
key plan 109
modify 115

L
label 265
label bar reinforcement placed
176
label style
create 258
layers 284
access rights 286
advantages 288
assignments 69
Attributes 285
Format Properties 285
general 284
in drawing files 289
line attributes 21
manage 288
pen, line, color 21
plot sets 299
select current layer 53
set to visible, frozen 67
settings 21
Troubleshooting 69
visibility 287
layout
definition 262
elements 265
layout window 271
plot 269
plot set 265
Layout
plot set 299

Allplan 2013
line attributes for layers 21
line for layer 21
linear placement
along leg 196
along placing line 191

M
mesh reinforcement 211
model
reinforcing with 3D model
(method 1) 124
reinforcing with 3D model
(method 2) 189
reinforcing without 3D model
(method 3) 210
modify mesh cross-section
catalog 245
modifying using palette
mark 206
placement 206
modules
3D modeling 91
associative views 126
BAMTEC 230
bar reinforcement 137
basic

walls, openings,
components 29
draft 80
key plan 109
mesh reinforcement 211

O
observer 129
offset polyline 81
open stirrup
enter manually 138
expanding mode 148
opening
enter 56
output
layout 262
symbols 204
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Index

P
palette configuration 305
paste
symbols in catalog 203
Pen
for layer 21
pen thickness
pen for architectural surface
elements 30
place automatically 148, 157,
163
place bar reinforcement
along leg 196
along placing line 191
automatically 148, 157, 163
hidden 172
in batch 168
manually 142
place in freehand mode 199
place excess mesh 223, 229
place in freehand mode 199
place reinforcement in batch 168
place reinforcement in span
place meshes in polygonal
area 214
place meshes in rectangular
area 212
reinforcing bars 151
place reinforcement in view 180
planar polygonal surface 93
plot
layout 269
plot set 265
requirements 253
polyline sweep solid 96
priority 31
Project
create 291
download training project 309
path for settings 291
project attributes 255
Project Organization
tip 299
ProjectPilot
common approaches 278

Q
quick printout 253

R
read properties 165
reinforce
with 3D model (method 1)
124
with 3D model (method 2)
189
without 3D model (method 3)
210
reinforce recess 216
reinforcement drawing 119
reinforcement schedule
legend 187
sending to printer 186
reinforcement schema 183
reinforcing bars
modifying using palette 206
place in 3D 148, 157, 163
place in freehand mode 199
placing along leg 196

S
save
component parameters as
favorites 74
save view 50
section
create 133
reshape area 179
standard section 179
settings in the tools palette 15
shell drawing 25
slab 73
slab opening
polygonal 77
solid component 99
sources of information 6
training, coaching and project
support 8
spacer 224
stair 70
standard section 179
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Index
starter bars 157
stirrup
enter manually 191
expanding mode 163
support reinforcement
meshes 222
symbols
get from library 204
write to library 203

T
title block
as a label style 258
using label styles 265
toolbar
engineering 123
track tracing 20
training project on the internet
309
training project provided with
Allplan DVD 12
troubleshooting 23
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U
upstand beam 54

V
view 44
viewports 44

W
wall
offset direction 37
walls
three-dimensional 31
two-dimensional 81
window
three-dimensional 61
two-dimensional 85

